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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license.

Third-Party Web Sites

HP provides links to external third-party Web sites to help you find supplemental 
information.  Site content and availability may change without notice.  HP makes no 
representations or warranties whatsoever as to site content or availability.

Copyright Notices

© Copyright 2004-2009 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

Intel®, Pentium®, and Intel® XeonTM are trademarks of Intel Corporation in the U.S. and

other countries.

JavaTM is a US trademark of Sun Microsystems, Inc.

Microsoft®, Windows®, Windows NT®, and Windows® XP are U.S registered trademarks of

Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

Unix® is a registered trademark of The Open Group.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

You can visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
4



Contents
1 Welcome to This Guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
How This Guide Is Organized  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Who Should Read This Guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Getting More Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

2 Component Administration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Administration Console Description. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Starting the Administration Console. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Functions Provided by the Administration Console . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Starting and Stopping the BPI Server Components. . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Starting the BPI Server Components Using the Administration Console . . . . . . . 28
 Stopping the BPI Server Components Using the Administration Console . . . . . . 28

BPI Clients  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Log File Locations and Changing the Log Viewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Component Configuration - Notification Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Changing the Notification Server Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Component Configuration - Business Impact Engine (BIE) . . . . . . . . . . . . . . . . . . . . . . . 36

BIE Java Virtual Machine (JVM) Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Modifying the BIE Java Virtual Machine (JVM) Settings  . . . . . . . . . . . . . . . . . . . 37

BIE Model Cleaner Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Modifying the BIE Model Cleaner Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

BIE Process and Data Instance Cleaner Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Modifying the BIE Instance Cleaner Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

BIE Event Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Modifying the BIE Event Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

BIE Event Queue Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Modifying the BIE Event Queue Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
5



BIE Notification Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Modifying the BIE Notification Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

BIE JDBC Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Modifying the BIE JDBC Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Component Configuration - Monitor Engine  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Monitor Engine Java Virtual Machine (JVM) Settings  . . . . . . . . . . . . . . . . . . . . . . . . 53

Modifying the Monitor Engine Java Virtual Machine Settings  . . . . . . . . . . . . . . . 54
Monitor Engine Events Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Modifying the Monitor Engine Events Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Monitor Engine Statistics Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Modifying the Monitor Engine Statistics Settings  . . . . . . . . . . . . . . . . . . . . . . . . . 59
Monitor Engine Threshold Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Modifying the Monitor Engine Threshold Settings . . . . . . . . . . . . . . . . . . . . . . . . . 62
Monitor Engine Instance Cleaner Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Monitor Engine Instance Cleaner Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Active Monitor Instances Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Completed Monitor Instances Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Monitor Statistics Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Monitor Alarm Instances Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Modifying the Monitor Engine Instance Cleaner Settings . . . . . . . . . . . . . . . . . . . 67

Component Configuration - HP Business Availability Center Settings . . . . . . . . . . . . . . 68
Modifying the Business Availability Center Settings . . . . . . . . . . . . . . . . . . . . . . . 74

Component Configuration - Process Repository. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Changing the Password Details . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Component Configuration - Business Event Handler . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Modifying the Business Event Handler Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . 80

Component Configuration - JMS Business Event Handler. . . . . . . . . . . . . . . . . . . . . . . . 82
General Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
Service Providers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
Event Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
Modifying the JMS Business Event Handler Settings . . . . . . . . . . . . . . . . . . . . . . . . . 87

Component Configuration - Servlet Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Process Instance Web Pages and Portlets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

Process Instance Web Pages and Portlet Settings . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Modifying the Process Instance Web Pages and Portlet Settings . . . . . . . . . . . . . . 91
6



Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Authorization Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
HTTP Over SSL Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Modifying the Security Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Component Configuration - MS SQL Server Access  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
Changing the Password Details . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Component Configuration - Oracle Server Access . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Changing the Password Details . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

Component Configuration - Port Numbers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Modifying BPI Port Numbers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Component Configuration - Logging. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Logging Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

Modifying the Log File Parameter Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
Component Startup Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

Modifying the Component Startup Parameter Values  . . . . . . . . . . . . . . . . . . . . . 107
License Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

3 Enhancing BAC with Process Instance Monitors . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Overview of BPI as an Application Within Business Availability Center  . . . . . . . . . . . 112
Design-Time Integration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

Modeling with Tracking Individual Process Instances Disabled . . . . . . . . . . . . . 115
Modeling with Tracking Individual Process Instances Enabled. . . . . . . . . . . . . . 117

Run-Time Integration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
Monitoring - Tracking Individual Process Instances is Disabled . . . . . . . . . . . . . 119
Monitoring - Tracking Individual Process Instances is Enabled  . . . . . . . . . . . . . 121

Data Samples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Configuration Items Stored in the UCMDB. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

Viewing BPI CIs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Multiple CIs for Each Business Process and Business Process Step . . . . . . . . . . 128

Configuring the BPI Server to Connect to a Gateway Server or Load Balancer . . . . . . 130
Business Availability Center General Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
Data Sample Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
CI Poller Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Business Process Insight Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
Using SSL for Connections with Business Availability Center. . . . . . . . . . . . . . . . . . . . 138
7



Gateway Server Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
Creating a My BSM Application for BPI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
SLM and Reporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Description of Data Samples Sent to Business Availability Center . . . . . . . . . . . . . . . . 145

Value and Counts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

4 Modeler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Modeler Concepts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
Process Repository  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152

Modeler Management Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Starting and Stopping the Modeler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Deploying Processes and Dependencies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Undeploying Definitions from the BPI Modeler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
BPI Modeler Log File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
Exporting and Importing Process Definitions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158

Exporting Definitions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
Importing Definitions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160

Importing BPEL Processes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
Linking Steps to TransactionVision Events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Linking Steps to IT Operational Resource CIs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Copying Properties Between Data and Event Definitions . . . . . . . . . . . . . . . . . . . . . 161
Exporting Definitions to Recover Unsaved Changes  . . . . . . . . . . . . . . . . . . . . . . . . . 162

5 Monitor Definer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 165

Business Process Monitor Definer Concepts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166
Monitor Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168

Monitor Definer Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
Opening the Monitor Definer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
BPI Monitor Definer Log Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
Exporting and Importing Monitor Definitions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173

Exporting a Business Process Monitor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Importing a Business Process Monitor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175

Monitor Definer Reference  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
Collection Interval  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
Warning Messages in Log Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
8



6 Process Repository Explorer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179

Process Repository Explorer Concepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180
Repository Explorer Tasks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182

Open the Repository Explorer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
Browse Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
Print Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
Delete Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
Exporting Process Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183

Exporting a Single Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184
Exporting All Definitions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185

Undeploying a Process Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
Restoring a Definition  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186

Repository Explorer Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187
Repository Explorer GUI Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188

Navigator Frame . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188
Details Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190
History Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 192

Process Repository Explorer Log Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193

7 Process Intervention . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195

Process Intervention Concepts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196
Process Intervention Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199

Opening the Process Intervention Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199
Deleting Process or Data Definitions and Clearing Data. . . . . . . . . . . . . . . . . . . . . . 200
Search for Specific Instances . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
Change the State of an Instance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
Delete All Instances . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
Modify or Reset the Data within a Data Instance  . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
Synchronize with the CMDB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204

Process Intervention Reference. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205
Using the Process Intervention Option . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206

Process Definitions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206
Data Definitions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207

8 Notification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 209

Notification Server Concepts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
9



Notification Server Component . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
Email Notification Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212

Notification Server Administration Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
Managing Email Subscriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213

Configuring the Events Received by Notification Server Users . . . . . . . . . . . . . . 215
Managing HP Operations Manager Message Subscriptions . . . . . . . . . . . . . . . . . . . 217
Managing Script Subscription . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220
Creating Notification Server Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 222

Creating an Email Template. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 223
Creating an HP Operations Manager Template  . . . . . . . . . . . . . . . . . . . . . . . . . . 223
Creating a Velocity Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225
XSLT Templates. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236

Creating Script Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237
Example Script to Write a String to a File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238
Example Script to Write Process Name and Blocked Instances to a File  . . . . . . 239
Environment Variables for Scripts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240

9 BPI Application Concepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245

Overview of the BPI Application. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
Key Elements of Business Process Insight Application. . . . . . . . . . . . . . . . . . . . . . . . . . 247

10 BPI Application Scorecard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249

Common Header. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252
Results Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 254
Understanding KPI Statuses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 257
How the Scorecard Builds its Display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258

Splitting Mechanism. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259

11 BPI Application Health  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261

Process Diagram Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265
Step Overlay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270

Summary Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 272
Business Health Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276

Business Health Dials  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 277
Instance Violation Counts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278

Transactions Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279
10



Instances Dialog. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
Process Instances for a Selected Business Process . . . . . . . . . . . . . . . . . . . . . . . . 281

Process Instances for a Selected Business Process Step  . . . . . . . . . . . . . . . . . . . . . . 283
Process Instance Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 287

Process Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
Process Timeline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
Monitor Thresholds. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
Process Steps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
Data Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 290

Step Instance Dialog  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291
Instance Violations Dialog. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
Monitor Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 295

Monitor Diagram  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 296
Monitor Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 296
Monitor Values  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 297
Monitor Graph  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 300
Monitor Summary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303

Monitor Threshold Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 304
Threshold Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
Threshold Violations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 306

Synchronization and Delay in Seeing Updates to Data. . . . . . . . . . . . . . . . . . . . . . . . . . 308
BPI Instance and Violation Health Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 309
Process Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311

Step Rates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311

12 BPI Application Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313

Profile Database Configuration Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 314
Enrich the Business Process Report View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315

Business Process Summary Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 316
BPI Monitors Over Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325

Monitor Data Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327
Status Distribution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 328

Business Process Step Summary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329
Business Process Over Time Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334

Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335
11



Health . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 336
Business Process Step Over Time Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337

Value  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 338
Count . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 339

13 Annotations for Process Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 341

Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 342
Customizing your Process Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 343

annotations.xml File Format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 343
encoding= . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 344
<annotations>  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 344
<step>. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 344
<texttype>  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 345
<textsymbol> . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346
<textdp> . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346
<scalesymbol>  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 348
<image> . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 348

Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 349
No Text on Process Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 349
A Custom Image for Process Step Image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 349
Value for Active Instances and Custom Image on a Process Step  . . . . . . . . . . . . 350
Scaled Active Value . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351
Value and Instance Count . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352
A Complete Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353

Character Set Encoding. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354

14 Deleting Completed Instances from the Database. . . . . . . . . . . . . . . . . . . . . . . . . . . 355

Business Impact Engine Process and Data Instance Cleaner Parameters  . . . . . . . . . . 356
Configuring the BIE Instance Cleaner Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . 357

Example for Deleting Completed Instances. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358
Example for Deleting Active and Completed Instances  . . . . . . . . . . . . . . . . . . . . 359
Example for Deleting Completed Instances as Soon as They Are Complete . . . . 360

Archiving Completed and Active Process Instances . . . . . . . . . . . . . . . . . . . . . . . . . . 360
Monitor Engine Instance Cleaner Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 363

Configuring the Monitor Engine Instance Cleaner Parameters  . . . . . . . . . . . . . . . . 364
Example for Deleting Completed Monitor Instances. . . . . . . . . . . . . . . . . . . . . . . 364
12



15 Servlet Engine Authentication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 365

Tomcat Realm Mechanism. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 366
Modifying Login Credentials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368

Modifying Servlet Engine Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 370
Tomcat and HTTP Over SSL. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372

Servlet Engine Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372
Web Client Certificate-Based Authentication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 373

16 High Availability Using Microsoft Clusters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 377

Modes of High Availability  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 378
Configuring BPI Within a Microsoft Cluster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381

Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381
Summary of Configuration Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 383
Licenses for BPI in a Cluster Environment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 385

Cluster License Example. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 387
Reinstalling BPI In a Cluster. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388
Removing BPI From the Cluster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388
Other Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388

17 Backup and Recovery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 391

Files and Directories to Backup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 393
How the BPI System Behaves When Components are Shutdown  . . . . . . . . . . . . . . . . . 396

Engine Shutdown . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396
Database Shutdown . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396
Notification Server Shutdown . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396

Email Server Shutdown  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397
Business Event Handler - BPI Adapter Shutdown. . . . . . . . . . . . . . . . . . . . . . . . . . . 397
Servlet Engine Shut Down. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397

Completing an Online Backup for BPI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 398
Restoring your BPI Data from a Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 400

Steps to Restore your BPI System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401
Completing the BPI Recovery Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 404

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 405
13



14



1 Welcome to This Guide
This guide provides information about the management tasks that you need to 
complete for the ongoing set up and maintenance of your Business Process 
Insight (BPI) solution. 

BPI comprises a number of different components, some of which can be 
distributed to other systems; however, there are some BPI components that 
always need to be located together and these are collectively referred to as the 
BPI Server components.

For information about the architecture of the BPI system and how BPI 
integrates with other products, refer to Business Process Insight Reference 
Information. You do not need to understand the BPI architecture in order to 
manage the BPI system; however, it provides useful information that helps to 
understand how the components relate to each other.

This chapter includes:

• How This Guide Is Organized on page 16

• Who Should Read This Guide on page 19

• Getting More Information on page 19
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How This Guide Is Organized

This guide covers the following topics:

• Chapter 2, Component Administration

This chapter describes using the Administration Console to modify the 
BPI Server configuration parameters.

This chapter also describes how to configure the logging levels for the BPI 
components. This is useful if you are trying to gather information about a 
particular problem that is occurring in your BPI system, or if you are 
trying to debug a Process definition that you have created, you might need 
to modify the level at which the BPI components are logging.

• Chapter 3, Enhancing BAC with Process Instance Monitors

This chapter describes how to configure the integration of the BPI Server 
into your BAC system.

• Chapter 4, Modeler

The Modeler page is one of the BPI Administration client pages and is 
where you launch the BPI Modeler. The chapter describes how to launch 
the Modeler and also provides information about how to manage the BPI 
Modeler, for example, importing and exporting process definitions.

• Chapter 5, Monitor Definer

The Monitor Definer page is one of the BPI Administration client pages. 
The chapter describes the Monitor Definer and how to manage the 
Business Process Monitor Definer, for example, exporting and importing 
monitor definitions.
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• Chapter 6, Process Repository Explorer

The Process Repository Explorer page is one of the BPI Administration 
client pages. The chapter describes managing Business Process data in 
the Process Repository using the Repository Explorer, for example, the 
chapter describes how to:

— view and print details of the definitions that are stored in the Process 
Repository.

— export versions of your Business Processes.

— permanently delete definitions.

— restore definitions previously deleted within the BPI Modeler.

— view the history of your definitions.

• Chapter 7, Process Intervention

The Process Intervention page is one of the BPI Administration client 
pages. The chapter describes how to use the Intervention tool to intervene 
in process progression.

The Intervention tool enables you to intervene or gain access to instances 
of Process and Data definitions. You might need to do this in cases where 
the process instance is blocked for some reason and cannot progress, or 
where you have entered inaccurate start and complete conditions in your 
progression rules.

The Intervention tool also enables you to:

— initiate a synchronization with the UCMDB for deployed Business 
Processes, process Steps and Monitors.

— delete instances.

— undeploy definitions.

• Chapter 8, Notification

The Notification page is one of the BPI Administration client pages. This 
chapter describes how you can configure user accounts to receive process 
event notifications and monitor instance threshold violations. 

You use the Notification page to configure user accounts to subscribe to 
event notifications and violations for email and HP Operations Manager 
messages. You can also subscribe user accounts to events, such that when 
a specified subscription event is received by the Notification Server, a 
script is run.
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• Chapter 9, BPI Application Concepts

This chapter describes using the options available within BAC to monitor 
the health and operational status of your Business Processes and 
Business Process Steps.

• Chapter 10, BPI Application Scorecard

The Scorecard page is one of the BPI Application pages and presents a 
type of report that enables you to display the real time status, trend, and 
changes-over-time data for a selected BPI Business Process.

• Chapter 11, BPI Application Health

The Health pages are a set of pages accessible from the BPI Application 
menu option and present the operational and business health of the 
Business Processes that you have defined using the BPI Modeler.

• Chapter 12, BPI Application Reports

The Reports page is one of the BPI Application pages and shows historical 
data relating to summaries of Business Processes, Business Process Steps, 
and Monitors that you have defined.

• Chapter 13, Annotations for Process Diagrams

This chapter describes how to add annotations to the flow map within the 
Flow Map tab and on the Business Health page.

• Chapter 14, Deleting Completed Instances from the Database

This chapter describes the tools that are available to manage data that is 
being collected in the BPI Database.

If you are tracking many BPI process instances, and monitor instances, 
statistics and violations, the data in the BPI database can build up over 
time. This chapter describes how to manage the data that builds up.

• Chapter 15, Servlet Engine Authentication

This chapter describes how to use the Memory Realm mechanism within 
Tomcat, the Servlet Engine used by the BPI Server, to secure the BPI Web 
pages where required. This is as an alternative to lightweight single 
sign-on.
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• Chapter 16, High Availability Using Microsoft Clusters

This chapter describes how to create a high availability solution for BPI 
on Microsoft Windows.

You can install and configure BPI as part of a Microsoft Server Cluster in 
order to provide a high availability solution for BPI. This is a separate 
topic to high-availability configuration described in the Business 
Availability Center Deployment Guide.

• Chapter 17, Backup and Recovery

This chapter describes how to create a backup and recovery process for the 
BPI Server system.

For enterprise systems, you need to make sure that you have a backup 
policy for your BPI system. This chapter describes how to backup BPI and 
advises you of any specific requirements that might have an effect on your 
organizational backups. You should read this chapter in conjunction with 
the high-availability solution described in the Business Availability 
Center Deployment Guide.

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

• HP Business Availability Center administrators

• HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Availability Center 
and enterprise monitoring and management concepts.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, see 
the HP Business Availability Center Deployment Guide PDF.
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2 Component Administration
This chapter describes the BPI Administration Console, which is installed as 
part of the BPI Server. Using the Administration Console you can modify 
parameters relating to the BPI Server Application for Business Availability 
Center (BAC). 

Chapters in Business Process Insight Reference Information, provide 
background information relating to the architecture of the BPI system that 
you might find helpful when modifying some of these parameters.

This chapter includes the following information:

• The parameters that can be modified using the Administrative Console.

• How to make sure that any modifications made through the 
Administrative Console are preserved.

• Accessing the License Manager software.

Not all the parameters described in this chapter need to be modified. What 
you need to change depends on your particular configuration and 
requirements. You are advised not to change anything unless you are 
recommended to in the documentation, or by your support representative.
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Administration Console Description

You use the Administration Console to manage the BPI Server components. 
(The BPI components that make up the BPI Server are described in Business 
Process Insight Reference Information.) The Administration Console is a 
graphical management interface that displays a list of the parameters that 
can be modified.

The Administration Console opens on the Status panel, which is where you 
start and stop the BPI Server components.

You navigate through the Administration Console configurations using the 
explorer-style menu in the left-hand pane. Select the option from the pane 
that you want to manage. For example, if you want to manage port numbers 
select the Port Numbers option. 

When you select an option in the left-hand pane, the right hand pane is 
updated to contain the configuration details for the parameters that can be 
modified. 

You do not necessarily need to complete all the tasks described in this chapter 
for your implementation. Many of the parameters that you can change are 
used to configure more than one BPI component, for example, changing the 
database password affects all components that access the database.

Starting the Administration Console

You start the Administration Console as follows:

Start > Programs > HP > HP Business Process Insight > 
Administration

The Administration Console opens at the Status pane. 

You can close the Administration Console at any time without applying 
outstanding changes and it does not impact the status of the system. You 
might need to click the Reset button to reset the page back to its state when 
you opened it. The next time that you start the Administration Console, it 
shows the current status of the BPI components.

IB

Make sure that you follow the instructions in each section when making 
changes to the configuration for BPI Server components through the 
Administration Console. This is because the steps for changing the 
parameters can vary according to the parameter that is being modified.
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Each time you start the BPI Server Administration Console, the BPI Server:

• sends details of the BPI instance database settings, Servlet Engine 
settings and installation directory details to BAC in order that the BPI 
Application infrastructure settings can be set automatically within BAC; 
this means you do not need to add these settings manually. 

If you change the settings using the Administration Console, the BPI 
Application infrastructure settings are also changed. If you change the 
BPI Application infrastructure settings directly from BAC, the settings 
are overwritten the next time the BPI Administration Console is 
restarted. This is with the exception of the Host name; the Host name is 
not affected because the same server can be known by different names to 
different systems.

• polls for the BAC lightweight single-signon setting and uses the values to 
update the equivalent BPI settings under the Security option.

Functions Provided by the Administration Console

BPI comprises a number of individual components, each of which has its own 
configuration, or property file that define the parameters that can be used to 
control how the component behaves. Examples of parameter values that can 
be configured are:

• retry delays

• port numbers

• logging levels

Many of the parameters in these property files do not need to be changed. 
Therefore, in order to simplify the management of the BPI system, only those 
parameters that might need to be modified have been made available through 
the BPI Server Administration Console.

If you do make changes directly to the properties in the property files, you will 
need to reapply the changes each time you reinstall BPI, or add the same 
changes within the Administration Console, where they are preserved. 

This is because the files and the property values in these files are overwritten 
when the BPI Server is installed.
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Specifically, the Administration Console provides access to the following BPI 
Server component areas:

• Server component status, which:

— shows whether or not the BPI Server components are running.

— enables you to start and stop components.

— enables you to view the content of the current log file.

See section Status on page 26 for details of the Status option.

• Notification Server parameters; see section Component Configuration - 
Notification Server on page 32.

• Business Impact Engine parameters; see section Component 
Configuration - Business Impact Engine (BIE) on page 36.

• Monitor Engine parameters; see section Component Configuration - 
Monitor Engine on page 53.

• HP Business Availability Center parameters; see section Component 
Configuration - HP Business Availability Center Settings on page 68.

• Process Repository parameters; see section Component Configuration - 
Process Repository on page 75.

• Business Event Handler parameters; see section Component 
Configuration - Business Event Handler on page 79.

• JMS Business Event Handler parameters; see section Component 
Configuration - JMS Business Event Handler on page 82.

• Servlet Engine parameters; see section Component Configuration - 
Servlet Engine on page 89.

• Microsoft SQL Server access.

This option is available when you have configured Microsoft SQL Server 
as the database for the BPI Server; see section Component Configuration - 
MS SQL Server Access on page 96.

• Oracle Server access.

This option is available when you have configured an Oracle Server as the 
database for the BPI Server; see section Component Configuration - 
Oracle Server Access on page 98.
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• Port number settings; see section Component Configuration - Port 
Numbers on page 100.

• Logging parameter settings; see section Component Configuration - 
Logging on page 103.

The configuration parameters that you can modify for these component areas 
are described in the remaining sections of this chapter.

In addition to individual component configurations, the Administration 
console provides access to the HP License Manager software; see section 
License Management on page 108.

The Modeler is not a BPI Server component; its configuration is described in 
Chapter 4, Modeler.
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Status

Use this option to start and stop the BPI Server components and also to view 
the component log files of these components. 

The Status pane lists the BPI Server components that you can start and stop, 
and includes buttons labeled, Start, Stop and View Log. The components 
included on the Status pane, following a full installation on Windows, are:

• Business Impact Engine (BIE)

The component responsible for managing the progress of process 
instances, based on the business and operational events received from 
external sources. The BIE also generates impact notifications.

• Monitor Engine

The component that analyzes and provides the statistical results from 
Business Process Monitor, monitor instances and performance indicators. 
The Business Process monitors are created using the Business Process 
Monitors Definer.

• Business Event Handler

Receives business events from sources external to BPI and forwards them 
on to the Business Impact Engine in a standard format.

• JMS Business Event Handler

Received JMS-sourced business events from JMS-based business 
application sources external to BPI and forwards them on to the Business 
Impact Engine in a standard format. TransactionVision is an example of a 
JMS-based application.

• Process Repository

The design-time repository where the BPI Modeler stores its definitions. 
The Process Repository uses the information in the Process Repository 
schema when deploying the Business Processes.

• Data Samples Provider

The BPI component that is responsible for sending KPI data samples to 
the BAC system. The data samples are configured within the Monitor 
Definer.
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• Web Services Provider

The BPI interface that exposes BPI Web Services to an external consumer.

• CI Status Poller

This is the service adapter that is used to manage the communication 
between the Business Impact Engine and the Gateway Server that BPI 
connects to for CI statuses.

• Servlet Engine

This is the Web Server component (Tomcat) that is installed as part of 
BPI. This component manages the server-side of all the BPI Web-based 
interfaces, for example: the Notification page and Intervention tool. It also 
manages the process instance and violation pages that are presented 
through the BPI Application pages.

• Notification Server

The component used to send email notifications of business events to 
configured recipients.

In addition, there are the Start All and Stop All buttons, which you can 
use to start and stop all BPI Server components.

You also access the log files for the BPI Server components from the Status 
pane. This enables you to identify status and error information for that 
component. The level of detail shown in the log files is controlled by the 
logging levels that you set. Setting log levels is described in section 
Component Configuration - Logging on page 103. 

If the log files are not displaying correctly on your system, you can change the 
viewer used to display the log files as described in section Log File Locations 
and Changing the Log Viewer on page 31.

Starting and Stopping the BPI Server Components

You can use the BPI Administration Console to start and stop the BPI Server 
components that you have installed, on the system where the Administration 
Console is running. The BPI Server components are also defined as Windows 
Services.

This chapter describes using the Administration Console to start and stop the 
BPI Server components; refer to Deploying Business Process Insight for 
details of the Windows Services for the BPI Server components.
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Starting the BPI Server Components Using the Administration Console

You start the BPI Server components from the Status panel. Click the Start 
All button to start all the BPI components installed on the system. You must 
make sure that the BPI Instance database is running and that BAC is 
installed and running before you attempt to start the BPI components as this 
command does not start the database.

You can start and stop the BPI components individually. To do this, click the 
Start button adjacent to the BPI component that you want to start.

 Stopping the BPI Server Components Using the Administration Console

You stop the BPI Server components in the same way that you started them, 
from the Status panel of the Administration Console. Select the Stop All 
option to stop the BPI Server, or stop the components individually.

If you stop each BPI component individually, the Stop All button remains 
enabled. This is because the Administration Server components is still 
running. You are therefore advised to always use the Stop All command to 
shut down BPI Server before completing any installation tasks or tasks where 
it is important that all the BPI Server components are stopped.

There are some dependencies between components, you are therefore advised 
to use the Start All option to start the components unless instructed 
otherwise.
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BPI Clients

BPI has the following clients, which are accessed from the Gateway Server 
where the BPI Application is available. These clients require both the 
Gateway Server to be running and the BPI Servlet Engine to be enabled:

• Modeler

This is an application that you use to create and deploy your Business 
Processes. Using the Modeler to configure Business Processes is described 
in the Business Process Insight Training Guide - Modeling Processes. 
Managing the Modeler is described in Chapter 4, Modeler of this guide.

• Monitor Definer

You use the Monitor Definer to configure Business Process monitors and 
monitor instance threshold definitions. Examples and scenarios for using 
the Monitor Definer to configure Business Process monitors and 
thresholds are described in the Business Process Insight Training Guide - 
Defining Business Monitors. Managing the Monitor Definer is described in 
Chapter 5, Monitor Definer of this guide.

• Process Repository Explorer

Use the Process Repository Explorer to view and manage entries in the 
Process Repository database. The Process Repository database holds the 
details of the Business Processes that you have created using the BPI 
Modeler. The Repository Explorer is described in Chapter 6, Process 
Repository Explorer. 
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• The Process Intervention

Use the Process Intervention Tool to make changes to definitions and 
instances that are active or completed in the Business Impact Engine. The 
Process Intervention tool is described in Chapter 7, Process Intervention.

• Notification Administration 

Use the Notification Administration:

— to add and configure users who want to receive email notifications of 
instance violations from BPI. 

— to configure HPOM to receive HP Operations Manager messages.

— to configure scripts.

Using the Notification page to configure the Notification Server is 
described in Chapter 8, Notification.

In addition there are BPI Application pages. These are the pages that enable 
you to monitor and track your Business Processes and are described in 
Chapter 9, BPI Application Concepts.

You can also configure your own security options for accessing the BPI 
interfaces. You do this using the Servlet Engine (Tomcat); see.Chapter 15, 
Servlet Engine Authentication.
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Log File Locations and Changing the Log Viewer

All the BPI components have log files; however the log files presented through 
the Status pane relate only to the BPI Server components, which are 
managed using the Administration Console. 

The Modeler is not a BPI server component and its log file is described in 
Chapter 4, Modeler. The structure of all BPI log files is described in the 
Business Process Insight Problem Solving Guide.

All the BPI Server log files are located in the following directory:

bpi-install-dir\data\log

Use the View Log button on the Status pane (adjacent to the Start and Stop 
buttons) to view the log files for the server components. By default the logs are 
displayed using notepad.

Section Component Configuration - Logging on page 103 describes the 
parameters for modifying the viewer application that is used to display the log 
files for BPI Server components.
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Component Configuration - Notification Server

Table 1 lists the parameters that you can modify to change the configuration 
of the Notification Server using the Administration Console.

Table 1 Notification Server Parameters

Descriptive Parameter Name Description

SMTP hostname The fully qualified domain name of the system where 
the SMTP email server is running; you can also 
enter localhost where appropriate.
The BPI system needs access to a running SMTP 
email server in order to send impact violations 
through email to registered users.
Refer to Chapter 8, Notification for information 
about registering users to receive email notifications.

SMTP port number The port number that the SMTP server is 
communicating on.
The BPI system communicates with the SMTP email 
server through a specific port number, which is 
usually port 25.

Sender email address The email address that you want to appear in the 
Sender: field on email notifications sent from the 
BPI system. This is the email address that identifies 
where the message originated from.

Retry interval to SMTP server 
(minutes)

The time (in minutes) that the Notification Server 
waits before attempting to send a notification to the 
SMTP server, if it fails on the first attempt. If the 
Notification Server is unable to send the message, it 
logs a warning message and temporarily stores the 
message in the database. The message is removed 
from the database when the notification is 
successfully delivered, or the retry limit is exceeded.
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Maximum retries to SMTP server Maximum number of retry attempts made by the 
Notification Server to send a notification message to 
the SMTP server. When the maximum number of 
retries is reached, the Notification Server deletes the 
message from the database, issues an error message 
in its log file and makes no further attempts to 
deliver the message to the email server.

Path to HP Operations Manager 
Opcmsg utility

The full path name for the opcmsg utility within HP 
Operations Manager. Used by the Notification 
Server to send notifications to HP Operations 
Manager.

Retry interval to HP Operations 
Manager (minutes)

The time (in minutes) that the Notification Server 
waits before attempting to send an HP Operations 
Manager message to HP Operations Manager, if it 
fails on the first attempt. If the Notification Server is 
unable to send the message, it logs a warning 
message and temporarily stores the message in the 
database. The warning message is removed from the 
database when the notification is successfully 
delivered.

Maximum retries to HP Operations 
Manager

Maximum number of retry attempts made by the 
Notification Server to send an HP Operations 
Manager message to HP Operations Manager. When 
the maximum number of retries is reached the 
Notification Server deletes the message from the 
database, issues an error message in its log file and 
makes no further attempts to deliver it.

Table 1 Notification Server Parameters

Descriptive Parameter Name Description
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Changing the Notification Server Parameters

To change the Notification Server parameters, complete the following steps on 
the Windows system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Notification Server option 
from the Navigator pane on the BPI Administration Console.

3. Enter the changes that you want to make to the Notification Server 
parameters in the right-hand pane as appropriate.

4. Click Apply to apply the changes to the BPI configuration.

Retry interval for script execution 
(minutes)

The time (in minutes) that the Notification Server 
waits before attempting to execute a script that you 
have created, if the script fails to execute on the first 
attempt. If the Notification Server is unable to 
execute a script, it logs a warning message in the 
Notification Server log file.

Maximum retries for script execution Maximum number of retry attempts made by the 
Notification Server to execute a script that you have 
created. When the maximum number of retries is 
reached the Notification Server, issues an error 
message in its log file and makes no further attempts 
to execute the script.

Timeout for script execution 
(seconds)

The time (in seconds) that the Notification Server 
waits before aborting the execution of the script, 
after the script has started executing. Once aborted, 
the Notification Server waits for the retry interval 
before attempting to execute the script again.

Table 1 Notification Server Parameters

Descriptive Parameter Name Description
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5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All buttons. You could stop and restart only the Notification 
Server and the Servlet Engine; however, you are recommended to use 
Stop All and Start All to make sure that components are started and 
stopped in the correct order.

The new Notification Server parameter values are now applied to your BPI 
system.

If you want to change the login password for the Notification Server 
Administration Console, refer to Chapter 15, Servlet Engine Authentication.
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Component Configuration - Business Impact Engine 
(BIE)

The Business Impact Engine configuration parameter settings are divided 
into a number of logical sections. These sections appear within the 
Administration Console under the Engine option as follows:

• BIE Java Virtual Machine (JVM) settings

• BIE Model Cleaner settings

• BIE Process and Data Instance Cleaner settings

• BIE Event settings

• BIE Event Queue settings

• BIE Notification settings

• BIE JDBC settings

The parameters relating to these settings appear on the right-hand pane of 
the Administration Console when you select one of these options in the 
console’s navigation tree. If the options are not visible, you need to expand the 
entries under Engine using the usual Explorer style navigation techniques.

BIE Java Virtual Machine (JVM) Settings

This section describes the parameters that you can modify through the BIE 
Java Virtual Machine (JVM) settings option.

Table 2 shows the Business Impact Engine parameters that enable you to 
modify the amount of memory heap available to the JVM for the system.
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A heap is a storage management structure for tracking and allocating 
memory. In this case, the Java heap is used for allocating the Java objects 
used by the Engine.

Modifying the BIE Java Virtual Machine (JVM) Settings

To change the BIE Java Virtual Machine (JVM) Settings, complete the 
following steps on the Windows system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Business Impact Engine 
(BIE) > BIE Java Virtual Machine (JVM) settings option from the 
Navigator pane on the BPI Administration Console.

3. Enter the changes that you want to make to the settings as appropriate in 
the right-hand pane.

4. Click Apply to apply the changes to the property files.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options. 

The new Business Impact Engine settings are now applied to your BPI 
system.

Table 2 BIE Java Virtual Machine (JVM) Settings

Descriptive Parameter Name Description

Initial size of the JVM heap (MB) The initial size of the storage allocated by the JVM 
for Java objects.

Maximum size of the JVM heap (MB) The maximum size of the storage allocated by the 
JVM for Java objects.
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BIE Model Cleaner Settings

This section describes the parameters that you can modify through the BIE 
Model Cleaner Settings option. The Model Cleaner is a thread that runs at 
intervals and deletes Process and Data definitions that have been undeployed 
and that no longer have any associated instances, either in progress or 
completed.

Table 3 shows the Business Impact Engine parameters that enable you to 
remove undeployed Process and Data definitions from the BPI Instance 
database.

Table 3 BIE Model Cleaner Settings

Descriptive Parameter Name Description

Delay between checking for all 
Models (minutes)

The time interval (in minutes) that the Business 
Impact Engine waits before reading the latest list of 
definitions. This list is used as input for the Delay 
between checking each model parameter.

Delay between checking each Model 
(seconds)

The time (in seconds) that the Business Impact 
Engine waits between checking each entry in the list 
of definitions created as a result of the Delay 
between checking for all models parameter. It 
is used to establish those definitions that have been 
undeployed and which are therefore candidates to be 
deleted.
Definitions are not deleted if:
• the definition is deployed.
• there are associated instances in the database, 

either in progress or completed.
• the definition is referenced from another 

definition that is currently defined in the BPI 
Instance database; for example, a Data Definition 
is referenced from a Process definition.

Disable cleanup of files for Models 
not in database?

A check box indicating whether or not to remove the 
Java source, Java Class and script files for process 
and data models that have been cleaned from the 
Business Impact Engine. When checked, the source, 
classes and scripts are not removed.
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Modifying the BIE Model Cleaner Settings

To change the BIE Model Cleaner Settings, complete the following steps on 
the Windows system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Business Impact Engine 
(BIE) > BIE Model Cleaner settings option from the Navigator pane 
on the BPI Administration Console.

3. Enter the changes that you want to make to the Engine settings as 
appropriate in the right-hand pane.

4. Click Apply to apply the changes to the property files.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options. 

The new Business Impact Engine settings are now applied to your BPI 
system.

BIE Process and Data Instance Cleaner Settings

This section describes the parameters for the BIE Process and Data 
Instance Cleaner settings. 

The BIE Process and Data Instance Cleaner settings section describes 
how often the instance cleaner thread is run and therefore how often the 
Completed and Active instances are deleted (or not deleted) from the 
database. Chapter 14, Deleting Completed Instances from the Database 
provides more information on the business Impact Engine instance cleaner 
threads and the parameters that control it.

Instances are initially marked as being candidates to be deleted and the 
business impact Engine instance cleaner then runs at intervals that you 
specify to delete the instances that have been marked as candidates. More 
details of this process are provided in Chapter 14, Deleting Completed 
Instances from the Database.
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You also have the option to delete completed instances as soon as they are 
complete using this setting. There is no requirement for the Engine Instance 
Cleaner to run in this case, as the instances are deleted as soon as they are 
complete.

For a new installation, the Engine Instance Cleaner threads does not run and 
instances are not deleted when they complete. Completed and Active 
instances can therefore accumulate in the database and this, eventually, has 
an impact on the performance of your BPI system.

If performance, or space, is a consideration, you need to modify this default to 
remove these instances and also consider archiving data in order that you can 
view historical data. Refer to Chapter 7, Process Intervention for details of 
how you can specify your own SQL to archive process data before it is removed 
from the BPI database.

There are settings for how often the Engine Instance Cleaner marks instances 
as being candidates to be deleted, plus individual settings for controlling 
when the Completed and Active Instances are deleted. These are described in 
Table 4, Table 5 and Table 6.

If you delete the data for all Completed instances as soon as they are 
completed, data is no longer available to be viewed through the Process 
Instance and Violation Web pages for viewing purposes.
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Table 4 lists the BIE Process and Data Instance Cleaner thread settings, 
which enable you to control how often the instance cleaner thread is executed.

Table 4 BIE Process and Data Instance Cleaner Settings

Descriptive Parameter Name Description

Mark instances for deletion: The option for marking process and data instances 
as candidates to be deleted by the Instance Cleaner 
thread at a specified interval. 
You have the following options:
• Never - instances are never marked to be deleted.
• Periodically - instances are marked to be 

deleted at the interval that you specify.
• Once a day - instances are marked to be deleted 

once a day, at the time that you specify. 
• Twice a day - instances are marked to be deleted 

twice a day, at the times that you specify.

Delete interval for marked instances The time interval used to control when the instance 
cleaner thread runs to delete any instances that 
have been marked for deletion.

Delete batch size The maximum number of active and complete 
process and data instances that the instance cleaner 
thread deletes in one Delete interval. There are 
four batches, one each for active and complete 
process instances, and active and complete data 
instances.
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Table 5 lists the settings that control when Completed process and data 
instances are deleted from the BPI Instance database.

Table 5 Completed Process and Data Instance Cleaner Settings

Descriptive Parameter Name Description

Delete completed instances from the 
database

The option for deleting Completed instances from 
the database. You have the following options for 
deleting Completed instances:
• Never - completed instances are never deleted 

and remain in the database
• As scheduled above - completed instances are 

deleted from the database at an interval that you 
specify in the BIE Engine Process and Data 
Instance Cleaner settings options.

• Immediately on completion - completed 
instances are deleted as soon as they reach the 
state COMPLETED and are not under the control of 
the settings for the Engine Instance Cleaner 
thread.

Age of the completed instances to be 
removed (minutes)

The age (in minutes) that the Completed instances 
must be before they can be deleted.
The following are quick references to common time 
durations expressed as minutes:
1 day = 1440 minutes
1 week (7 days) = 10080 minutes
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Table 6 lists the settings that control how often Active process and data 
instances are deleted from the BPI Instance database.

These parameters, and information about archiving instances before deleting 
them, are further described in Chapter 14, Deleting Completed Instances 
from the Database.

Modifying the BIE Instance Cleaner Settings

To change the BIE Instance Cleaner Settings, complete the following steps on 
the Windows system where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Business Impact Engine 
(BIE) > BIE Process and Data Instance Cleaner settings option 
from the Navigator pane on the BPI Administration Console.

3. Enter the changes that you want to make to the Engine Instance Cleaner 
settings as appropriate in the right-hand pane.

4. Click Apply to apply the changes to the property files.

Table 6 Active Process and Data Instances Cleaner Settings

Descriptive Parameter Name Description

Delete active instances from the 
database?

This is an indication of whether or not you want to 
delete active instances from the database. 
• Never - active instances are never deleted and 

remain in the database
• As scheduled above - active instances are 

deleted from the database at an interval that you 
specify in the Engine Process and Data 
Instance Cleaner settings options.

Age of the active instances to be 
removed:

The age (in days, hours or minutes) that the Active 
instances must be before they can be deleted.
If you enter a value of 60 minutes, the next time that 
you access this pane, the value is presented in terms 
of hours and not minutes.
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5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options. 

The new Business Impact Engine settings are now applied to your BPI 
system.

BIE Event Settings

This section describes the parameters that you can modify through the BIE 
Event settings option. 

The parameter settings listed in Table 7 enable you to minimize the amount of 
time that the components spend in loops and possible database deadlock 
situations and provides settings for throughput rates.

Table 7 BIE Event Settings

Descriptive Parameter Name Description

Maximum event generation number A limit for the number of child events created from 
an initial incoming event. This is intended to 
interrupt potential infinite loops for subscriptions to 
data definitions.

Maximum retries for an event 
transaction deadlock

When processing an individual event, this is the 
maximum number of attempts by the Business 
Impact Engine to retry a database transaction before 
aborting it. It is possible for deadlocks to occur when 
the Engine and other applications are accessing the 
BPI database simultaneously.
When the maximum number of retries is exceeded, 
the Business Impact Engine generates an error 
message and sends an exception to the Business 
Event Handler. The Business Event Handler then 
rolls back the event transaction and retries at a later 
time.
44 Chapter 2



Modifying the BIE Event Settings

To change the BIE Event Settings, complete the following steps on the 
Windows system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configuration > Business Impact Engine 
(BIE) > BIE Event settings option from the Navigator pane on the 
BPI Administration Console.

3. Enter the changes that you want to make to the Engine settings as 
appropriate in the right-hand pane.

4. Click Apply to apply the changes to the BPI configuration.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options. 

The new Business Impact Engine settings are now applied to your BPI 
system.

Event sample count used for 
calculating rates

The number of Events used as a basis for calculating 
throughput rates. Set this parameter according to 
the incoming Event rate (to the Business Impact 
Engine). You want to use sufficient numbers of 
Events to give you a realistic throughput rate.

Decay period for rates when no 
events are received (seconds)

The time period after which the throughput rates are 
decremented, in stages, to zero. This is used for 
periods of inactivity, to maintain realistic results for 
throughput rates.

Table 7 BIE Event Settings

Descriptive Parameter Name Description
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BIE Event Queue Settings

The following are the parameters that you can modify through the BIE Event 
Queue settings option.

These settings enable you to configure a business event queuing mechanism 
within the Business Impact Engine (BIE). When you select the option to use a 
queue for incoming events, all new business events are placed on a queue by 
the BIE. This means that any source of business events, for example: the 
Business Event Handler or the JMS Business Event Handler does not need to 
wait for the BIE to process the business event and can immediately return to 
tracking the event source and process the next incoming business event. This 
allows the BIE to have multiple threads to process business events. 

If you choose not to use a queue for business events, the Business Event 
Handler waits until the business event has been processed by the BIE; this 
includes waiting for all the necessary information from the event to be 
committed to the database. The effect of this is to make the BIE 
single-threaded for event processing; the options are all disabled and any 
setting for the number of event handling threads is ignored.

The settings listed in Table 8 on page 46 control whether or not a queue is 
utilized for business events and the characteristics of the queuing mechanism.

Table 8 BIE Event Queue Settings

Descriptive Parameter Name Description

Use a queue for incoming events? Select this option if you want BPI to use a queue for 
incoming business events. Clear the check box if you 
do not want to use a queue.

When cleared, all the remaining options for the BIE 
Event Queue settings are unavailable. 

Maximum number of events in the 
queue

The maximum number of business events that can 
be placed on the queue. When the number of 
business events on the queue reaches this maximum, 
no further business events can be added to the 
queue. In this case, the Business Event Handler has 
to wait until the queue is reduced before it can add 
further events.
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Save the queue to the database Select this option if you want to write each business 
event to the database either as it arrives on the 
queue, or each time the Business Impact Engine is 
shut down (where shut down is stopping the 
Business Impact Engine from the Administration 
Console, or stopping the Windows Services.)
Using this option enables you to rebuild the queue in 
the event of a system failure. If the business events 
are not written to the database on arrival, there is a 
risk that the events might be lost following a system 
failure. Be aware that there is a possible 
performance impact when you select the option to 
save each event as it arrives to the database.

Event queue cleaner interval (mins) The time interval used to control the frequency that 
the event queue cleaner runs. Each time the event 
queue cleaner runs, it deletes, from the database, all 
business events that have been successfully 
processed by the BIE.
This setting is available when the option to save the 
queue to the database for every event is selected.

Number of event handling threads The number of individual processes available to 
process business events held on the event queue. 
A recommendation is to set this parameter to be 
twice the number of CPU cores that are available on 
your machine. Be aware that setting this property to 
a value of other than one, requires you to purchase 
an Enterprise license for BPI.

Table 8 BIE Event Queue Settings

Descriptive Parameter Name Description
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Modifying the BIE Event Queue Settings

To change the BIE Event Queue Settings, complete the following steps on the 
Windows system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Business Impact Engine 
(BIE) > BIE Event Queue settings option from the Navigator pane on 
the BPI Administration Console.

3. Enter the changes that you want to make to the Business Impact Engine 
settings as appropriate in the right-hand pane.

4. Click Apply to apply the changes to the BPI configuration.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options.

The new Business Impact Engine settings are now applied to your BPI 
system.
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BIE Notification Settings

The following are the parameters that you can modify through the BIE 
Notification settings option.

If the Business Impact Engine initially fails to send an event notification to 
the Notification Server, it can try again. The settings listed in Table 9 on 
page 49 control at what impact level notifications are sent, and the number of 
retry attempts and the interval between the retries for the notifications.

Table 9 BIE Notification Settings

Descriptive Parameter Name Description

Process step impact notification 
severity threshold

The minimum instance threshold for the severity for 
a Business Process Step’s KPI that can trigger an 
impact of impeded or blocked for the process. When 
one (or more) Step services reach the instance 
threshold specified a notification event is issued. 
Possible levels of severity are: Normal, Warning, 
Minor, Major and Critical. These map to other HP 
BTO Software products’ levels of severity.

Maximum number of retries The maximum number of attempts that the Business 
Impact Engine tries to send a notification event to 
the Notification Server, if the initial attempt fails. 
When the maximum number of retries is reached, 
the Business Impact Engine issues an error message 
in its log file and makes no further attempts to send 
the notification event.

Retry delay (seconds) The delay (in seconds) between the Business Impact 
Engine’s attempts to retry sending notification 
events to the Notification Server. Each time the 
Engine fails a retry attempt, it issues a warning 
message to the log file.
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Modifying the BIE Notification Settings

To change the BIE Notification Settings, complete the following steps on the 
Windows system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Business Impact Engine 
(BIE) > BIE Notification settings option from the Navigator pane 
on the BPI Administration Console.

3. Enter the changes that you want to make to the Business Impact Engine 
settings as appropriate in the right-hand pane.

4. Click Apply to apply the changes to the BPI configuration.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options.

The new Business Impact Engine settings are now applied to your BPI 
system.
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BIE JDBC Settings

The following are the parameters that you can modify through the BIE JDBC 
settings option.

Table 10 lists the settings that enable you to tailor the JDBC connection 
between the BIE and the database.

Table 10 BIE JDBC Settings

Descriptive Parameter Name Description

Maximum number of active JDBC 
Connections

The maximum number of JDBC connections that the 
Business Impact Engine can have active at any one 
time.
If a connection does not become available in the 
required time, the connection is refused and the 
Engine is unable to commit the transaction. In this 
case, the Engine writes an error to its log file.

Maximum wait time for a JDBC 
Connection (seconds)

The maximum length of time (in seconds) that the 
Business Impact Engine waits for an available JDBC 
connection before reporting an error.
If a connection does not become available in the 
required time, the connection is refused and the 
Engine is unable to commit the transaction. In this 
case, the Engine writes an error to its log file.

Maximum number of idle JDBC 
Connectionsa

The maximum number of JDBC connections that can 
be idle at any one time. Set this to at least the 
number of active connections.

Maximum number of active JDBC 
Prepared Statements1

The maximum number of database Prepared 
Statements that can be active at any one time.

Maximum wait time for a JDBC 
Prepared Statement (seconds)

The maximum length of time (in seconds) that the 
Business Impact Engine waits for a Prepared 
Statement to be executed before reporting an error 
in the log file and aborting the transaction.

Maximum number of idle JDBC 
Prepared Statements1

The maximum number of Prepared Statements that 
can be idle at any one time.

a. These connections are managed by Apache Commons DBCP (Database Connection Pool).
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Modifying the BIE JDBC Settings

To change the BIE JDBC Settings, complete the following steps on the 
Windows system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Business Impact Engine 
(BIE) > BIE JDBC settings option from the Navigator pane on the BPI 
Administration Console.

3. Enter the changes that you want to make to the Engine settings as 
appropriate in the right-hand pane.

4. Click Apply to apply the changes to the BPI configuration.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options.

The new Business Impact Engine settings are now applied to your BPI 
system.
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Component Configuration - Monitor Engine

The Monitor Engine configuration parameter settings are divided into a 
number of logical sections. These sections appear in the Administration 
Console, under the Monitor Engine option as follows:

• Monitor Engine Java Virtual Machine (JVM) settings

• Monitor Engine Events Settings

• Monitor Engine Statistics settings 

• Monitor Engine Threshold settings

• Monitor Engine Instance Cleaner settings

The parameters relating to these settings appear on the right-hand pane of 
the Administration Console when you select one of the Monitor Engine 
options in the console’s navigation tree. If the Monitor Engine options are not 
visible in the navigation tree, expand the entries under Monitor Engine using 
the usual Explorer-style navigation techniques.

Monitor Engine Java Virtual Machine (JVM) Settings

This section describes the parameters that you can modify through the 
Monitor Engine Java Virtual Machine (JVM) settings option. These are the 
Monitor Engine parameters that enable you to modify the amount of memory 
heap available to the JVM and are listed in Table 11.

A heap is a storage management structure for tracking and allocating 
memory. In this case, the Java heap is used for allocating the Java objects 
used by the Monitor Engine.

Table 11 Monitor Engine Java Virtual Machine (JVM) Settings

Descriptive Parameter Name Description

Initial size of the JVM heap (MB) The initial size of the storage allocated by the JVM 
for Java objects.

Maximum size of the JVM heap (MB) The maximum size of the storage allocated by the 
JVM for Java objects.
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Modifying the Monitor Engine Java Virtual Machine Settings

To change the Monitor Engine Java Virtual Machine Settings, complete the 
following steps on the Windows system where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configuration > Monitor Engine > Monitor 
Engine Java Virtual Machine (JVM) settings option from the 
Navigator pane on the BPI Administration Console.

3. Enter the changes that you want to make to the Monitor Engine Java 
Virtual Machine settings as appropriate in the right-hand pane.

4. Click Apply to apply the changes to the property files.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI components.

The new settings are now applied to your BPI system.

Monitor Engine Events Settings

This section describes the parameters that you can modify for the Monitor 
Engine Events settings option.

These settings provide control for the rate at which the Monitor Engine 
processes monitor events and the maximum sizes of the resulting database 
transactions as monitor events are processed.

The values for the Monitor Engine Events settings have been set to be 
suitable for most implementations. You should not change them unless you 
are advised to by your support representative.

The Monitor Engine Events settings are divided into two logical sections. 
These sections appear on the Monitor Engine Events settings pane within 
the following categories:

• Monitor Engine Event processing settings

• Monitor Engine performance checking settings 
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The Monitor Engine Event processing settings parameters are listed in 
Table 12.

Table 12 Monitor Engine Event Processing Settings

Descriptive Parameter Name Description

The maximum number of pooled 
monitor event processors (1 to19)

The number of parallel threads available to the 
Monitor Engine for processing different monitor 
events.
Be aware that setting this property to a value of 
other than one, requires you to purchase an 
Enterprise license for BPI.

The maximum number of monitor 
events to process in each batch

The number of monitor events that can be processed 
in a single batch. This provides a balance between 
the monitor event processing rate and database 
transaction size. It also optimizes how the monitor 
events are processed across all available threads.

The monitor events idle wait time 
(seconds)

Each time the Monitor Engine determines that there 
are no more monitor events to process, it waits for 
this time period before checking again.
This prevents the Monitor Engine continuously 
initiating searches that can return no results.
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The following settings provide some control to regulate the rate at which 
monitor events are generated by the Business Impact Engine. It is used to 
make sure that the Business Impact Engine does not create monitor events at 
a rate that the Monitor Engine is unable to keep up with,

The Monitor Engine performance checking settings parameters are 
listed in Table 13.

Modifying the Monitor Engine Events Settings

To change the Monitor Engine Events settings complete the following 
steps on the Windows system where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Monitor Engine > Monitor 
Engine Events settings option from the Navigator pane on the BPI 
Administration Console.

Table 13 Monitor Engine Performance Checking Settings

Descriptive Parameter Name Description

The monitor events queue length 
high-water mark

This is the number of unprocessed monitor events 
that signal that the Monitor Engine is not keeping 
up with the Business Impact Engine.
When the high-water mark is exceeded, the Business 
Impact Engine temporarily stops processing 
Business events until the Monitor Engine has 
reduced the backlog to below the low-water mark.

The monitor events queue length 
low-water mark

This is the number of unprocessed monitor events 
that signal that the Monitor Engine has cleared its 
backlog and is now keeping up with the Business 
Impact Engine.
As a result, the Business Impact Engine can resume 
its processing of Business events. 

Interval for checking Monitor Events 
queue length (seconds)

Time interval (in seconds) at which the number of 
Monitor Events waiting to be processed is checked 
against the values of the high-water mark and 
low-water mark parameters. 
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3. Enter the changes that you want to make to the Monitor Engine Events 
settings as appropriate in the right-hand pane.

4. Click Apply to apply the changes to the property files.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI components.

The new settings are now applied to your BPI system.

Monitor Engine Statistics Settings

The Monitor Engine Statistics settings parameters control how the 
Monitor Engine processes the staged statistical data and stores them in the 
configured statistical time intervals (Data Samples setting).

Staged statistical data are produced and stored as monitor events are 
processed. At intervals that you configure, the Monitor Engine collects the 
staged statistics into the statistics table for the completed time intervals. 
Most of the parameters in Table 14 control the rate at which statistics are 
generated and these settings should not be modified unless you are instructed 
to do so by your support representative. The exception is the settings that 
controls how far back in time monitor statistics are generated when the 
Monitor Engine is restarted.

When BPI is restarted following a system shutdown, the monitor statistics are 
calculated for all the monitor definitions defined for processes. If you have 
shut your BPI system down for a significant amount of time (several days), 
then these statistic calculations can take considerable time, and impact the 
performance of your system. You can configure how far back in time to 
calculate these statistics following a restart using the Maximum age of 
generated statistics on startup (days) setting.

In Table 14, the following settings are used to control how the staged statistics 
are processed into the statistical time intervals:

• The maximum number of statistics consolidators (1 to 19)

• The maximum number of staged statistics’ rows per transaction

• The maximum number of staging transactions each time

• The maximum number of statistics aggregators (1 to 19)
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In the description of the parameters, consolidation is the process of producing 
the data for specific time intervals directly from the staged data. If you have 
defined Business Monitors that have Groups, aggregation is then the process 
of taking all the individual groups' time interval data and producing the 
overall time interval data, where overall is the combined data for all the 
groups.

Table 14 lists the parameters that you can set to configure how often the 
Monitor Engine polls the BPI database.

Table 14 Monitor Engine Statistics Settings

Descriptive Parameter Name Description

Statistics generation polling interval 
(seconds)

The time interval (in seconds) that the Statistics 
generator polls the BPI database tables in order to 
update the statistics that have been configured using 
the Monitor Definer.

Maximum age of generated statistics 
on startup (days)

The time interval (in days) that the Monitor Engine 
uses to calculate historical monitor statistics 
following a period of BPI shutdown.

The maximum number of statistics 
consolidators (1 to 19)

The number of parallel threads available to 
consolidate the staged statistical data, for different 
monitor events, into the user-defined statistical time 
intervals. This includes monitor events that have 
Groups defined.

The maximum number of staged 
statistics’ rows per transaction

Controls the size of database transactions as the 
statistical data is being consolidated.

The maximum number of staging 
transactions each time

Controls the rate at which statistics are 
consolidated. This is a multiplier of The maximum 
number of staged statistics’ rows per 
transaction and is applied each time the Monitor 
Engine processes statistics.

The maximum number of statistics 
aggregators (1 to 19)

The number of parallel threads available to 
aggregate statistics that have Groups defined into 
their overall statistical time intervals.
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Modifying the Monitor Engine Statistics Settings

To change the Monitor Engine Statistics settings, complete the 
following steps on the Windows system where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Monitor Engine > Monitor 
Engine Statistics settings option from the Navigator pane on the 
BPI Administration Console.

3. Enter the changes that you want to make to the Monitor Engine 
Statistics settings as appropriate in the right-hand pane.

4. Click Apply to apply the changes to the property files.

5. Select the Status option to move to the panel where the BPI component 
status is shown.

6. Stop and restart all the BPI components.

The new settings are now applied to your BPI system.
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Monitor Engine Threshold Settings

This section describes the parameters that you can modify through the 
Monitor Engine Threshold settings option.

The Monitor Engine Threshold Settings are divided into two logical sections. 
These sections appear on the Monitor Engine Threshold settings pane 
within the following categories:

• Monitor Engine Threshold checking settings

• Monitor Engine Threshold violation notification settings 

Table 15 lists the Monitor Engine Threshold settings that enable you to 
control how often the Monitor Engine polls its data in order to identify 
instance threshold information for alarms, notifications.

Table 16 lists the Monitor Engine Threshold settings that enable you to 
control the number of, and frequency at which, notifications (email, HP 
Operations Manager messages and script invocations) are sent out when 
monitor instance threshold violations occur. 

When an instance threshold is violated, the Monitor Engine database records 
the detail of the violation. You can then be notified of these instance threshold 
violations in a number ways; for example, email; this is done using the 
Notification Server.

Table 15 Monitor Engine Threshold Checking Settings

Descriptive Parameter Name Description

Threshold minimum sample count, 
used for calculating relative 
thresholds

The minimum number of monitor instances required 
for the calculation of the relative scope thresholds.
If the number of monitor instances available for 
sampling is less than this minimum figure, the 
instance threshold is not calculated. As a result, 
there are no notifications or alarms generated based 
on the threshold.

The maximum number of pooled 
threshold monitors (1 to 19)

The number of parallel threads available to the 
Monitor Engine for processing different Business 
Monitor Thresholds
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Where there is a significant failure in your business, for example, an 
application becomes unavailable, you can have the situation where thousands 
of thresholds are violated, or a small number of thresholds are violated many 
times. This can result in large numbers (or a storm) of notifications being 
generated. In the case of email, this can quickly fill up your email Inbox and it 
is possible that your email Server is unable to keep up with the rate at which 
the notifications are generated. This in turn creates a backlog of notifications 
and can severely impact the performance of the BPI system. In the case of HP 
Operations Manager messages or scripts, the backlog created depends on how 
your system is configured to receive the notifications.

Use the parameters in Table 16 to control the frequency and numbers of 
notifications that you receive. This reduces the possibility of these notification 
storms occurring, and still notifies users of the monitor instance threshold 
violations.

The following is an example of the effect of setting these parameters:

The parameter values set when you install BPI for the first time are: 

— 300 seconds for the polling interval 

— a maximum of 10 notifications for each instance threshold violated

This means that you receive a maximum of 10 notifications for each 
instance threshold violation, every 5 minutes (300 seconds); this is for 
each instance threshold. If there are 20 thresholds violated, there are 
potentially 200 (10 x 20) notifications in each 5 minute polling interval.
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If you know the number of instance threshold violations your business is 
likely to generate, you can set these parameters such that:

• you receive all notifications for the occasional problems.

• you have the maximum instance threshold set such that when there is a 
system failure, notification storms are prevented and you receive a 
summary instead.

This also has the effect of reducing the impact of notification storms on BPI 
performance.

Modifying the Monitor Engine Threshold Settings

To change the Monitor Engine Threshold Settings, complete the following 
steps on the Windows system where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Monitor Engine > Monitor 
Engine Threshold settings option from the Navigator pane on the BPI 
Administration Console.

3. Enter the changes that you want to make to the Monitor Engine 
Threshold settings as appropriate in the right-hand pane.

Table 16 Monitor Engine Threshold Violation Notification Settings

Descriptive Parameter Name Description

Threshold violation notification 
polling interval (seconds)

The time interval (in seconds) that the Monitor 
Engine waits between the time that is sends the last 
notification message at the end of one polling period, 
to the start of the next polling period.

Maximum number of individual 
violation notifications per threshold 
per polling interval

The maximum number of violation notifications sent 
to the Notification Server for each business monitor 
instance threshold. The actual number of threshold 
violations generated might be significantly more 
than this maximum; however, if you are using the 
default Velocity email templates, each email 
notification also has summary information, which 
includes all the instance threshold violations 
generated during the polling interval. 
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4. Click Apply to apply the changes to the property files.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI components. 

The new settings are now applied to your BPI system.

Monitor Engine Instance Cleaner Settings

This section describes the parameters that you can modify through the 
Monitor Engine Instance Cleaner settings option.

The Monitor Engine instance cleaner settings section controls how often the 
Monitor Engine instance thread is run and therefore how often Active and 
Completed monitor instances, Monitor violation instances and statistics are 
deleted.

The configuration parameters are divided into a number of logical sections. 
These sections appear in the Monitor Engine Instance Cleaner settings pane 
within the following categories:

• Monitor Engine Instance Cleaner settings 

• Active Monitor Instances settings

• Completed Monitor Instances settings

If

If you set a low Collection interval for your Business Process monitor 
definitions, the monitor data can accumulate very quickly and consume a 
considerable amount of disk space. In addition, if you shutdown your BPI 
system and restart it after a significant amount of time, the monitor statistics 
are calculated for the period of the shutdown as soon as the BPI Server is 
restarted. As an example, if you set a Collection interval of five minutes and 
shut down your BPI system for a week. When you restart your BPI Server, the 
Monitor Engine calculates all the monitor statistics for each five-minute 
period since the last time the monitors were calculated. This can result in a 
significant amount of calculation time, and a significant amount of disk space 
for the results. 

If these results are immediately deleted as a result of the instance cleaner 
settings, this can also have an impact on the overall operational performance 
of your machine.

The Collection interval is set as the value for the Data Samples period. 
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• Monitor Statistics settings

• Monitor Violation Instances settings

The parameters relating to these settings are described in the following 
sections.

Monitor Engine Instance Cleaner Settings

Table 17 lists the settings that controls how often the Monitor Engine 
instance cleaner thread is executed. This interval impacts all the other 
sections on the Monitor Instance Cleaner pane.

Table 17 Monitor Engine Instance Cleaner Settings

Descriptive Parameter Name Description

Instance cleaner execution interval 
(minutes)

The time period (in minutes) that you want the 
Monitor instance cleaner thread to run. When it 
runs, it deletes all eligible Active monitor instances, 
Completed monitor instances, Monitor Alarm 
instances and Statistics. This thread also deletes all 
monitor instances for monitors that have been 
marked as deleted in the Monitor Definer.
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Active Monitor Instances Settings

Table 18 lists the settings that enable you to control the amount of Active 
monitors instance data held in the BPI database tables.

Completed Monitor Instances Settings

Table 19 lists the settings that enables you to control the amount of 
Completed monitors instance data held in the BPI database tables.

Table 18 Active Monitor Instances Settings

Descriptive Parameter Name Description

Delete active monitor instances from 
the database?

Select this check box if you want to delete Active 
monitor instances from the BPI database tables. 
Clear the check box if you do not want to delete the 
Active monitor instances. 

Age of active monitor instances to be 
removed (days)

This option is available when you select the check 
box for deleting Monitor violation instances.
Enter the age (in days) of the Active monitor 
instances that you want to be deleted when the 
Monitor Engine instance cleaner thread is run.

Table 19 Completed Monitor Instances Settings

Descriptive Parameter Name Description

Delete completed monitor instances 
from the database?

Select this check box if you want to delete Completed 
monitor instances from the BPI database tables. 
Clear the check box if you do not want to delete the 
Completed monitor instances.

Age of completed monitor instances 
to be removed (days)

This option is available when you select the check 
box for deleting Completed monitor instances.
Enter the age (in days) of the Completed monitor 
instances that you want to be deleted when the 
Monitor Engine instance cleaner thread is run
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Monitor Statistics Settings

Table 20 lists the settings that enable you to control the amount of statistical 
data held in the BPI database tables.

Monitor Alarm Instances Settings

Table 21 lists the settings that enables you to control the amount of Monitor 
Alarm instance data held in the BPI database tables.

Table 20 Monitor Statistics Settings

Descriptive Parameter Name Description

Delete monitor statistics from the 
database?

Select this check box if you want to delete statistics 
from the BPI database tables. Clear the check box if 
you do not want to delete the statistics data.

Age of monitor statistics to be 
removed (days)

This option is available when you select the check 
box for deleting statistics.
Enter the age (in days) of the statistics data that you 
want to be deleted when the Monitor Engine 
instance cleaner thread is run

Table 21 Monitor Violation Instances Settings

Descriptive Parameter Name Description

Delete monitor violation instances 
from the database?

Select this check box if you want to delete Monitor 
Violation instances from the BPI database tables. 
Clear the check box if you do not want to delete the 
Monitor Violation instances.

Age of monitor violation instances to 
be removed (days)

This option is available when you select the check 
box for deleting Completed monitor instances.
Enter the age (in days) of the Monitor Violation 
instances that you want to be deleted when the 
Monitor Engine instance cleaner thread is run
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Modifying the Monitor Engine Instance Cleaner Settings

To change the Monitor Engine Instance Cleaner Settings, complete the 
following steps on the Windows system where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Component Configurations > Monitor Engine > Monitor 
Engine Instance Cleaner settings option from the Navigator pane on 
the BPI Administration Console.

3. Enter the changes that you want to make to the Monitor Engine Instance 
Cleaner settings as appropriate in the right-hand pane.

4. Click Apply to apply the changes to the property files.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI components.

The new settings are now applied to your BPI system.
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Component Configuration - HP Business Availability 
Center Settings

The HP Business Availability Center settings options enable you to 
configure the details of the Gateway Server system (or Load Balancer) in 
order that the BPI Server can send data samples to the Gateway Server. 

The HP Business Availability Center settings page is divided into the 
following logical sections:

• Business Availability Center General settings; see Table 22.

These are the properties relating to the connection details for the 
Business Availability Center server that you want BPI to use and are 
required for both the Data Samples settings and for CI Poller settings.

• Data Sample settings; see Table 23.

These are the properties relating to the data that you want BPI to send to 
Business Availability Center.

• CI Poller settings; see Table 24.

These are the properties that enable BPI to receive status information 
relating to IT operational resources, which are configured for BPI CIs, 
within Business Availability Center.

To configure the properties of the Business Availability integration, make 
sure that the HP Business Availability Center settings option is 
selected in the Administration Console navigator pane. The parameters are 
displayed in the right-hand pane.
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Table 22 describes the settings related to connection details.

Table 22 Business Availability Center General Settings

Descriptive Parameter Name Description

Hostname of Gateway server The fully qualified DNS name of the machine where 
the Business Availability Center Gateway Server 
that receives data from the BPI Data Collectors is 
installed. This is the Gateway Server that provides 
the status information for process step KPIs or 
access to the UCMDB for BPI and is the Gateway 
Server when the BPI Data Samples are sent.
Alternatively, this could be the name of a Load 
Balancer if there is one configured.
This value can also be an IP address.

Use SSL? Select the checkbox to enable HTTP over SSL for the 
BPI:
• Data Sample Provider
• UCMDB synchronizer
• component obtaining status information for 

process Step KPIs
Clear the checkbox if you do not want to use HTTP 
over SSL. This parameter also requires that 
Business Availability Center is configured to use 
SSL; refer to the Business Availability Center help 
documentation for details of how to set this up.

HTTP(S) port of Gateway server The port number used by the Web Server on the 
Business Availability Center Gateway Server for 
Data Collectors. 
This is usually port 80 if SSL is not enabled, or port 
443 is SSL is enabled.
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User name The user name for a Business Availability Center 
account, which is for use by BPI to send data 
samples.
This can be an existing user, or a new user, as long as 
it has permissions to access the View name as 
specified in Table 24 on page 73. For a new 
installation the view name is Business Processes. 

Password The password set for User name.
If you have created your own user, enter the 
appropriate password details for this user name.

Basic authentication enabled? Select the checkbox to enable basic authentication. 
Clear the checkbox to disable basic authentication.
Select this option only when Business Availability 
Center is configured to use basic authentication for 
Web Server and Web browser communications.
Basic authentication is the BAC mechanism for 
enabling a Web browser (or Web client) to 
authenticate with the Web Server using a user name 
and a password; refer to the Business Availability 
Center help documentation for details of basic 
authentication.

Basic authentication user User name configured for basic authentication 
credentials.

Basic authentication password Password configured for basic authentication 
credentials.

Maximum retries for synchronization 
deadlock

Maximum number of times that you want BPI to 
attempt to send data to the Gateway Server.
This parameter ensures that, in the case of a 
deadlock, the synchronization attempt to the 
Gateway Server is aborted in order to break the 
deadlock.
Failed synchronizations are automatically retried at 
regular intervals.

Table 22 Business Availability Center General Settings

Descriptive Parameter Name Description
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Table 23 describes the settings related to the data that you want to send to 
Business Availability Center.

Table 23 Data Sample Settings

Descriptive Parameter Name Description

Data samples send interval 
(minutes)

The time interval (in minutes) that you want BPI to 
use to send data samples to the named Business 
Availability Center Gateway Server or Load 
Balancer.
Select a time from the drop-down list. The selection 
of time intervals is aligned with the time periods for 
the Business Availability Center SLM calculations. 
in order to provide the most accurate results.
This time interval is the measurement interval for 
all BPI Monitors.

Connection timeout (seconds) The period of time (in seconds) allowed for the BPI 
Server to request a connection with the Business 
Availability Center Gateway Server when sending 
data samples.
If this parameter is set to zero (0), the time allowed 
for requesting a connection is unlimited, that is, no 
timeout occurs.
If a timeout does occur, BPI attempts to resend the 
data sample after waiting for the interval configured 
for Data samples send interval.
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Guaranteed retention period 
(minutes)

The period of time (in minutes) that a Data Sample 
is guaranteed to be made available for transfer to the 
Business Availability Center Gateway Server and 
before it is discarded.
In cases where it is not possible to make a connection 
to the Business Availability Center Gateway Server, 
or where the Gateway Server’s buffer tables are full, 
BPI retains copies of each Data Sample for the 
period specified by this parameter.

Delay before sending samples 
(seconds)

Delay (in seconds) following the Data samples send 
interval to allow time for the Business Impact 
Engine and the Monitor Engine to collate data to be 
sent to Business Availability Center.
Setting a value for this parameter enables you to 
take account of the fact that there might be a time 
difference between when a business event is 
recorded by a business application and when BPI 
receives notification of the event from the 
application; this is because some business 
applications do not make data available 
immediately.
Setting a delay enables BPI to collect complete and 
accurate statistics for each send interval before 
sending data samples to the Gateway Server. It also 
means that BPI data shown within BAC lags behind 
the Last Update time by the value of this delay; for 
example, if the Last Update time in BAC is 10:30 
and you set a delay of 900 seconds (15 minutes), the 
values you see for the BPI data samples displayed 
within the BPI Application and elsewhere in BAC 
relate to the collection period ending at 10:15. 
Note: If you configure a delay that is more than 90 
seconds, you should also increase the Decay setting 
for BPI samples in BAC (see the BAC Dashboard 
Help). If you do not, a No Data status is shown for 
the BPI Application instance data.

Table 23 Data Sample Settings

Descriptive Parameter Name Description
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Table 24 describes the settings related to the status information that you 
want to receive from Business Availability Center.

Table 24 CI Poller Settings

Descriptive Parameter Name Description

View name The name of the Business Availability Center 
Dashboard view that contains the Business Process 
information (IT operational resource information in 
BPI terms), required for display in the BPI 
Application.
The default view for the Business Availability 
Center Dashboard is the Business Processes view.

Status event poll interval (seconds) The time interval (in seconds) that you want to be 
used for the CI Poller to poll the Business 
Availability Center Gateway Server (or Load 
Balancer) for status events.

Connection timeout (seconds) The period of time allowed for the BPI Server to 
request Service status information from the 
Business Availability Center Gateway Server (or 
Load Balancer) when requesting information 
relating to services.
If this parameter is set to zero (0), the time allowed 
for the connection is unlimited, that is, no timeout 
occurs.
If a timeout does occur, the BPI Server waits for the 
interval configured for Status event poll 
interval before issuing another request for status 
events.
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Modifying the Business Availability Center Settings

To change the HP Business Availability Center settings, complete the 
following steps on the Windows system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select Component Configurations > HP Business Availability 
Center settings option from the Navigator pane on the BPI 
Administration Console.

3. Enter the changes that you want to make to the settings as appropriate in 
the dialog presented.

4. Click OK to dismiss the dialog.

5. Click Apply to apply the changes to the BPI configuration.

You do not need to stop and start the components after changing these 
settings as the configuration changes are made automatically.

The new settings are now applied to your BPI system.
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Component Configuration - Process Repository

The Process Repository configuration has one of the following sections. The 
section that appears depends on the database type for the Process Repository 
Database and is related to the option that you selected and configured when 
you installed the BPI Server:

• MS SQL Server Access to the Process Repository database

• Oracle Server Access to the Process Repository database

The parameters relating to these settings appear on the right-hand pane of 
the Administration Console when you select one of these options in the 
console’s navigation tree.

Table 25 lists the parameters that you can modify for a SQL Server Database.

Changing the database connection details relating to the Process 
Repository does not automatically migrate data that is stored in the 
Process Repository database. You should not reconfigure the database 
connection unless you have already used the database tools to migrate 
your data.

Table 25 MS SQL Server Access to the Process Repository Database

Descriptive Parameter Name Description

MS SQL Server hostname The hostname of the system where the Microsoft 
SQL Server Database for the Process Repository is 
installed.

MS SQL Server port number The port number that the Microsoft SQL Server 
Database is expecting connections on.

MS SQL Server database name The name of the database configured for the Process 
Repository database.
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To change the password for the database, follow the instructions in section 
Changing the Password Details on page 77.

MS SQL Server authentication Select the type of authentication that you want to 
use when BPI connects to the Process Repository 
database. You can select either SQL Server 
authentication, or Windows authentication.
If you select SQL Server authentication, the MS 
SQL Server login user and MS SQL Server login 
password options are enabled, as you need to provide 
a username and password for the SQL Server 
authentication.
If you select Windows authentication, no 
additional information is required.

MS SQL Server username The name of the user who has access privileges to 
the database schema for the Process Repository.
This field is enabled only when you have selected 
SQL Server Authentication.

MS SQL Server password The password for the user who has access privileges 
to the database schema for the Process Repository. 
This field can be used to re-synchronize the BPI 
Server version of the password with the Process 
Repository database password after the database 
password is changed using the database 
management tools.
This field is enabled only when you have selected 
SQL Server Authentication.

Table 25 MS SQL Server Access to the Process Repository Database

Descriptive Parameter Name Description
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Table 25 lists the parameters that you can modify for an Oracle database

To change the password for the database, follow the instructions on section 
Changing the Password Details on page 77

Changing the Password Details

This section describes how to change the password for the Process Repository 
database user that you created during the BPI Server installation.

Complete the following steps to make the changes to the database password:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Stop all the BPI components using the Stop All button.

Table 26 Oracle Server Access to the Repository Database

Descriptive Parameter Name Description

Oracle Server hostname The hostname of the system where the Oracle Server 
Database for the Process Repository Database is 
installed.

Oracle Server port number The port number that the Oracle Server Database is 
expecting connections on.

Oracle Server SID The SID for the database configured for the Process 
Repository.

Oracle Server login user The name of the user who has access privileges to 
the database schema for the Process Repository.

Oracle Server login password The password for the user who has access privileges 
to the database schema for the Process Repository. 
This field can be used to re-synchronize the BPI 
Server version of the password with the Process 
Repository database password after the database 
password is changed using the database 
management tools.
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3. Select the Component Configurations > Process Repository > ... 
Server Access to the Repository Database option on the BPI 
Administration Console and make the changes to the following field:

— login password

4. Click Apply to apply the changes to the BPI configuration.

5. Return to the Status option and restart all the BPI components, using the 
Start All button. 

The new settings are now applied to your BPI Server system.
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Component Configuration - Business Event Handler

The Business Event Handler options enable you to configure the 
parameters for the Adaptor (based on openadaptor) that sends and receives 
events between the Business Impact Engine and the Business Event Handler.

These parameters are listed in Table 27.

Table 27 Business Event Handler Settings

Descriptive Parameter Name Description

Log package information? A check box that when checked means that the 
Business Event Handler logs package information.

Log thread information? A check box that when checked means that the 
Business Event Handler logs thread information.

Log time information? A check box that when checked means that the 
Business Event Handler logs time information.

Maximum number of socket source 
threads

Maximum number of threads that can be created for 
the adapter socket source. When this instance 
threshold is exceeded, the request for a thread is 
refused and the Business Event Handler reports a 
Connection Refused error in its log file.

Maximum number of retries to 
deliver events into Business Impact 
Engine

The maximum number of times the Business Event 
Handler attempts to deliver an event to the Business 
Impact Engine (using RMI) before rolling back the 
transaction for the business event.
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Modifying the Business Event Handler Parameters

To change these settings, complete the following steps on the Windows 
system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Business Event Handler option from the Navigator pane on 
the BPI Administration Console.

3. Enter the changes that you want to make to the settings as appropriate in 
the right-hand pane.

4. Click Apply to apply the changes to the BPI configuration.

Business Impact Engine event retry 
delay (seconds)

Time (in seconds) between each attempt to retry an 
event from the Business Event Handler to the 
Business Impact Engine using RMI.

Maximum number of retries to 
deliver events from Hospital

The maximum number of times the Business Event 
Handler attempts to deliver an event from the Event 
Hospital to the Business Impact Engine. 
The Business Impact Engine marks particular 
categories of event errors to result in the event being 
sent to the event Hospital and marked to be 
automatically discharged; for example, events that 
are received out of sequence before a data instance 
has been created for the event.
If the Business Event Handler does not succeed in 
delivering the event to the Engine in within the 
specified number of retries, the event remains in the 
event Hospital.

Hospital event poll interval (seconds) Time (in seconds) that the Business Event Handler 
polls the Event Hospital looking for events that have 
been marked as ready for discharge and that can be 
delivered to the Business Impact Engine.

Table 27 Business Event Handler Settings

Descriptive Parameter Name Description
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5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options. You can stop and restart the Business Event 
Handler component; however, you are advised to use Stop All and Start 
All to ensure that the BPI components are stopped and started in the 
correct order.

The new settings are now applied to your BPI system.
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Component Configuration - JMS Business Event 
Handler

Use the JMS Business Event Handler options to configure the parameters 
for your JMS connections., which enables BPI to receive business events from 
a JMS-based system.

These options appear hierarchically in the Administration Console, under the 
JMS Business Event Handler navigation option as follows:

• General settings

• Service Providers

• Event Sources

The parameters relating to these settings appear on the right-hand pane of 
the Administration Console when you select one of these options in the 
console’s navigation tree. If these options are not visible, you need to expand 
the entries under JMS Business Event Handler using the usual Explorer 
style navigation techniques.

BPI supports the JMS message type javax.jms.TextMessage, where the 
content of the text is an XML file in a particular format. This means you must 
be integrating with an application that sends and receives this message type 
if you want to use the JMS Business Event Handler. One example of such an 
application is HP Business Availability Center TransactionVision.
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General Settings

Table 28 describes the parameters that you can set to configure the behavior 
of your JMS connection.

Table 28 JMS General Settings 

Descriptive Parameter Name Description

Log package information? A check box that when checked means that the JMS 
Business Event Handler logs package information.

Log thread information A check box that when checked means that the JMS 
Business Event Handler logs thread information.

Log time information? A check box that when checked means that the JMS 
Business Event Handler logs time information.

Maximum number of retries to 
deliver events into Business Impact 
Engine

The maximum number of times the JMS Business 
Event Handler attempts to deliver an event to the 
Business Impact Engine (using RMI) before rolling 
back the transaction for the business event.
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Business Impact Engine event retry 
delay (seconds)

Time (in seconds) between each attempt to retry an 
event from the JMS Business Event Handler to the 
Business Impact Engine using RMI.

Maximum number of retries to 
deliver events from Hospital

The maximum number of times the JMS Business 
Event Handler attempts to deliver an event from the 
Event Hospital to the Business Impact Engine. 
The Business Impact Engine marks particular 
categories of event errors to result in the event being 
sent to the event Hospital and marked to be 
automatically discharged; for example, events that 
are received out of sequence and where there is no 
process or data instance created for the event.
If the JMS Business Event Handler does not succeed 
in delivering the event to the Engine in within the 
specified number of retries, the event remains in the 
event Hospital.

Hospital event poll interval (seconds) Time (in seconds) that the JMS Business Event 
Handler polls the Event Hospital looking for events 
that have been marked as ready for discharge and 
that can be delivered to the Business Impact Engine.

Table 28 JMS General Settings 

Descriptive Parameter Name Description
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Service Providers

This section describes the parameters that you can set to specify the details of 
the service providers that you are using for your JMS connections to BPI. You 
must add a Service Provider before you can configure a JMS Event Source. 
Note that there is a Service Provider already configured for a standard 
TransactionVision integration.

From the list of JMS Service Providers, you can:

• select HP TransactionVision from the list, if you want to configure an 
integration with TransactionVision. Click the Modify option to make 
changes to the TransactionVision JMS Service Provider parameters.

• click the Add button to add a new Service Provider to the list of available 
providers.

The JMS Service Provider Properties dialog is presented and the 
properties for adding a new service provider are described in Table 29.

Table 29 JMS Service Provider Properties

Descriptive Parameter Name Description

Service Provider Name Unique name that identifies the service provider 
within the BPI interfaces for administrative and 
identification purposes. The name can be up to 40 
characters.
In the case of TransactionVision, this name is 
predefined as HP TransactionVision.

Description An optional description of service provider.

Enabled? Select the check box to enable this service provider to 
send JMS Business Events to BPI. Clear the check 
box to disable the service provider.

Service Provider Classpath Location of the Service Provider client Java classes.
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Event Sources

This section describes the parameters that you can set to specify the details of 
the event sources that you want to access from your service provider. These 
are the event sources that will supply the transaction events that you have 
configured for your processes.

JNDI Provider Location Location of the JNDI service for the named Service 
Provider, typically this is a URL.
This parameter is predefined as tcp://
analyzerhost:21110 for the HP TransactionVision 
service provider. 
You need to replace analyzerhost with the host 
name of machine where the TransactionVision 
Analyzer is installed.

JNDI Factory Class The Java class name for the initial context factory 
for the JNDI service.
This parameter is predefined as 
com.sonicsw.jndi.mfcontext.MFContextFactory 
for the HP TransactionVision service provider. If this 
value is not correct for your implementation, you can 
modify it.

JMS Factory Class The Java class name for the initial context factory 
for the JMS service provider.
This parameter is predefined as BPIQueueFactory 
for the HP TransactionVision service provider. If this 
value is not correct for your implementation, you can 
modify it.

Table 29 JMS Service Provider Properties

Descriptive Parameter Name Description

You c

You cannot add a new Event Source until you have configured at least one 
Service Provider.
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There is a preconfigured JMS Event Source for HP TransactionVision, or you 
can click the Add button to add a new Event Source to the list. 

The JMS Event Source Properties dialog is presented and the properties 
for adding a new Event Source are described in Table 30. 

Modifying the JMS Business Event Handler Settings

To change these settings, complete the following steps on the Windows 
system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the JMS Business Event Handler option from the Navigator pane 
on the BPI Administration Console.

3. Enter the changes that you want to make to the settings as appropriate in 
the right-hand pane.

4. Click Apply to apply the changes to the BPI configuration.

Table 30 JMS Event Sources 

Descriptive Parameter Name Description

Service Provider Name Select the name of the service provider that you have 
configured to source the events that you require.

JMS Queue Subject The name of the JMS queue created for BPI at the 
selected Service Provider.
This parameter is predefined as 
TV2BPI.EVENT.QUEUE for the HP TransactionVision 
Queue Subject. You cannot modify this parameter, 
you must create a new JMS Event Source with a new 
name and Queue Subject if required.

User Name If required by the Service Provider, the name of the 
user with authority to access the queue identified by 
JMS Queue Subject.
Not all JMS Service Providers require a user name 
to be specified.

Password If required, the password for User Name.
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5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options. You can stop and restart the JMS Business Event 
Handler component; however, you are advised to use Stop All and Start 
All to ensure that the BPI components are stopped and started in the 
correct order.

The new settings are now applied to your BPI system.
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Component Configuration - Servlet Engine

Use the Servlet Engine options to configure the parameters that relate to 
how the process instance pages are displayed within the BPI Application and 
the security of the pages served by the Servlet Engine.

These options appear hierarchically in the Administration Console, under the 
Servlet Engine navigation option as follows:

• Process Instance Web Pages and Portlets on page 89

• Security on page 91

Process Instance Web Pages and Portlets

This option enables you to manage the parameters of the BPI process instance 
pages, instance violation pages and the BPI portlets. BPI portlets can be 
found under My BSM and on the Applications > Business Process 
Insight > Health > Business Health page.

The parameters relating to these settings appear on the right-hand pane of 
the Administration Console when you select the Servlet Engine > Process 
Instance Web Pages and Portlets in the console’s navigation tree. If the 
Process Instance Web Pages and Portlets options are not visible in the 
navigation tree, expand the entries using the Explorer-style navigation 
techniques.

You can also control the security settings for the Process Instance Web 
Pages and Portlets as described in section Security on page 91.
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Process Instance Web Pages and Portlet Settings

This option enables you to configure parameters related to the behavior of the 
Process Instance pages, Violation Pages and portlets within the Business 
Process Insight Application Health pages and My BSM. 

These parameters are listed in Table 31.

Table 31 Process Instance Web Page and Portlets Settings

Descriptive Parameter Name Description

Process Instance Web Pages refresh 
delay (seconds)

The time interval (in seconds) that the Process 
Instance pages use to set the refresh interval for the 
Web browser. 

Maximum number of retries on 
database deadlock

The maximum number of attempts by the Process 
Instance pages to retry a database transaction before 
aborting it. It is possible for deadlocks to occur when 
the Process Instance pages and other applications 
are accessing the BPI database simultaneously. This 
parameter ensures that, in the case of a deadlock, 
the Process Instance pages abort the transaction in 
order to break the deadlock and generates an error 
message. which is displayed on a Web page. If the 
Process Instance pages abort the transaction, use 
the Refresh button on your browser to reload the 
page.

Database deadlock retry delay 
(seconds)

The time (in seconds) between each attempt to retry 
a database transaction.

Show service state for a completed 
step?

A check box indicating whether or not to show the 
status of services for Steps that have already been 
completed in the Business Process. 

Include data properties when 
exporting process lists as CSV?

A checkbox indicating whether or not to include the 
properties of a Data instance when exporting Process 
instances, using the Export All option, within the 
Process Instance pages.
This is the option, on the Process Instance pages, to 
export the current process instance list to a file in a 
comma-separated value (CSV) format.
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Modifying the Process Instance Web Pages and Portlet Settings

To change these settings, complete the following steps on the Windows 
system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Servlet Engine > Process Instance Web Pages and 
Portlets option from the Navigator pane on the BPI Administration 
Console.

3. Enter the changes that you want to make to the settings as appropriate in 
the right-hand pane.

4. Click Apply to apply the changes to the BPI configuration.

5. If you have modified the Show service state for a completed step? 
parameter, you need to stop and restart the Servlet Engine as described in 
step 6. If you have not modified this parameter, continue at step 8.

6. Select the Status option to move to the panel where the BPI component 
status are shown.

7. Stop and restart the Servlet Engine component.

8. If you have modified the Page refresh delay (seconds) parameter, and 
the parameter was previously set to zero (0), you need to refresh the Web 
browser window where the Process Instance page is active.

9. The new settings are now applied to your BPI system.

Security

The Security option enables you to set the type of authorization used 
between BAC and the BPI Server. 

Each time a BPI Server component is started, the BPI Server polls 
BAC for the lightweight single-signon settings and sets the BPI 
Server parameters based on the values set for BAC. These settings 
overwrite any settings that you have entered, using the 
Administration Console; you are therefore advised not to modify 
the Authorization settings and to leave the BPI Server to set them, 
based on the BAC values, when you start components.
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The parameters relating to security appear on the right-hand pane of the 
Administration Console when you select Security in the Administration 
Console’s navigation tree.

The right-hand pane is divided into the following logical sections: 

• Authorization Settings on page 92

• HTTP Over SSL Settings on page 94

Authorization Settings

The Authorization settings hold the values obtained for the lightweight 
single-signon properties within BAC.

If you have installed the BPI Server in a domain that is different to the 
domain where the Gateway Server is installed, make sure that you add the 
BPI domain to the list of Protected Domains, under:

Admin > Platform > Users and Permissions > Authentication
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Table 32 lists the Authorization parameters.

Table 32 Authorization Settings

Descriptive Parameter Name Description

Authorization method Use this option to select which method, or product, 
that you want to use to authorize your BPI 
components. 
This parameter is set at installation and reset each 
time you restart a component. Do not modify the 
parameter as it will be overwritten.

Domain name of local host The domain name for the Business Availability 
Center Gateway server. This is a fully qualified 
domain name for the Gateway Server host, named in 
the Business Availability Center settings in section 
Component Configuration - HP Business Availability 
Center Settings on page 68.
This parameter is set at installation and can be 
modified if required.

Bypass security for Process Instance 
Web Pages and Portlets

This parameter is set at installation and reset each 
time you restart a component. Do not modify the 
parameter as it will be overwritten
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HTTP Over SSL Settings

HTTP over SSL (secure socket layer) is a secure version of HTTP. SSL enables 
the data from a client, such as a Web browser, to be encrypted prior to 
transmission to prevent unauthorized access to the data being transmitted.

Refer to Chapter 15, Servlet Engine Authentication for more information 
about BPI and HTTPS. 

Table 33 lists the properties that you can configure to encrypt the data that 
you send to the BPI Web-based clients.

Table 33 HTTP Over SSL Settings

Descriptive Parameter Name Description

Enable HTTP over SSL for BPI Web 
Pages?

Select the checkbox to enable HTTP over SSL from 
the Web Server to the Web Browser, or Web 
Browsers, for the BPI:
• Process instance pages, instance violation pages 

and the BPI portlets. 
• Process Repository Explorer
• Monitor Definer
• Process Intervention
• Notification
The setting applies to all Web Browsers where these 
pages are running for a specific installation of the 
Servlet Engine. 
Clear the checkbox if you do not want to use HTTP 
over SSL.

SSL Keystore This is the location of the signed certificate file 
required for the HTTPS connection.

SSL Keystore Password This is the password for the signed certificate that 
you supply. 

Enable Certificate-based Client 
Authentication

Select the checkbox to enable certificate-based client 
authentication (from the Web Browser to the Web 
Server). 
Clear the checkbox if you do not want to use this 
form of authentication.
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Modifying the Security Parameters

To change these settings, complete the following steps on the Windows 
system, where the BPI Server is installed:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Select the Security option from the Navigator pane on the BPI 
Administration Console.

3. Enter the changes that you want to make to the settings as appropriate in 
the right-hand pane.

4. Click Apply to apply the changes to the BPI configuration.

5. Select the Status option to move to the panel where the BPI component 
status are shown.

6. Stop and restart all the BPI Server components using the Stop All and 
Start All options. If you do not start all the components, some of the 
security settings can be compromised.

The new settings are now applied to your BPI system.
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Component Configuration - MS SQL Server Access

The MS SQL Server Access parameters are available only when you select MS 
SQL Server as the database from within the BPI installation procedure. If you 
select Oracle as your database, the MS SQL Server parameters are not 
available through the Administration Console.

The MS SQL Server Access option enables you to view the current 
configurations for the SQL Server access and modify the password for the 
database access.

The database is used by the following components:

• Business Impact Engine

• Monitor Engine

• Business Event Handler

• JMS Business Event Handler

• Notification Server

• Web pages hosted within the Servlet Engine, for example, the Process 
Intervention pages.

These parameters are listed in Table 34.

Table 34 MSSQL Access

Descriptive Parameter Name Description

MS SQL Server hostname This is a non-modifiable field and shows the fully 
qualified domain name of the system where the 
Microsoft SQL Server Database is installed.

MS SQL Server port number This is a non-modifiable field and shows the port 
number that the Microsoft SQL Server Database is 
expecting connections on.

MS SQL Server database This is a non-modifiable field and shows the name of 
the database configured for BPI.
96 Chapter 2



To change the password for the database, follow the instructions on section 
Changing the Password Details on page 97.

Changing the Password Details

This section describes how to change the password for the BPI database user 
that you created during the installation.

Complete the following steps to make the changes to the database password:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Stop all the BPI components using the Stop All button.

3. Select the MS SQL Server Access option on the BPI Administration 
Console and make the changes to the following fields:

— MSSQL login password

4. Click Apply to apply the changes to the BPI configuration.

5. Return to the Status option and restart all the BPI components, using the 
Start All button. 

You have now completed the tasks to change the database password details 
used by BPI components.

MS SQL Server login user This is a non-modifiable field and shows the name of 
the user who has permission to read and write the 
BPI database files.

MS SQL Server login password The password for the user with permission to read 
and write the BPI database files. This field can be 
used to re-synchronize the BPI version of the 
password with the database password after the 
database password is changed using the database 
management tools.

Table 34 MSSQL Access

Descriptive Parameter Name Description
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Component Configuration - Oracle Server Access

The Oracle Server Access parameters are available only when you select 
Oracle as the database from within the BPI installation procedure. If you 
select MS SQL Server as your database, the Oracle Server parameters are not 
available through the Administration Console.

The Oracle Access option enables you to manage the properties of the 
connection to the Oracle database. 

The database is used by the following components:

• Business Impact Engine

• Monitor Engine

• Business Event Handler

• JMS Business Event Handler

• Notification Server

• Web pages hosted within the Servlet Engine, for example, the Process 
Intervention pages.

These parameters are listed in Table 35.

Table 35 Oracle Server Access

Descriptive Parameter Name Description

Oracle Server hostname This is a non-modifiable field and shows the fully 
qualified domain name of the system where the 
Oracle Database is installed.

Oracle Server port number This is a non-modifiable field and shows the port 
number that the Oracle Database is expecting 
connections on.

Oracle Server SID This is a non-modifiable field and shows the name of 
the database sid configured for BPI.
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If you are changing the password for the database user with permission to 
read and write the BPI database tables, follow the instructions on section 
Changing the Password Details on page 99.

Changing the Password Details

To change the password for the BPI database user, complete the following 
steps:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Stop all the BPI components using the Stop All button on the Status 
option.

3. Select the Oracle Access tab on the BPI Administration Console and 
make the changes to the following fields:

— Oracle Server login password

4. Click Apply to apply the changes to the BPI configuration.

5. Return to the Status option and restart all the BPI components, using the 
Start All button. 

You have now completed the tasks to change the database password details 
used by BPI components.

Oracle Server login user This is a non-modifiable field and shows the name of 
the user who has permission to read and write the 
BPI database files.

Oracle Server login password The password for the user with permission to read 
and write the BPI database files. This field can be 
used to resynchronize the BPI version of the 
password with the database password after the 
database password is changed using the database 
management tools.

Table 35 Oracle Server Access

Descriptive Parameter Name Description
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Component Configuration - Port Numbers

This section describes the port numbers used by the BPI components. You 
might need to modify these if there is a port number clash, or if you have 
specific requirements with personal firewalls or other security processes.

The port number parameters are listed in Table 36

Table 36 Port Numbers

Descriptive Parameter Name Description

RMI Registry The port number for SUN’s implementation of the 
Java RMI Activation System Daemon (RMID), which 
is used by BPI as a reliable RMI registry. The RMI 
registry holds the directory of port numbers used by 
the BPI components to receive RMI requests.
If this port number is in use by another application, 
the BPI Server components are unable to start.

Administration Console Server The port number that the server component of the 
Administration Console uses to listen for incoming 
administration requests.

Business Impact Engine SOAP 
Receiver

The port number used by the Business Impact 
Engine to receive incoming SOAP requests.

Business Impact Engine XML 
Receiver

The port number used by the Business Impact 
Engine to receive XML requests.

Business Impact Engine RMI 
Receiver

The port number used by the Business Impact 
Engine to receive incoming RMI requests.

Monitor Engine RMI Services The port number used by the Monitor Engine to 
receive connections to RMI services.

Business Event Handler Source The port number used by the Business Event 
Handler Engine Adapter to receive incoming Events 
into the Business Event Handler. 

Business Event Handler Control The port number used to stop and start the Business 
Event Handler Engine Adapter programmatically; 
see the Business Process Insight Integration 
Training Guide - Business Events, for more details.
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If you want to modify a port number, refer to section Modifying BPI Port 
Numbers on page 102.

JMS Business Event Handler 
Control

The port number used to stop and start the JMS 
Business Event Handler Engine Adapter 
programmatically; see the Business Process Insight 
Integration Training Guide - Business Events, for 
more details.

Process Repository The port number used by the Process Repository to 
listen for incoming RMI requests.

Servlet Engine HTTP The port number that the Tomcat Web Server uses to 
receive HTTP requests.

Servlet Engine HTTPS The port number that the Tomcat Web Server uses to 
receive HTTP over SSL encrypted requests.

Servlet Engine Shutdown The port number used by the Tomcat Servlet Engine 
to shutdown.

Servlet Engine AJP 1.3 The AJP 13 protocol is a packet-based protocol that 
allows a Web server to communicate with the Tomcat 
JSP/Servlet Container over a TCP connection.

Servlet Engine Admin The port number used by the Tomcat Servlet Engine 
administration tools.

Web Services Provider Not used in BPI.

Data Samples Provider RMI Services The port number defined for the Data Samples 
Provider and used by the Business Impact Engine 
and Monitor Engine to send data samples to 
Gateway Server (or Load Balancer).

Table 36 Port Numbers

Descriptive Parameter Name Description
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Modifying BPI Port Numbers

The BPI components use a number of different port numbers for connections. 
There should not be any need to modify these port numbers unless you know 
that other applications are already using them, or if you are using personal 
firewall software that filters incoming connections based on port number. You 
must stop all the BPI components before you can modify the BPI port 
numbers.

To change the port number for the BPI Server components, complete the 
following steps:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Using the Status option, stop the BPI components using the Stop All 
button.

You cannot modify any of the port numbers until you have stopped the 
BPI components.

3. Select the Port Numbers option in the Navigator pane.

4. Make the changes to the port numbers that you want to modify.

5. Click Apply to apply your modifications.

6. Restart, using Start All, the BPI components that you previously 
stopped.

The port number changes have now been applied.
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Component Configuration - Logging

This section describes the parameters that you can set for the log BPI 
component log levels and the component startup settings. Section Logging 
Parameters on page 103 describes the logging parameters and section 
Component Startup Parameters on page 106 describes the component startup 
parameters.

Logging Parameters

BPI includes a number of third-party products, which use their own logging 
mechanisms, for example:

• the Business Event Handler component, which is based on the 
openadaptor framework, uses Log4j as its logging mechanism.

• Hibernate, which is used by the Business Impact Engine and other BPI 
Server components, uses Jakarta Apache Commons logging.

Log4j and Java J2SE logging are two alternative implementations and 
Apache Commons is an layer above a specific logging implementation. In the 
case of BPI, Apache Logging is a layer over the Java J2SE logging 
implementation.

This Logging option enables you to set logging levels for the BPI components, 
and for the Business Event Handler; the Business Event Handler logging is 
based on openadaptor. There is no mechanism for setting the logging levels for 
Hibernate using the Administration Console, as the logging for the 
components using Hibernate is usually sufficient.
Component Administration 103



The logging parameters, which can be set through the Logging option, are 
listed in Table 37. For your BPI implementation, you see only those logging 
parameters that relate to the components that you have installed.

Table 37 Logging

Descriptive Parameter Name Description

Change the log viewer application

Path for the log viewer application The full path name for the application that is being 
used to display the log files.
If the application is defined as being on your PATH, 
you can enter the application name without its full 
path name.

Logging Levels - HP Operations Manager Logging

The Administration Console log level The log level set for the Administration Console.

The Administration Console Server 
log level

The log level set for the Administration Console 
Server.

The Monitor Engine log level The log level set for the Monitor Engine

The Business Impact Engine (BIE) 
log level

The log level set for the Business Impact Engine.

The Process Repository log level The log level set for the Process Repository.

The Notification Server log level The log level set for the Notification Server

The Servlet Engine log level The log level set for the Tomcat Servlet Engine.

The Web Services Provider log level The log level for the Web Services interface.

The CI Status Poller log level The log level for all the CI Poller, unless overridden 
by specific instances of the CI Poller. You override 
the log level on the configuration page for the 
individual CI Poller.
Each entry in the log file is identified by the name 
that you give the CI Poller in the Administration 
Console.
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The following are the logging levels that you can set for the HP Operations 
Manager Logging in ascending level of log detail provided:

1. Info, which reports runtime informational messages and is the default 
level of logging. 

2. Fine, which provides more detail and is used when debugging or 
diagnosing problems.

3. Finer, which provides the greatest detail and is used for tracing and 
debugging low level problems.

The Data Samples Provider log level The log level for all the Data Sample Destinations, 
unless overridden by specific instances of the 
Destination. You override the log level on the 
configuration page for the individual Data Sample 
Destination.
Each entry is identified by the name that you give 
the Destination in the Administration Console.

Log BIE events (to 
bie_event0_0.csv)?

Check the checkbox to log all business events to the 
file bie_event0_0.csv in the 
bpi-install-dir\data\log 
The file is in a comma-separated format in order that 
you can order and filter the events within a tool such 
as Microsoft Excel.
When the maximum number of bytes that should be 
written to a file is reached, or the BPI Server is 
restarted, a new log file is opened and named 
bie_event0_0.csv. The previous log file is renamed, 
for example, bie_event0_1.csv

Logging Levels - Log4j Logging

The Business Event Handler log 
level

The logging level set for the Business Event Handler.

The JMS Business Event Handler 
log level

The logging level set for the JMS Business Event 
Handler.

Table 37 Logging

Descriptive Parameter Name Description
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The following are the logging levels that you can set for Log4j Logging in 
ascending level of detail:

1. Info, which reports at the informational level and is the default level of 
logging.

2. Trace, which should be used for debugging purposes.

Modifying the Log File Parameter Values

To modify the log levels for the BPI server components complete the following 
steps:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Stop the server components using the Stop All button.

3. Select the Logging option in the Navigator pane.

4. Make the changes to the log levels that you want to modify.

5. Click Apply to apply your modifications.

6. Restart the BPI components that you previously stopped.

The logging level changes have now been applied.

Component Startup Parameters

Use this parameter to configure the time allocated to start individual 
components.

BPI components have a configured time allocated for starting. If they fail to 
start within the period specified by the Startup timeout (seconds): 
parameter, they are assumed to have failed.

When setting logging levels to report more detail, make sure that these are 
temporary settings as the detail logged can consume a significant amount of 
disk space and impact the performance of the system where BPI is installed.

The log levels set when BPI is installed are suitable for most error reporting. 
If you need to increase the granularity of the logging information provided, 
make sure that you set the log levels for a temporary period only. When set 
the Fine and Finer logging levels, the log files become large very quickly and 
can have a detrimental effect on your system’s performance.
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On some machines, it can take some time for components to start; for 
example, because the machine has a slow processor, or has many applications 
running. If this is the case in your implementation, you can increase the value 
of the startup time to allow more time for the component startup.

Table 38 describes the startup setting. 

Modifying the Component Startup Parameter Values

To modify the component startup parameter for the BPI server components, 
complete the following steps:

1. Start the Administration Console as described in section Administration 
Console Description on page 22.

2. Stop the server components using the Stop All button.

3. Select the Logging option in the Navigator pane.

4. Make the changes to the startup time.

5. Click Apply to apply your modifications.

6. Restart the BPI components that you previously stopped.

The startup times are now modified.

Table 38 Component Startup Settings

Descriptive Parameter Name Description

Startup timeout (seconds): The time, in seconds, that is allocated to start each 
BPI component. All components are allocated the 
same value for their startup time.
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License Management

You use the License Management software (Autopass) to manage the HP 
Process Insight software license keys. When you purchase an HP Software 
product, for example BPI, you receive an Entitlement Certificate. This 
Entitlement Certificate contains information that you need to retrieve and 
install BPI license keys.

The License Management utility is not an BPI component. BPI provides 
access to the utility to make it easier for you to request and install the BPI 
license keys. You can also request your license keys using email or facsimile 
(fax). Requesting license keys is described as part of the License Key 
installation in the License Management online help.

The License Management utility provides a number of features, including:

• License key installation

• License key reporting

• License key backup

• License key removal

• License key recovery

Details of these features and how to use them are provided in the License 
Management online help.

To install your BPI license keys complete the following steps:

1. Make sure that you have your Entitlement Certificates, which contain the 
order numbers that you need to retrieve your license keys.

2. Open the BPI Administration Console.

3. Select License Manager from the Admin menu on the Administration 
Console to start the Autopass License Management software.

The License Management utility opens at the screen to Retrieve/
Install License Key.
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4. Follow the on-screen instructions and the instructions in the License 
Management online help to install the BPI license keys.

5. Select the Report License Key option from the License Management 
Navigation window to check that the BPI license keys are successfully 
installed.

When the keys are successfully installed, you should see the BPI product 
number with an Expiration Date of Forever.

If you have problems retrieving or installing the license keys, contact your 
local support representative. The Administration Console provides access to 
the Support Web site from the Support Online option on the Help menu.
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3 Enhancing BAC with Process Instance 
Monitors
This chapter describes how to add process instance monitors to BAC by 
configuring your BPI Server and how you can use BPI to track instances of 
Business Processes that you create and develop using the BPI Modeler.

The chapter covers the following topics:

• Overview of BPI as an Application Within Business Availability Center on 
page 112

• Configuring the BPI Server to Connect to a Gateway Server or Load 
Balancer on page 130

• Using SSL for Connections with Business Availability Center on page 138

• Gateway Server Configuration on page 139

• Creating a My BSM Application for BPI on page 142

• SLM and Reporting on page 144

• Description of Data Samples Sent to Business Availability Center on 
page 145
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Overview of BPI as an Application Within Business 
Availability Center

If you have already installed HP Business Availability Center (BAC), some 
BPI components are also installed, namely the BPI Modeler and the Process 
Repository. A Process Repository Database is also created as part of the BAC 
installation. In this configuration, you can create Business Processes and link 
the Steps in the Business Process to CIs that represent IT operational 
resources. This then enables you to monitor the health of the Business Process 
and the Steps in the process relative to the IT operational resources on which 
they depend.

When you install the BPI Server, the BPI Application is added as a new 
component to the BAC Gateway Server that you have configured within the 
Administration Console. As a result, a new Process Repository is installed on 
the BPI Server system and the existing Process Repository on the BAC 
Gateway Server is disabled. Communication to the Process Repository 
Database is now from the BPI Server system and the data in the Repository 
Database is synchronized with the UCMDB. 

The addition of the BPI application enables you to monitor the health of your 
Business Process and its Steps as before; in addition, it enables you to:

• map business events to Steps in your Business Process to enable you to 
monitor the business impact when there are problems with the Business 
Process.

• monitor instances of your Business Process in near-real time.

• determine how effective your Business Process is by defining Monitor CIs 
that measure thresholds that you define.

• view and report on the status of the health of your Business Processes.

• view detailed information about each process instance in the Business 
Process, the Business Process Steps and the thresholds defined for the 
instances.

• model your business’s IT processes and your supporting business 
applications services. It also provides the tools to help you prioritize 
problems, based on business impact and service level compliance.

• report on the status of operational services and how they impact your 
Business Processes. 
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• set service level objectives (SLOs) for the BPI configuration items (CIs), 
which are managed within Business Availability Center.

• configure alerts, within the Business Availability Center SLM component, 
based on the SLOs that have been set on the BPI CIs.

• enable reports to be generated, based on the BPI CIs.

• use MY BSM portlets for views of the BPI Process and Monitor data.

The following sections describe in more detail how you can use the features of 
BPI within BAC for designing, managing and tracking your Business 
Processes. The sections have been divided into the features available for 
design and the features available after you have deployed your business:

• Design-Time Integration on page 114

• Run-Time Integration on page 118
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Design-Time Integration

You design and subsequently deploy your Business Processes and process 
Steps using the BPI Modeler. The features of the Modeler that are available to 
you when designing processes depends on whether you have:

1. the BPI Server installed

2. enabled or disabled tracking individual process instances when defining 
your process.

This section describes:

• Modeling with Tracking Individual Process Instances Disabled on 
page 115

• Modeling with Tracking Individual Process Instances Enabled on 
page 117

If you do not have the BPI Server installed, then you do not have 
the option to enable individual process instance tracking within the 
Modeler; the option is disabled.
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Modeling with Tracking Individual Process Instances Disabled

This section describes the concepts for modeling Business Processes, including 
mapping IT operational resources to process Steps when you do not have the 
BPI Server installed or you have not enabled individual process instance 
tracking.

Figure 1 Design-Time - Process Instance Tracking Disabled
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The following steps describe the communication between BAC components as 
shown in Figure 1:

• You create your Business Processes using the Modeler. When you deploy 
the Business Processes, the Modeler completes its consistency checking on 
the Business Process. 

• The Processing Server forwards the RMI command to the Process 
Repository, which manages how the process models are stored in the 
Process Repository Schema, including synchronizing the models with the 
UCMDB.

• As part of creating your Business Processes, you can map IT operational 
resources, which are defined as CIs within the UCMDB by applications 
such as SiteScope, to the Business Process Steps. BAC can then evaluate 
the status of the IT operational resource CIs for later presentation within 
the Flow Map. 
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Modeling with Tracking Individual Process Instances Enabled

This section describes the steps for modeling Business Processes when you 
have the BPI Server installed and you have enabled individual process 
instance tracking. These steps extend the modeling steps described in section 
Modeling with Tracking Individual Process Instances Disabled on page 115.

Figure 2 Design-Time - Process Instance Tracking Enabled
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The following steps describes the communication between BAC components 
when you have chosen to model processes in order to track and monitor 
individual process instances, as shown in Figure 2. You can model Business 
Processes and map IT operational resource CIs to the process Steps as 
described in Modeling with Tracking Individual Process Instances Disabled on 
page 115. In addition, you can model processes to track individual process 
instances as follows:

• Create your Business Process using the BPI Modeler and select the option 
to Track individual process instances. 

• Create the Data Definitions, progression rules, Event Definitions and 
Event Subscriptions for your Business Processes.

• Deploy the Business Process, at which point the Modeler completes its 
consistency checking on the Business Process. The Modeler sends the 
definition to the Gateway Server (or load balancer) using RMI over HTTP 
and the Gateway Server sends the Model definitions to the Process 
Repository on the BPI Server using RMI.

• The Process Repository manages how the process models and their 
components are stored and synchronized in the Process Repository 
Schema; this includes creating the Java class files and the Process 
Instance tables in the BPI Instance database.

• When the Business Process is successfully deployed, you can define 
Monitors and instance thresholds for the Business Process. These 
definitions are stored in the BPI Instance database and are synchronized 
with the UCMDB.

Run-Time Integration

When you have defined and deployed your Business Processes and Business 
Process monitors, you can then track and monitor the health of your Business 
Process relative to the status of the IT operational resources on which the 
process Steps depend and on the values of the data being captured by the 
Business Event Handler. This section covers:

• Monitoring - Tracking Individual Process Instances is Disabled on 
page 119

• Monitoring - Tracking Individual Process Instances is Enabled on 
page 121
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Monitoring - Tracking Individual Process Instances is Disabled

Figure 3. shows the components involved for displaying the monitoring data 
when you do not have the BPI Server installed or you have not enabled 
tracking of individual process instances.

Figure 3 Run-Time - Process Instance Tracking Disabled
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• You need to set KPI objectives on your IT operational resource CIs in order 
to be able to monitor status changes.

• BAC calculates the status of the dependencies for the mapped IT 
operational resource CIs and makes the results available to the 
Dashboard. 

The Dashboard combines these results with the process definition model 
information (obtained from the Process Repository) and the results are 
displayed on the Flow Map within the Dashboard Application.
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Monitoring - Tracking Individual Process Instances is Enabled

Figure 4. shows the components involved for displaying the monitoring data 
when you have the BPI Server installed and you have enabled tracking of 
individual process instances.

Figure 4 Run-Time - Process Instance Tracking Enabled
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The following is a list of the key steps involved for monitoring your Business 
Processes. These steps are in addition to those described in section Monitoring 
- Tracking Individual Process Instances is Disabled on page 119:

• In addition to the IT operational resource CIs that are monitored and 
reported for your Business Processes, BPI receives business events 
through the Business Event Handler.

• The business data relating to individual process instances is stored in the 
BPI Instance database.

• At the same time as each new Monitor definition is created in the BPI 
database tables, a BPI Monitor CI is created in the UCMDB.

• Changes to process instance data that impact the Business Process 
monitors that you have defined are sent to the Monitor Engine, which in 
turn updates the relevant tables in the BPI Instance database.

• The BPI Server periodically sends a set of data samples to the Business 
Availability Center Gateway Server.This period can be configured from 
the BPI Administration Console; see section Component Configuration - 
HP Business Availability Center Settings on page 68. 

The data samples are held on the BPI Server for a configurable length of 
time, until the Business Availability Center acknowledges receipt. If a 
data sample cannot be delivered in the required time, it is deleted. The 
values of these data samples are used to evaluate KPIs within the 
Business Availability Center environment.

These data samples can also be used for reporting and SLM.

• The BPI Server polls for the status of CIs to obtain details of the status of 
the IT operational resources that the process Steps are linked to. This 
period can be configured from the BPI Administration Console; see section 
Component Configuration - HP Business Availability Center Settings on 
page 68. 

• The business event data and monitor data for the process instances is 
made available to other BAC components and displayed through the BPI 
Application, which is described in more detail in Chapter 9, BPI 
Application Concepts.

Ongoing changes made to the Processes and Monitors in the BPI database 
tables are automatically synchronized with the UCMDB.
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Data Samples

A data sample, in Business Availability Center terms, is application-specific 
data sent from an application, in this case, BPI. In the case of BPI, these data 
samples can be used by Business Availability Center to show key performance 
indicators (KPIs), relating to the imported Process and Monitor definitions. 
The data samples are taken from the values of specific Monitor values in the 
BPI Instance database. Data samples are sent from the BPI Server to the 
Gateway server that you configure within the BPI Administration Console.

The data samples provide the information required to provide meaningful 
information about the health of your business.

If you have defined Groups for your Business Process Monitors, the Groups 
are not exported to the Gateway Server. The data samples that the BPI 
Server sends are for the entire Monitor Definition.
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Configuration Items Stored in the UCMDB

Table 39 describes the BPI data that is stored in the UCMDB as a result of the 
synchronization. This sharing of information between BPI and Business 
Availability Center enables Business Availability Center to access the BPI 
data from the UCMDB. The BPI data is stored in the UCMDB as 
configuration item (CI) of several types. For more information about CI types, 
refer to the CI Type Manager as follows:

Admin > Universal CMDB > Modeling > CI Type Manager

.

Table 39 Configuration Items Stored in the UCMDB for BPI Process 
Components

CI Type Description

business_process Stores the Process Name and Process 
Description as entered using the BPI 
Modeler.
A business_process CI is created for each 
Business Process in BPI.
business_process CIs are logical CIs.

bpi_step Stores the Step Name and Description as 
entered using the BPI Modeler.
A bpi_step CI is created for each Step in all 
Business Processes.
bpi_step CIs are logical CIs.
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bpi_monitor Stores the Monitor Name, Description, Type, 
Units, Collection Interval, Threshold 
Operator, Server Name and Instance 
Threshold limits (where specified) as defined 
with BPI.
There are sub-types of the bpi_monitor type 
as follows:
• bpi_duration_monitor
• bpi_value_monitor
• bpi_custom_monitor
Monitor data samples are sent for each 
bpi_monitor CI.
bpi_monitor CIs are Monitor CIs.

Table 39 Configuration Items Stored in the UCMDB for BPI Process 
Components

CI Type Description
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As with any synchronization, or sharing of data, there must be a master copy 
of the data to synchronize from. In this case, the BPI Server holds the master 
copy of the data. This means that any changes to the data within Business 
Availability Center UI Framework are overwritten by BPI when the data 
models are synchronized. If you delete a CI in the UCMDB, it is created again 
when the data models are synchronized.

bpi_process_monitor A bpi_process_monitor CI is created in the 
UCMDB for every business_process CI 
stored. This CI stores the process monitor 
data collected implicitly by BPI for each 
process; for example:
• current numbers of active instances
• numbers of blocked instances
• number of completed instances
Data samples are sent to Business 
Availability Center for each 
bpi_process_monitor CI.
bpi_process_monitor CIs are child CIs of 
business_process.

bpi_step_monitor A bpi_step_monitor is created in the 
UCMDB for every bpi_step CI stored. This 
CI stores the process monitor data collected 
implicitly by BPI for each process Step; for 
example:
• current numbers of active instances
• number of completed instances
Data samples are sent to Business 
Availability Center for each 
bpi_step_monitor.
bpi_step_monitor CIs are child CIs of 
bpi_steps.

Table 39 Configuration Items Stored in the UCMDB for BPI Process 
Components

CI Type Description
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Data synchronization occurs as a result of any one of the following:

• a Business Process is deployed, re-deployed, or un-deployed.

• a Business Process monitor definition is created, modified or deleted.

• related configuration changes are made within the BPI Administration 
Console.

• a synchronization is forced using the Synchronize with the CMDB option 
in Admin > Process Intervention.

As part of the synchronization process, BPI creates mapping tables, which are 
used to provide the references between the BPI data and the corresponding CI 
within the UCMDB. The BPI unique identifiers for the data (GUIDs) are 
mapped to the UCMDB GUIDs for the BPI-related CIs. This enables BPI to 
send data samples to Business Availability Center as well as manage the 
synchronization process.

Viewing BPI CIs

To see the CIs defined within Business Availability Center:

• Select:

Applications > Dashboard

• Select Business Processes from the View option drop-down list.

This is the View within Business Availability Center that groups together 
all BPI processes.

• Select the Orders process listed under Business Processes.

• Select the Top View tab.

Figure 5 shows the Business Process named Orders and its associated Steps.
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Figure 5 Dashboard - Top View

The Orders process, and its Steps, are listed in the View Explorer and the 
root view for the Orders CI and the dependent Step CIs is shown in the 
graphical view on the right-hand pane.

In this example, you can see that there are also other processes deployed and 
you also see these other processes within the Business Processes.

Also note that there are two CIs for each component of the Orders process.

Multiple CIs for Each Business Process and Business Process Step

When you view a Business Process within Dashboard, you might notice that 
there are two CIs defined for each Business Process component; for example, 
in the case of the Orders process, there is an Orders CI and an 
Orders_monitor CI. Similarly, for each Step, there is a Step CI and a 
corresponding Step monitor CI. For each Business Process or Business 
Process Step, BPI defines a CI within the UCMDB. This enables you to 
configure any dependent CI hierarchy and enables BPI to send data samples 
128 Chapter 3



to the UCMDB for a CI. However, within the UCMDB, data samples can only 
be assigned to a CI of type bpi_monitor. As a result, for each Business 
Process, BPI defines both a business_process CI and a bpi_monitor CI.

The CI with a name that ends in _monitor contains the data sample values 
as sent from BPI; these values are then inherited by the root CI.
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Configuring the BPI Server to Connect to a Gateway 
Server or Load Balancer

This section describes the steps that you need to complete to configure both 
the BPI Server system and the Gateway Server system (or Load Balancer) 
that the BPI Server will communicate with.

You configure the BPI Server to become an application within Business 
Availability Center through the HP Business Availability Center 
settings in the BPI Administration Console. These properties are divided 
into three sections and are described in sections:

• Business Availability Center General Settings on page 131.

• Data Sample Settings on page 133

• CI Poller Settings on page 135

If you have previously installed Business Availability Center and BPI and 
subsequently removed the BAC installation, including all the BAC data, you 
must also remove the BPI data before attempting to reconfigure BPI to 
connect to BAC. 

If you do not, some of the BPI data has no parent CI data within the BAC 
database and there are inconsistencies in your Business Process models.
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Business Availability Center General Settings

You configure general settings that apply to both the Data Sample settings 
and the CI Poller settings using the Administration Console as follows:

1. Start the Administration Console on the machine where the BPI Server is 
installed:

Start > Programs > HP > HP Business Process Insight > 
Administration

2. Click the HP Business Availability Center settings option in the 
left-hand navigation pane.

A configuration page is opened in the right-hand pane, which contains all 
the configuration options for the Business Availability Center integration. 
You need to set the parameters for the Business Availability Center 
General settings.

3. Enter values for the properties of the General settings. The properties 
are fully described in the Business Process Insight Administration Guide:

— Hostname of Gateway server

The fully qualified DNS name of the machine where the Business 
Availability Center Gateway Server is installed. This is the server 
that you want BPI to use as a source for Service Status information, as 
the destination for data samples and for UCMDB synchronization. If 
you have configured a Load Balancer, you can specify the name of the 
Load Balancer in place of the Gateway Server.

If you plan to the BPI Server in a domain that is different to the 
domain where the Gateway Server (or Load Balancer) is installed, 
make sure that you add the BPI domain to the list of Protected 
Domains, under:

Admin > Platform > Users and Permissions > Authentication
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— Use SSL?

Enables or disables use of SSL when connecting to the Gateway 
Server; see also section Using SSL for Connections with Business 
Availability Center on page 138.

— HTTP port of Gateway server

The port number used by the Web Server on the Business Availability 
Center Gateway Server. Usually this is port 80, or port 443 if you have 
configured SSL.

— User name

The user name that you have defined to be used by BPI server 
components when connecting to Business Availability Center. This is 
the account used by BPI to obtain the Service Status information from 
Business Availability Center and for synchronization. 

This can be an existing user, or a new user, as long as it has 
permissions to access the View name as specified in the Business 
Availability Center settings in the BPI Administration Console. 
For a new installation the view name is Business Processes. 

— Password

The password set for User name.

— Basic authentication enabled?

Enables or disables the use of basic authentication.

Select this option only when Business Availability Center is 
configured to use basic authentication for Web Server and Web 
browser communications.

Basic authentication is the BAC mechanism for enabling a Web 
browser (or Web client) to authenticate with the Web Server using a 
user name and a password; refer to the Business Availability Center 
help documentation for details of basic authentication.

— Basic authentication user

The user name that is configured for BAC basic authentication.
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— Basic authentication password

The password set for Basic authentication user.

— Maximum retries for synchronization deadlock

For a new configuration accept the value offered.

You do not need to restart any BPI components for these settings to take 
effect. BPI automatically synchronizes its data with Business Availability 
Center when changes are applied to the General settings.

Data Sample Settings

You need to configure the Data Sample settings in order for BPI to send data 
samples to Business Availability Center. Sending data samples to Business 
Availability Center enables you to use the BPI application to report and view 
the health of the Business Processes that you create.

Business Availability Center displays the sample information based on the 
time period specified in the Data sample send interval and until the next 
sample is sent by the BPI Server. In order to make sure that there are data 
samples to display, there is an additional decay period that you can set within 
Business Availability Center. Unless modified, the value of the decay period is 
set at 90 seconds. 

You can also set a delay before sending data samples to the Gateway Server 
using the Delay before sending samples parameter. You configure a delay 
if you want to allow time for the Business Process Engine and the Monitor 
Engine to collate data before sending it to the Gateway Server. 

Setting a delay enables you to take account of the fact that there might be a 
time difference between when a business event occurs and when BPI receives 
notification of the event; this is because some business applications do not 
make data available immediately. This then enables BPI to collect complete 
and accurate statistics for each send interval before sending the data to the 
Gateway Server; however, it also means that the data sample values shown in 
BAC lag behind the Last Update time by the value of the value of this delay; 
for example, if the current time is 10:30 and you set a delay of 900 seconds (15 
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minutes), the values you see for the BPI data samples displayed within the 
BPI Application and elsewhere in BAC relate to the collection period ending at 
10:15.

The Data Sample settings are configured using the Administration Console as 
follows:

1. Start the Administration Console on the machine where the BPI Server is 
installed:

Start > Programs > HP > HP Business Process Insight > 
Administration

2. Click the HP Business Availability Center settings option in the 
left-hand navigation pane.

A configuration page is opened in the right-hand pane, which contains all 
the configuration options for the Business Availability Center integration. 

3. Enter values for the properties of the Data Samples settings. The 
properties are fully described in the Business Process Insight 
Administration Guide:

— Data samples send interval (minutes)

For a new configuration accept the value offered (five minutes). This 
interval also becomes the collection period for all BPI monitors.

— Connection timeout (seconds)

For a new configuration accept the value offered.

BAC displays the last sample information for the time period specified in 
the collection_interval attribute. The sample is kept for an additional 90 
seconds, which is the default decay setting to make sure that the data 
samples continue to display the same statuses. If there is no decay setting 
specified, the BAC views display No data as a status in cases where a 
new sample has not yet been received by BAC due to overload problems or 
late arrival of the new sample. This default decay setting is customizable. 

If you configure a data sample delay within BPI that is more than 90 
seconds, you should also increase the decay setting for BPI samples in 
BAC (see the BAC Dashboard Help). If you do not, a No Data status is 
shown for the BPI Application instance data.
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— Guaranteed retention period (minutes)

For a new configuration accept the value offered.

— Delay before sending samples (seconds)

Delay following the Data samples send interval to allow time for 
the Business Impact Engine and Monitor Engine to collate data to be 
sent to the Gateway Server.

4. Click the Apply button to apply your changes.

You do not need to restart any BPI components for these settings to take 
effect. BPI automatically synchronizes its data with the Gateway Server 
when changes are applied to the Data Sample settings.

The first time you configure the Data Samples settings, BPI synchronizes 
all deployed Business Process (and Step) definitions with the UCMDB. For 
each Business Process and Step, CIs are created in the UCMDB; for example, 
if you have a process called MyProcess containing a step called Step1, then 
you will have a corresponding CI in the UCMDB for MyProcess, and this will 
contain a dependent CI called Step1.

The data samples sent by the BPI Server are then stored against the 
corresponding CIs within the UCMDB. 

CI Poller Settings

In order for the BPI Server to receive status information that relates to 
operational services that have been associated with BPI Step CIs within 
Business Availability Center, you need to configure CI Poller settings.

You configure the CI Poller settings using the Administration Console as 
follows:

1. Start the Administration Console on the machine where the BPI Server is 
installed:

Start > Programs > HP > HP Business Process Insight > 
Administration

2. Click the HP Business Availability Center settings option in the 
left-hand navigation pane.

A configuration page is opened in the right-hand pane, which contains all 
the configuration options for the Business Availability Center integration. 
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3. Enter values for the properties of the CI Poller settings. The properties are 
fully described in the Business Process Insight Administration Guide:

— View name

Unless you have modified this on the Business Availability Center 
system, accept the value offered (Business Process)

— Status event poll interval (seconds)

For a new configuration accept the value offered (five minutes).

— Connection timeout (seconds)

For a new configuration accept the value offered.

4. Click the Apply button to apply your changes.

You do not need to restart any BPI components for these settings to take 
effect. BPI automatically synchronizes its data with the Gateway Server 
when changes are applied to the CI Poller.

You should now continue at section Gateway Server Configuration on 
page 139 to configure the Gateway Server to recognize your BPI Server 
system.
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Business Process Insight Application

When you have successfully configured the BPI settings, and deployed your 
Business Process you are able to view and monitor the health of your 
processes using the Scorecard, Health and Reports options within the BPI 
Application. Refer to Chapter 9, BPI Application Concepts for details of the 
BPI Application.
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Using SSL for Connections with Business Availability 
Center

You can specify an SSL (secure socket layer) connection between BPI and 
Business Availability Center.

In order to configure Business Availability Center to support HTTPS, you 
need to obtain an SSL certificate. SSL uses public key cryptography, which is 
based on key pairs. These key pairs contain one public key and one private 
key. These keys are used by Business Availability Center to enable HTTPS. 
When installed the certificate encrypts the data that is sent between BPI Web 
interfaces (clients) and the Business Availability Center Web Server.

In order that BPI can use SSL when integrating with Business Availability 
Center, you need to import the required SSL certificate from Business 
Availability Center. You import the certificate into the keystore for your Java 
distribution on the BPI Server machine. 

The instructions for importing the certificate are provided in the Business 
Availability Center documentation in a document called: Hardening Guide 
within the System Deployment category of documents. 
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Gateway Server Configuration

In addition to configuring details of the Gateway Server system from the BPI 
Server system, you also need to configure the Gateway Server system with 
details of the BPI Server. Alternatively, this could be a Load Balancer if there 
is one configured for the BAC system.

To configure the Gateway Server, complete the following steps:

1. Logon to Business Availability Center on the system where the Gateway 
Server is running.

2. Select Admin > Platform.

3. Select Setup and Maintenance.

4. Select Infrastructure Settings.

The Infrastructure Settings Manager page is displayed.

5. Select Business Process Insight from the Applications option under 
Select Context.

The Business Process Insight settings page is displayed.

The page is divided into sections and some of the information is already 
completed with values that are set as part of the installation. You can 
leave these settings until you have been using BPI and have more 
information about what the most suitable values are. For example, you 
can modify the KPIs that are listed on the BPI Application Scorecard page 
using the Selected Scorecard KPIs setting.

If you are using a Virtual Machine for your BPI Server, make sure 
that any host names are fully qualified and include the domain 
names, when entered in the infrastructure settings. If you do not, 
you can experience anomalies within the BPI Application Scorecard 
display and the KPI filter appears to apply only to the first entry in 
the scorecard list.
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6. If not already completed, set the following values for Instance Database 
Settings:

a. Host Name

This is the fully-qualified domain name of the system where the 
database that you configured for the BPI Server is installed. This 
must match the name that you entered for the database host when 
you installed the BPI Server and the setting determines which Process 
Repository is used to manage your Process Definitions.

b. Port

This is the Port number configured for the database on the hostname 
above and should not be modified unless you have reconfigured your 
database to use an alternative port number.

c. Database Type

The database configured for the BPI Server and can be either a SQL 
Server database or an Oracle database.

d. Database Name or SID (according to the Database Type)

For SQL Server this is the database name that you entered when you 
configured the database details during the BPI Server installation.

For Oracle this is the SID that you entered when you configured the 
database details during the BPI Server installation.

e. User Name

User name for the database user configured during the BPI Server 
installation.

f. Password

Password for the database user configured during the BPI Server 
installation.
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7. If not already completed, set the following values for Instance Server 
Settings:

a. BPI Host Name

This is the fully-qualified domain name of the system where the BPI 
Server is installed.

b. BPI Port

This is the port number for the Web Server used by the BPI Server 
and is identified as Servlet Engine HTTP or Servlet Engine HTTPS 
under the Port Numbers option within the Administration Console for 
the BPI Server. 

c. BPI Protocol

The protocol used for the BPI Web Server and can be either HTTP or 
HTTPS depending on the port number configuration.

d. BPI RMI Port

The port number for the BPI Server RMI Registry. The RMI Registry 
port number is listed under the Port Numbers option within the 
Administration Console for the BPI Server.

You can also create My BSM applications for BPI as described in section 
Creating a My BSM Application for BPI on page 142.
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Creating a My BSM Application for BPI

Within Business Availability Center, you can configure a Business Availability 
Center portlet server (My BSM). My BSM is a portal that you can customize to 
display specific content that is relevant to you, in this case, BPI Business 
Process information.

There is a Category, within the Personalize option, for My BSM called HP 
Business Process Insight. The following are the portlets that you can add 
for the BPI Integration category to display BPI data:

• a BPI Process Diagram portlet to display an BPI Process diagram that 
corresponds to a selected CI. 

• a BPI Monitors Over Time portlet to display:

— the average, minimum, maximum, process value or duration of a CI 
over a specific time period.

— the violated instances of a CI over a specific time period.

• a Business Process Over Time portlet to display information about the 
volume (throughput), backlog (active process value) and health of a 
selected Business Process CI over a specific time interval.

• a Business Process Step Over Time portlet to display information 
about the volume and backlog of a Step CI over time.

• a Business Process Step Summary portlet to display the summary data 
for a selected Step CI.

• a Business Process Summary portlet to display the summary data for a 
selected Business Process.

For more details of the My BSM portlets available for BPI, refer to the My 
BSM Help.
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If you configure a My BSM application for BPI, but there is no diagram 
shown in the portlet, check that you have used a fully qualified domain 
name for the Domain name of the Gateway Server as follows:

— Open the BPI Administration Console.

— Select Servlet Engine > Security from the left-hand navigator 
pane.

— Under Authorization settings make sure that the property 
Domain name of local host: is fully qualified and contains a 
Domain name. If it is not fully qualified, correct the entry and restart 
all the BPI Server components.
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SLM and Reporting

As mentioned earlier in the chapter, the data samples sent to Business 
Availability Center are written to an offline data repository.

The Business Availability Center Service Level Management (SLM) 
component uses the data stored in the offline data repository as a source for 
building Service Level Agreements and setting Service Level Objectives, and 
for creating reports.

In terms of Service Level Management, you can:

• enable service level objectives (SLOs) to be set for the BPI configuration 
items (CIs), which are managed within Business Availability Center.

• configure alerts, within the Business Availability Center SLM component, 
based on the SLOs that have been set on the BPI CIs.

Refer to the Business Availability Center Service Level Management 
documentation for information about setting Service Level Objectives.

In terms of reporting, you can configure the Business Availability Center 
Report Administration component to generate reports based on the BPI CIs.

Refer to the Business Availability Center documentation related to custom 
reporting and alerting for more information. 
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Description of Data Samples Sent to Business 
Availability Center

BPI sends data samples to Business Availability Center and all the BPI data 
samples are mapped to the following KPIs within Business Availability 
Center:

• backlog (600)

The data sample for this KPI is taken from the active value of the 
Business Process or Business Process Step as calculated as part of the 
Business Monitor instance results.

• business impact (602)

This KPI shows the overall health of the bpi_step in the Business Process 
within Business Availability Center. It is based on the number of blocked, 
at risk and healthy instances reported in the Business Process Insight 
data samples. This KPI applies to processes only.

• duration (601)

The data sample for this KPI is taken from the duration value.

This KPI is displayed only if the Business Process includes a Business 
Monitor where the Monitor Type is equal to Duration.

• value (1311)

The data sample for this KPI is taken from the Process Value.

This KPI is displayed only if the Business Process includes a Business 
Monitor where the Monitor Type is equal to Process Value.

• volume (1050)

The data sample for this KPI is taken from the throughput value (Volume) 
as calculated as part of the Business Monitor statistics.

This value is sent from BPI and represents the value throughput for the 
data sample poll interval; for example, if you have a poll interval that is 
set to one minute, the throughput is the value processed for this one 
minute interval.
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These data samples include as much information as is possible to give the KPI 
context. In the case of the business health for a Business Process, the health of 
the specific Business Process is reported. When reporting the overall health, 
any Groups that you have defined in the Monitor Definer are ignored, it is the 
overall monitor statistic that is reported

If all the backlog, throughput and duration thresholds in the Business Process 
Monitor have a status of Normal, Dashboard displays the Business Process 
Monitor Description as the Units Description in all the relevant KPIs.

If any of the backlog, throughput and duration thresholds in the Business 
Process Monitor have a status other than Normal, the Dashboard displays the 
Instance Threshold Description for the most severe status as the Units 
Description in the corresponding KPI. 

The time interval between data samples can be configured using the Data 
Sample send interval (seconds) parameter in the BPI Server 
Administration Console.

Value and Counts

If you have not modified the BAC configuration, Dashboard is configured to 
show KPIs (Backlog, Volume, Business Impact) based on the process value 
from your process definition. You can change this behavior by reconfiguring 
the KPIs within Dashboard; for example:

1. Select:

Admin > Dashboard

2. Within the Business Processes view, navigate to the Business Process 
Step and then Monitor that you want to modify.

3. Select the KPIs tab.

You can then add or modify a KPI that you want to show within 
Dashboard.

For example, Figure 6 shows an example using the BPI Monitor 
Backlog Count Rule.

It might seem obvious, but in order to have Business Monitor data reported 
though the Business Availability Center, you must be collecting statistics on 
your Business Monitors.
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Figure 6 Switching KPIs

There are a range of KPIs that are available for you to configure as objectives 
for your Business Processes.
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4 Modeler
This chapter describes tasks that are specific to the management of your 
Process definitions using the Modeler. 

For information and help about using the BPI Modeler to create and deploy 
definitions, including examples and scenarios, refer to the Business Process 
Insight Integration Training Guide - Modeling Processes. You can also find 
information about using the BPI Modeler in the Modeler Online Help, which is 
accessed from within the Modeler application from the Help menu option.

This chapter describes the following:

• Modeler Concepts on page 150.

• Modeler Management Tasks on page 153.
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Modeler Concepts

The BPI Modeler is a client-side BPI component that you use to create your 
Business Process definitions, Data definitions and Event definitions. It is a 
graphical tool, with a unified interface for all the definition types that you are 
creating. 

Figure 7 shows the components of the Modeler when initially installed with 
Business Availability Center and there is no BPI Server component installed.

Figure 7 BPI Modeler

The BPI Modeler is installed when you install Business Availability Center 
and is accessed from the Business Process Insight option under Admin. 

In order to use the full capabilities of the Modeler, you need to install the 
Server component of HP Business Process Insight. Without this Server 
component, you can model Business Processes and map process Steps to IT 
infrastructure CIs; however, you are not able to create process models that 
enable you to monitor individual process instances within Business 
Availability Center. All options are visible within the Modeler interface, but 
some options cannot be set unless you have installed the BPI Server 
component of Business Availability Center.
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When you install the BPI Server, you are then able to create and edit Business 
Process definitions, Data definitions and Event definitions quickly and easily, 
using the BPI Modeler. When you are satisfied that your definitions are 
complete, you can use the Modeler to deploy them to the Business Impact 
Engine. 

In addition, you can import Business Process Execution Language (BPEL) 
into the Modeler and use the BPEL definition as the start point of your 
Process definition.

A local repository cache, in the BPI Modeler, holds Process definitions, 
including Data and Event definitions until they are saved in the Process 
Repository schema as a set of database tables. Definitions might also need to 
be redeployed. The tables are managed by the Process Repository, which is 
described in section Process Repository on page 152. Figure 8 shows the 
components of the Modeler after you have installed the BPI Server.

Figure 8 BPI Modeler when the BPI Server is Installed
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Process Repository

The Repository schema and the Process Repository are the server-based 
components that manage the data as it is entered through the Modeler. These 
components store the model definitions in the database and ensure that the 
details are consistent and deployable. There is a ToDoList within the Modeler, 
which is associated with each definition. The ToDoList reports on the 
consistency of the definition and keeps track of all the outstanding issues and 
tasks required to ensure that the definition is consistent and complete. Note 
that a definition cannot be deployed unless it is consistent.

The deployer component of the Process Repository deploys the different 
definitions to their destinations as follows:

• Process definitions, including any imported BPEL definitions, are 
deployed to the Business Impact Engine as compiled Java code.

• Data definitions are deployed to the Business Impact Engine as compiled 
Java code.

• Event definitions are deployed to the Business Event Handler to be 
mapped to events from underlying business applications.

In addition, there is a Repository Explorer, which is a Web-based interface 
that you can use to view and manage some aspects of the data stored in the 
Repository Database.

The BPI Modeler and its features are described in more detail in the Business 
Process Insight Integration Training Guide - Modeling Processes.
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Modeler Management Tasks

The following are the management tasks that you can complete using the BPI 
Modeler:

• Starting and Stopping the Modeler on page 153

• Deploying Processes and Dependencies on page 155

• Undeploying Definitions from the BPI Modeler on page 157

• BPI Modeler Log File on page 157

• Exporting and Importing Process Definitions on page 158

• Importing BPEL Processes on page 160

• Copying Properties Between Data and Event Definitions on page 161

• Exporting Definitions to Recover Unsaved Changes on page 162

• Linking Steps to TransactionVision Events on page 161

• Linking Steps to IT Operational Resource CIs on page 161

Details of the tasks for creating Business Processes definitions, Data 
definitions and Event definitions are contained in the Modeler online Help, 
which can be accessed from the Modeler Help menu option. 

Starting and Stopping the Modeler

To start the BPI Modeler, complete the following steps:

1. Select Admin > Business Process Insight

You are presented with a tabbed page that includes a tab for Modeling. 

2. Select the Modeling page.

3. Click the icon for the Modeler on the page and wait for the Modeler to 
launch as a Java Web Start application.

You might be asked to confirm that you want to download the files to open 
the Modeler within your web page. If required, confirm that you want the 
download to proceed.

The BPI Modeler opens.
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Figure 9 shows an example of the layout of the Modeler when you open it.

Figure 9 Modeler GUI

If you have installed the BPI Server component, you also need to make sure 
that the Process Repository component is started on the BPI Server system 
and the Infrastructure settings are completed for BPI.

Use the BPI Administration Console on the BPI Server system to start the 
Process Repository as described in section Starting and Stopping the BPI 
Server Components on page 27.

To stop the BPI Modeler, select Exit from the File menu in the Modeler 
window. You are prompted to save any currently unsaved changes to the 
models that you have been editing.
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If you logout of BAC and leave the Modeler running, the Modeler no longer 
has access to the Process Repository. In this case, when you next try to use the 
Modeler, you are prompted to save any currently unsaved changes to the 
models that you have been editing and the Modeler closes.

Deploying Processes and Dependencies

This section explains how to deploy a Process and any associated Data 
definitions and Event definitions.

Before deployment, you have either created a new definition in the repository 
that the BIE has no knowledge of, or have created a new undeployed revision 
of a definition by making changes to it.

When you deploy the definition to the Engine, the Engine then creates:

• a Java-compiled definition for the process in its database

• database entries for the definition

To deploy the Process, Data and Event definitions to the Business Impact 
Engine, complete the following steps:

1. Open the Modeler.

2. Select the Process from the Navigator pane in the left-hand pane.

3. Select File > Deploy from the menu options. 

You are prompted to save all currently unsaved changes, if you have not 
saved them already. Click Yes.
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If you have previously deployed the process, you are presented with a 
dialog that lists the definitions that will be deployed and that also informs 
you that a previous version of the process is already deployed. In this case, 
you need to select an option for deployment:

— Replace the existing definition.

This replaces the definition and removes all the instance of the 
definition. Any statistical information collected for the instance is 
retained.

— Deploy under a different name.

This enables you to deploy the definition using a different name, and 
therefore preserving the instance information for the existing 
definition. If you select this option, you then select the Next button to 
make a copy of the definition.

The Modeler checks the state of all the definitions that you selected to 
deploy. A dialog box appears to prompt you to confirm that you want to 
deploy all currently undeployed changes to the Business Process and all 
its dependencies. 

4. Click Deploy to confirm your request.

The deployer shows its progress as it deploys the Processes, Data and 
Event definitions.

5. Click Close when the Deployer indicates that it has finished deploying 
the definitions.

You have now deployed the process and its dependencies.
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Undeploying Definitions from the BPI Modeler

There are circumstances where you might want to undeploy one or more of 
your Business Processes. In addition, you might need to undeploy individual 
definitions from the BPI Process Repository; for example, you might need to 
undeploy Event definitions when an Event becomes out of date. 

To undeploy a Process, Data or Event definition, complete the following steps:

1. Open the Modeler:

2. Select the definition that you want to undeploy from the Navigator pane 
in the BPI Modeler.

3. Select Undeploy from the File menu and follow the instructions provided.

The status of the definition changes from Yes to No, but can be 
deployed.

The Summary Window in the BPI Modeler now shows the revised status of the 
definition.

If you have modified a definition, it is shown as not being deployed; however, 
an earlier version is deployed. If you want to know what the deployed status of 
definitions is (as opposed to a development status), use the Repository 
Explorer, see Chapter 6, Process Repository Explorer.

You can also use the Intervention tool to show you the status of the 
definitions. The Intervention tool is described in Chapter 7, Process 
Intervention.

BPI Modeler Log File

There is a Modeler log file located on the machine where the Browser is 
running as follows:

If you undeploy a definition, existing instances using the definitions are still 
running in the Business Impact Engine until completion, or until the 
Instance Cleaner deletes them. New instances of any undeployed definitions 
are no longer created. The definition is removed by the Model Cleaner as 
described in section Modifying the BIE Model Cleaner Settings on page 39.

You can undeploy a definition that is referenced by another definition, so you 
need to make sure that you maintain consistency within your Business 
Processes.
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.../Documents and Settings/username/.hp_bpi

The following log files are the most significant files:

• hpbpi_modeller0_0.log

This log file is the most useful.

• hpbpi_modeller_m.log

This log file is less informative, but does contain communication errors, if 
they occur. 

In addition, there are Modeler related log messages contained in the Process 
Repository log file. If the BPI Server is installed, the Process Repository log 
file is located as follows:

bpi-install-dir/data/log/bia_model_repository0_0.log

If the BPI Server is not installed, the Process Repository log file is located as 
follows:

bac-install-dir\log\bpi_process_repository

The log files are text files that you can open using a text editor. Use the log 
files to identify problems with your BPI system.

You can also modify your Java settings to show the Java console while the 
Modeler is running. You should do this only if you are trying to isolate a 
problem. You can access the Java Console options as follows:

Start > Programs > Settings > Java > Advanced > Java Console

Exporting and Importing Process Definitions

The BPI Modeler has an option to enable you to export and import Business 
Processes, including their dependencies (any Data and Event definitions) to a 
.zip file that contains XML files. This enables you to create Business 
Processes using one Modeler for testing and then move the processes to a 
production system when they are fully verified. You can also export and 
import any Business Process monitor definitions that you have defined for 
your processes as described in Exporting and Importing Monitor Definitions 
on page 173.

You use the File > Import Definitions... and File > Export 
Definition... menu options from the BPI Modeler to export and import 
your Business Process definitions.
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Make sure that you have a naming policy for Process, Data and Event 
definitions across your organization to minimize the possibility of a name 
clash when the Business Processes are imported for deployment to the 
Business Impact Engine. You have the option to rename your definitions when 
you import them; however, you might prefer to have a standard naming 
scheme.

Exporting Definitions

Use the File > Export Definition... option to export the Business 
Processes to an XML .zip archive file. When you have exported the file, you 
can copy the file to the system where the BPI Modeler that you want to import 
the file to is installed. Finally, use the Import option to import the Process 
definitions as described in section Importing Definitions on page 160.
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Importing Definitions

If you have previously exported a Process definition and you now want to 
import it into the BPI Modeler, complete the following steps:

1. Select the following option from the File menu: 

Import Definitions...

2. Navigate, or browse, to the location of the previously exported definition 
file and click Open.

3. Click Next to move to the next option. You are presented with a dialog 
that lists the content of the definition file that you are importing. 

From this dialog, you can:

— import a listed definition and overwrite any existing definition of the 
same type that has the same name. 

— create a new copy of a listed definition or rename an existing 
definition. For this option, you provide a new name for the definition 
in the Save As column.

— choose not to import a listed definition.

When you have tailored your import requirements, click Import.

4. Click Close to complete the import.

When the Process definitions are successfully imported they are shown as 
being undeployed in the BPI Modeler. You now need to deploy the imported 
Processes and their dependencies to the target BPI Server system.

Importing BPEL Processes

You can use the BPI Modeler to import Business Process Execution Language 
(BPEL) definitions.

You import the structure of a BPEL definition using the BPI Modeler; 
however, you cannot import the associated BPEL logic. When you have 
imported the BPEL definition, you can use the structure as the basis of a 
Business Process, which you can then modify to suit your reporting and 
tracking requirements. You also need to create the Data and Event definitions 
required to track the imported BPEL definition.
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Details of importing BPEL definitions, and the options available for tailoring 
the definitions when importing them are provided in the Business Process 
Insight Integration Training Guide - Importing BPEL. There are also 
instructions on using the Modeler commands in the BPI Modeler Online Help.

Linking Steps to TransactionVision Events

You use the BPI Event Importer to import transaction events directly from 
TransactionVision such that they are available to the Modeler when 
developing your processes. 

You link to the transaction events to configure event progression, and the 
linked transaction events automatically provide access to the transaction 
class CIs.

Refer to the Business Process Insight Reference Information for details of BPI 
and integrating with TransactionVision.

Linking Steps to IT Operational Resource CIs

When you configure the Steps in your Business Process, using the Modeler, 
there is an option to link the Step to one or more Configuration Items (CIs) 
within the UCMDB.

You edit the Related CIs for a Business Process, and then you redeploy the 
process to commit these CI dependencies to the CMDB.

If the Business Process has already been deployed, you are not able to link a 
CI directly, you need to edit the Business Process using the Edit Deployed 
Process Settings option.

Refer to the Online Help for the Modeler for more details of linking CIs to 
Business Process Steps.

Copying Properties Between Data and Event Definitions

Using this option enables you to create properties in your Data definition that 
match the properties of an Event definition that it subscribes to. Similarly, it 
can be used to create properties of an Event definition that match those in a 
Data definition.
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Using the copy function saves the need to define identical properties for your 
Data and Event definitions multiple times. To copy properties from one 
definition to another definition, complete the following steps:

1. Open the definition whose properties you want to define.

The properties that you select in the following steps are copied to this 
definition.

2. Select the Properties tab for the definition.

3. Select the Copy Properties option from the Tools menu.

You are presented with a Copy Properties dialog that has a tree 
definition of all the Data and Event definitions currently defined.

4. Select the definition whose properties you want to copy.

Note that you are not able to copy a property that already exists in the 
selected definition.

5. Select the properties within the definition that you want to copy. You can 
use the Select All option to select all the properties.

6. Click OK and the selected properties are copies to the definition that you 
opened in step 1.

You have now copied properties from one definition to another definition.

Exporting Definitions to Recover Unsaved Changes

If the BPI Modeler loses its connection to the Process Repository for any 
reason; for example, the BPI Server has been shutdown in order to 
reconfigure a component, you cannot continue and modify your Process 
definitions.

If you have made changes to your definitions, but not saved the changes, you 
have the opportunity to export these changes to a recovery file before closing 
the BPI Modeler. 

As soon as the BPI Modeler realizes that it has lost its connection to the 
Process Repository, it presents a dialog for you to enter the name of the file 
where you want to save your modifications. The next time that you start the 

If you close the BPI Modeler without exporting your unsaved changes, the 
changes are lost.
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BPI Modeler and the Modeler successfully connects to the Process Repository, 
you are presented with a dialog that enables you to select the file where you 
saved your changes in order to import them back into the Process Repository.

If the BPI Modeler loses its connection to the Process Repository, and all your 
definitions are up to date, you are informed that the BPI Modeler must exit, 
and that no data is lost.

When you have exported the unsaved modifications, the file that is created is 
the same as the files created using the Export option and you can import the 
file at a later time if required or preferred.

The file used to store the definitions for recovery purposed is not deleted after 
the recovery process is complete. It is therefore available in the future if you 
wanted to import your modifications again for any reason.
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5 Monitor Definer
This chapter describes tasks that are specific to the management of your 
Monitor definitions using the Monitor Definer.

Details of how to use the Monitor Definer to create Monitors for BPI, including 
scenarios and examples, is described in the Integration Training Guide - 
Defining Business Monitors. There is also information about using the 
Monitor Definer in the Online Help. This is provided within the Monitor 
Definer and is accessed from the Help menu option within the Monitor 
Definer interface.

This chapter describes the following:

• Business Process Monitor Definer Concepts on page 166.

• Monitor Definer Tasks on page 171

• Monitor Definer Reference on page 177

You cannot open or use the Monitor Definer, unless you have installed the 
BPI Server. The Monitor Definer options appear when the BPI Server is 
installed and the connectivity between the BPI Server and the Business 
Availability Gateway Server has been configured and the BPI Server 
components are started. This configuration is described in Chapter 3, 
Enhancing BAC with Process Instance Monitors.
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Business Process Monitor Definer Concepts

The Monitor Definer is a Web-based GUI that enables you to define Business 
Process monitors and monitor instance threshold definitions for deployed 
processes.

A Business Process monitor is a business measurement that has a specific 
meaning within your business and can be used to record information about 
the Business Process that you are monitoring. Monitor instance thresholds 
are set on individual monitor instances. When monitor instance thresholds 
are violated, instance threshold violations are generated and can be reported 
through the Business Process Insight Application Health pages. You can also 
configure the Notification Server to send violation messages when a monitor 
instance threshold is violated.

Within BPI, the tool for defining Business Processes is separated from the tool 
for defining Business Process monitors for these processes. You use the BPI 
Modeler to define your Business Processes and you use the Monitor Definer to 
define the Business Process monitors and monitor thresholds for these 
Business Processes. You define Business Process monitors for a Business 
Process after the process has been deployed; this provides more flexibility for 
defining and modifying Business Process monitors without the need to 
redeploy your Business Processes.

You can also use filters to further target the statistical data that you want to 
collect. This has the added benefit of reducing the amount of data stored in 
the database and therefore maintaining the BPI system performance.
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Figure 10 shows the Business Process Monitor Definer relative to the 
Business Monitor data stored in the BPI database.

Figure 10 BPI Business Process Monitor Definer

You can define monitors for:

• Single Steps

• Multiple Steps

• The whole process

These monitors can be duration based or Process Value based. In addition, you 
can define a custom monitor.

Data are collected based on this configuration, and instance thresholds can be 
defined to report on individual process instances.

You can also use the Monitor Definer to export Monitor and instance 
threshold definitions to an XML file, and subsequently import these 
definitions.

How the Business Process Monitors definer interworks with the Monitor 
Engine is described in section Monitor Engine on page 168. 
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Monitor Engine

The Monitor Engine is the component of the BPI Server that analyzes and 
provides the statistical results from the Business Process monitor and 
monitor instance threshold data that you define. The Monitor Engine takes 
data about the individual instances from the Business Impact Engine and 
combines this data with the data you enter through the Monitor Definer to 
collect and report on the required information about the process.

If you have configured BPI to integrate with Business Availability Center, no 
statistical monitors and thresholds can be defined in BPI. Instead, this data is 
sent as data samples to Business Availability Center where the statistics can 
be displayed and analyzed.
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Figure 11 shows the relationship between the process impact data and the 
monitor data that you define.

Figure 11 Process Impact and Monitor Data Relationship 

The Business Process monitors and monitor thresholds are configured 
through the Business Process Monitor Definer; see section Business Process 
Monitor Definer Concepts on page 166.
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are deployed according to the Business Process monitors that you have 
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Figure 12 shows how the monitor data is used by the Monitor Engine to report 
statistics and instance threshold violations to other BPI components.

Figure 12 BPI Business Process Monitor Engine

The statistics that the Monitor Engine calculates are stored in BPI database 
tables and are used by the Business Process Insight Application Health pages. 
The database tables also hold information used to determine if any monitor 
thresholds have been violated. These violations are reported through the 
Health pages and can also be reported through the Notification Server or 
other HPOM applications.

Managing the Monitor Engine parameters is described in section Component 
Configuration - Monitor Engine on page 53 of this guide and the architecture 
for the Monitor Engine and Monitor Definer is described in Business Process 
Insight Reference Information.

Monitor
Data

Performance 
Threshold Definitions

Performance 
Threshold Violations

Filter Definitions

Monitor Statistics

Monitor Definitions

Notification 
Server

Performance 
Threshold 
Violations

Filter 
definitions

Monitor 
Engine

Monitor Engine

Monitor and 
performance 

threshold 
definitions

Monitor 
definitions

Performance 
threshold 
definitions

Monitor 
values and 
statistics

Performance 
threshold 
violations

Monitor Definer

Business Process 
Health 
170 Chapter 5



Monitor Definer Tasks

The following are the management tasks that you can complete using the BPI 
Monitor Definer:

• Opening the Monitor Definer on page 171

• BPI Monitor Definer Log Files on page 173

• Exporting and Importing Monitor Definitions on page 173

Opening the Monitor Definer

Before trying to start the BPI Modeler, make sure that the Process 
Repository component is started on the BPI Server system. Use the BPI 
Administration Console to start the Process Repository as described in section 
Starting and Stopping the BPI Server Components on page 27.

To open the BPI Monitor Definer:

1. Select Admin > Business Process Insight

You are presented with a tabbed page that includes a tab for Monitor 
Definer.

2. Click the tab for the Monitor Definer and you are presented with a page 
listing any processes that are deployed and any monitors defined for these 
processes.

Figure 13 shows an example of the layout of the Monitor Definer when you 
open it. 
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Figure 13 Monitor Definer GUI
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BPI Monitor Definer Log Files

There are two sets of log files that you need to be familiar with when 
managing your Business Process monitors:

• Monitor Engine log files

The Monitor Engine log files are managed in the same way as other BPI 
Server components and are described in section Component Configuration 
- Logging on page 103.

• Monitor Definer log files

The Monitor Definer logs messages to the BPI Servlet Engine log file. 
These messages in the Servlet Engine log file are prefixed with the string 
Monitor Definer. The Servlet Engine is considered as a component of the 
BPI Server and section Component Configuration - Logging on page 103 
describes the Servlet Engine log file.

Exporting and Importing Monitor Definitions

The BPI Monitor Definer has options that enable you to export and 
subsequently import the Business Process monitors, monitor thresholds and 
filters defined for a selected Business Process. You might want to export a 
Business Process monitor definition to enable you to create Business Process 
monitors for testing and then move these monitors to a production system 
when they are fully verified.

These definitions can be exported to a .zip archive file, which contains XML 
files describing the definitions. The .zip archive contains a copy of the 
monitor definition and some (but not all) information about the parent 
Process definition. The information relating to the Process definition is that 
required to uniquely identify the Process definition that the Business Process 
monitor applies to. The .zip archive file does not contain all the information 
relating to files that you might have created for custom Business Process 
monitors; it contains the custom monitor definition, but you need to 
separately manage and export any SQL you have created for the custom 
monitor definitions.

Be aware that the .zip archive created from the Monitor Definer is not the 
same as the .zip archive created from the BPI Modeler. You cannot 
interchange the .zip archives between the two applications, you must import 
the archive created from the appropriate application. This is because the .zip 
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archive from the Monitor Definer contains sufficient information about the 
Business Process to enable the Monitor Definer to import the monitor; it does 
not contain a full definition of the Business Process.

Exporting a Business Process Monitor

To export one or more Business Process monitors, use the Export or Export 
All options from the File menu in the Monitor Definer Navigation frame.

When you select a Business Process monitor to export, all the associated 
monitor instance threshold and filters are also exported. The export is based 
around the identifier of the Business Process that the Business Process 
monitor is linked to. All the information, including monitor thresholds and 
filters, is exported to XML files, which are then packaged into an overall .zip 
archive file. The .zip file can then be copied to the destination system in order 
to be imported.

When you export a Business Process monitor, you also need to make a copy of 
any additional files that you might have created that are associated with the 
Business Process monitor; for example, you might have defined a custom 
monitor. In the case of a custom monitor, you need to make sure that you have 
a copy of any SQL files that you have created for the custom monitor.

The name of the exported file is based on the Process name, machine name 
and time that the monitor is exported. This is in order to provide a unique 
name for the .zip archive file. If any of the elements of this constructed file 
name contain non-ASCII characters, the elements are excluded from the file 
name. This is because Internet Explorer allows only .zip archive file names 
that contain ASCII characters.

You cannot import a monitor definition until the process definition that the 
monitor applies to is deployed to the Business Impact Engine. Refer to section 
Exporting and Importing Process Definitions on page 158 for details of 
exporting and importing process definitions.
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Importing a Business Process Monitor

Before importing a Business Process monitor, you must have already imported 
and deployed the Business Process to which the Business Process monitor is 
linked.

In addition, if you have defined custom monitors, and you are moving the 
definitions to a new machine, make sure that you also copy any files that you 
have created for the custom monitor to the new machine. For example, you 
might have created SQL files for your custom monitor and this SQL file is not 
exported as part of the .zip file. If you do not copy the files relating to any 
custom monitors before importing the Monitor definition and creating the 
appropriate stored procedures, the import fails.

To import the Business Process monitor, complete the following steps:

1. Select the following option from the File menu on the Monitor Definer 
navigation frame: 

Import

The right-hand pane provides a browse button that you can use to 
navigate to the file where the file that you want to import is located.

2. Select the file that you want to import and click Open.

3. Click the Import Definitions button.

The Monitor Definer provides a summary of the monitor definitions 
contained in the zip file and how they will be applied to the processes that 
are currently defined on your system. You need to check that the monitor 
definitions in the zip file are being applied to the correct process 
definitions before importing the file. As an example, you need to make 
sure that you have not renamed a process since a monitor definition was 
exported.

4. Select the checkbox next to each set of Business Process monitors that you 
want to import from the zip archive file.
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5. Click Import Definitions.

The Monitor Definer displays a feedback message indicating whether or 
not it successfully imported the selected monitor definition.

6. Click OK and the Monitor Definer returns to the Monitors and Thresholds 
page for the process.

If you import monitor definitions which are named identically to monitor 
definitions that are already defined within the Monitor Definer, they are 
imported and renamed (appended with a number), in order to make them 
unique. Instance threshold names are not changed as they need only be 
unique for the Monitor definition that they apply to.
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Monitor Definer Reference

This section contains the following topics:

• Collection Interval on page 177

• Warning Messages in Log Files on page 177

Collection Interval

When you install the BPI Server and configure the integration between BPI 
and Business Availability Center Gateway Server, you configure the Data 
Samples settings. One of the properties of these settings is Data samples 
send interval (minutes); this is the time interval used to send data 
samples to Business Availability Center. The value for the Data samples 
send interval becomes the value for the Collection Interval within BPI 
and you can no longer modify the value for Collection Interval within the 
Monitor Definer.

If you import a previously exported Business Process Monitor.zip archive 
file, the value for the imported Collection Interval is imported and 
recorded; however, when the integration with Business Availability Center is 
enabled, the value for Collection Interval is not used. The value is 
imported in order that it is available for use if the integration with Business 
Availability Center is subsequently disabled. The value used for the 
Collection Interval, in the case of importing to a system where the 
Business Availability Center integration is enabled, is the value set for the 
Data samples send interval.

Warning Messages in Log Files

Each time a Business Monitor is created with an associated Monitor 
Threshold or Group, a warning is generated in the Business Process Engine 
log file. This warning is added by Hibernate and can be ignored; there is not a 
problem with the Business Monitor. 
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6 Process Repository Explorer
This chapter describes the BPI Repository Explorer. The Repository Explorer 
is a Web-based interface that enables you to browse and manage the contents 
of the Process Repository Database. The Process Repository Database holds 
the data for the Business Processes that you have defined using the BPI 
Modeler.

For information about creating definitions using the BPI Modeler, refer to the 
Business Process Insight Integration Training Guide - Modeling Processes,. or 
the Modeler Online Help.

This chapter describes the following:

• Process Repository Explorer Concepts on page 180

• Repository Explorer Tasks on page 182

• Repository Explorer Reference on page 187

You cannot open or use the Process Repository Explorer, unless you have 
installed the BPI Server. The Process Repository Explorer options 
appear when the BPI Server is installed and the connectivity between the 
BPI Server and the Business Availability Gateway Server has been 
configured. This configuration is described in Chapter 4, BPI and HP 
Business Availability Center.
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Process Repository Explorer Concepts

The Repository Explorer is a Web-based interface that enables you to view, 
print and manipulate the contents of the Process Repository. The Repository 
Database is a set of database tables that hold the data for the Business 
Processes that you have defined using the BPI Modeler. 

Using the BPI Modeler, you can create, modify and subsequently deploy a 
definition. When you have deployed the definition, you might then go on and 
revise the definition and significantly change it. This means that, unless you 
have exported the version of the definition that you previously deployed, you 
no longer have a copy of it within the BPI Modeler. You can therefore be in the 
position of having a deployed process, but no copy of the source for the process.

The Repository Explorer enables you to always be able to access the source to 
versions of processes that you have created and deployed.

Using the Repository Explorer you can:

• See whether a process is defined for instance tracking or not.

• View all the details of your currently deployed processes in a tabular form.

• Print a definition.

• Export the latest versions of your currently deployed definitions.

• Import previously exported definitions.

• View, definitions that have been deleted using the BPI Modeler. These 
definitions appear in the Recycled folder within the Repository Explorer, 
from where they can be permanently deleted.

Note that the data presented by the Repository Explorer contains a super-set 
of information. It shows those definitions that were once deployed, those 
definitions that are currently deployed, and those definitions that have been 
edited and not yet deployed. 

This is because you might have modified the process within the BPI Modeler, 
but not yet redeployed the process.
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The Repository Explorer is a view on the Process Repository data, which is 
created using the BPI Modeler and stored in the Process Repository database 
tables. You can browse and manage the data using the Repository Server as 
shown in Figure 14.

Figure 14 Repository Explorer
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Repository Explorer Tasks

The following are the tasks that you can complete using the Repository 
Explorer:

• Open the Repository Explorer on page 182

• Browse Definitions on page 182

• Print Definitions on page 183

• Delete Definitions on page 183

• Exporting Process Definitions on page 183

• Undeploying a Process Definition on page 185

• Restoring a Definition on page 186

Open the Repository Explorer

Before trying to use the BPI Repository Explorer, make sure that the Process 
Repository and Servlet Engine components are started on the BPI Server 
system. Use the BPI Administration Console to start them, as described in 
section Starting and Stopping the BPI Server Components on page 27.

To open the BPI Repository Explorer, complete the following steps:

1. Make sure that the Process Repository and Servlet Engine 
components are started.

2. Select Admin > Business Process Insight

Browse Definitions

Using the Repository Explorer, you can easily browse the current and earlier 
revisions of a definition to quickly see how they were defined. You need to be 
able to do this as the BPI Modeler is optimized for editing and not for 
browsing and therefore does not present the information relating to Process, 
Data and Event definitions in an easy-to-view way.
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Print Definitions

You can also print definitions using the print option at the top right-hand 
corner of the GUI. This print option enables you to print the contents of the 
right-hand pane in the Details view.

Delete Definitions

You can delete any definition using the Repository Explorer, provided it is not 
the current version of the definition that has instances currently running in 
the Business Impact Engine.

To delete a definition:

1. Select the definition that you want to delete from the Navigator Frame 
(see section Navigator Frame on page 188)

2. Click the History tab (see section History Tab on page 192).

3. Select the checkbox for the definition, or definitions that you want to 
delete.

4. Click Delete.

Exporting Process Definitions

The Repository Explorer can be used to export any revision of a definition 
from the Process Repository.

You might have multiple versions of a definition where you have deployed the 
Process definition multiple times. You can also export the latest version of a 
definition using the BPI Modeler; however, you cannot export earlier revisions 
of a definition using the Modeler, you can do this only through the Repository 
Explorer.

In addition to exporting individual versions of a definition, you can also choose 
to export the latest revision of all definitions from the Process Repository; you 
might want to do this to move all the latest definitions to another BPI Server.

Note that this definition is compatible with the Modeler and not the Monitor 
Definer; it does not contain any Business Process monitor information.
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You can export single definitions or all definitions:

• single definitions; see section Exporting a Single Definition on page 184.

You might want to do this in order to take a copy of the latest revision of 
the definitions. The latest version of the definition is exported to a .zip 
file. Exporting the definitions through the Repository Explorer, or the BPI 
Modeler, also ensures that the definitions are consistent within 
themselves as the definition and all its dependencies are exported.

• all definitions; see section Exporting All Definitions on page 185.

You might want to do this in order to move the definitions from one BPI 
Server to another BPI Server, for example, from a development system to 
a staging system. The latest versions of all the definitions within the 
Process Repository are exported to a .zip file, including all the 
dependencies.

Exporting a Single Definition

To export a definition, complete the following steps:

1. Select the definition that you want to export from the left-hand Navigator 
pane.

2. Click the Export option from the File menu in the Navigation pane. 

Continue at step 6.

3. Select the History tab in the right-hand pane.

4. Select the revision of the definition that you want to export from the list.

5. Click the Export button in the right-hand pane.

6. The right-hand pane lists the definition that will be exported.

7. Click the Download button to continue to export the definition.

You are presented with your browser’s File Download dialog.
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8. Select Save, to save the definition as a .zip file.

You are presented with a Save As dialog, where you can specify a file 
name and directory location for the .zip file.

9. Enter the details of the file name and click Save.

The file is saved and a Download complete dialog is displayed.

10. Click Close and the export is complete.

Exporting All Definitions

To export all definitions, complete the following steps:

1. Click the Export All Option from the File menu in the Navigation pane. 

2. The right-hand pane lists the definitions that will be exported.

3. Click the Download button to continue to export the definition.

You are presented with your browser’s File Download dialog.

4. Select Save, to save the definition as a .zip file.

You are presented with a Save As dialog, where you can specify a file 
name and directory location for the .zip file.

5. Enter the details of the file name and click Save.

The file is saved and a Download complete dialog is displayed.

6. Click Close and the export is complete.

Undeploying a Process Definition

You cannot use the Repository Explorer to undeploy a specific definition. You 
must use the BPI Modeler to do this. You can use the Cleanup Recycled 
option within the Repository Explorer to undeploy and delete all current 
revisions of definitions held in the Recycled folder; see section Navigator 
Frame on page 188.

Be aware that undeploying an Event definition, which is referenced by a Data 
definition that has current active instances, means that these data instances 
might not be able to progress. If this is the case, you can use the Intervention 
tool to delete the individual Data definition instances.
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Restoring a Definition

The Repository Explorer can be used to restore definitions that have been 
deleted using the BPI Modeler. These definitions are listed in the Recycled 
folder on the Navigator frame. 

You can access the Restore option from the File menu on the Navigator 
frame. The steps for restoring a previously deleted definition are as follows:

1. Select the definition that you want to restore from the Recycled folder.

2. Select the Restore option from the File menu in the Navigator frame.

The definition is restored to the Process Repository and is removed from 
the Recycled folder in the Repository Explorer. The restored definition 
appears under the appropriate definition list in the Repository Explorer.
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Repository Explorer Reference

The following topics are covered in this section:

• Repository Explorer GUI Layout on page 188

• Process Repository Explorer Log Files on page 193

Figure 15 shows an example of the layout of the BPI Repository Explorer.

Figure 15 Repository Explorer GUI
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Repository Explorer GUI Layout

The Repository Explorer comprises:

• A left-hand Navigator frame that lists the deployed Process, Data and 
Event definitions. The Navigator frame also contains a Recycled folder 
where definitions that have been deleted from the BPI Modeler are listed.

Section Navigator Frame on page 188 describes the Navigator frame.

• A right-hand frame that displays the appropriate details of the definition 
that you have selected in the Navigator frame. The right-hand frame 
includes tabbed pages for Details and History; see sections Details Tab 
on page 190 and History Tab on page 192 respectively.

The right-hand frame also contains a print icon, which enables you to 
print the contents of the right-hand pane.

Navigator Frame

The Navigator frame lists all the definitions that have been created in the 
Process Repository, using the BPI Modeler; the deployment status of each 
definition is also displayed in the Navigator frame. The Repository Explorer 
uses the same icons as are used within the BPI Modeler to show whether a 
definition is deployed or undeployed.

The following are the menu options available within the Navigator frame:

• File

• Refresh 

Click the Refresh button to refresh the Navigator frame to be up to date 
with the latest definitions that have been recently entered into the 
Process Repository using the BPI Modeler.
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The following are the options are accessible from the File menu:

• Export

Enables you to export the selected definition to a zip file; see section 
Exporting Process Definitions on page 183.

• Export All

Enables you to export the latest revision of all the definitions in the 
Navigator frame to a zip file; see section Exporting Process Definitions on 
page 183.

• Restore

This option is available when you select a definition from the Recycled 
folder. It restores the definition back to its original location, in the Process 
Repository, at the point where it was deleted in the BPI Modeler; see 
section Restoring a Definition on page 186.

The Navigator frame also includes a Recycled folder. Under the Recycled 
folder is a list of definitions that have been deleted from the BPI Modeler. 
When you delete a definition using the BPI Modeler the definition is 
moved to this Recycled folder, which is accessible only from the 
Repository Explorer.

• Cleanup Recycled

This option deletes all definitions in the Recycled folder and undeploys 
definitions that are deployed. If a definition is still in use by the Business 
Impact Engine, it is not deleted or undeployed. When all instances of 
these definitions have completed, these entries can then also be removed 
using the Cleanup Recycled option and the entries no longer appear in 
the interfaces. The instances of definitions are deleted by the Business 
Impact Engine using the Engine Instance Cleaner.

When you select a definition in the Navigator frame, the right-hand frame 
opens at the Details tab; see section Details Tab on page 190. You also have 
the option of selecting the History tab from the right-hand frame; see section 
History Tab on page 192. 
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Details Tab

The Details tab provides a page listing the details of the definition that you 
have selected in the Navigator frame. Much of the information listed under 
the Details tab can be determined from the BPI Modeler; however, the 
Repository Explorer provides the information in a structured form, which 
makes it easier to reference and print. The information listed under the 
Details tab varies according to type of definition selected in the Navigator 
frame:

• Processes

• Data

• Events

The following is an overview of all the sections for all the definitions:

• Identity/Summary

This section appears for all the definitions and lists an overview, or 
summary, of the definition.This includes information that you have 
entered relating to the definition using the BPI Modeler, and information 
relating to the revision of the definition. 

This section also lists the revision number of the definition and details of 
the other definitions that the selected definition uses and is used by.

• Related Data

This section appears only for a Process definition and lists details of the 
Data definition that has been defined as the Related Data definition for 
the selected Process definition, including whether or not the option to 
track instances has been enabled for the selected process.

• Process Diagram

This section appears only for a Process definition and shows the process 
diagram of the selected process. It is the same process diagram as is 
shown through the BPI Modeler.
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• Steps

This section appears only for a Process definition and lists details of the 
individual Steps that make up the Process definition, including:

— Name of the Step, which is shown adjacent to the icon for the Step.

— Type of Step (Start, End, Junction or Activity). Beneath the Step type 
is the associated progression rule (Start and Complete conditions)

— List of any CIs that the Step is linked to.

• Checked Arcs

This section appears only for a Process definition and lists details of the 
arcs that have been defined as Checked Arcs for the Process definition.

• Properties

This section appears for Data and Event definitions and lists details of the 
Properties that have been defined for the selected definition.

• Subscriptions

This section appears only for a Data definition and lists details of the 
Event subscriptions related to the Data definition and includes:

— Name of the subscription, which is shown adjacent to the icon for the 
subscription.

— Description of the Subscription as entered in the Modeler.

— Creation option, which are the conditions under which you have 
requested that the Event definition can be created.

— Filter expression, which is additional filtering that you can define to 
be applied to the incoming business event.

— Actions, which is the action that you have specified for extracting the 
required properties from the Business Event in order that they can be 
placed into the Data Definition.

• ToDo List

This section appears for all the definitions and lists the content of the 
current to-do list for the selected definition.
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History Tab

The History tab provides a page tabulating the details of the revision history 
related to the selected definition in the Revision History table. 

These details include:

• Revision number

• Deployment status

• Name of process as defined in the Modeler

• Date the revision was last saved

• Description (from the Description field in the definition)

• Labels, which is the date and time that the revision was deployed.

Each entry in the table has a check box which you can select (and clear). When 
you select the check box for one, or more, of the definitions in the table, the 
Export and Delete options are made available. The Export option is available 
only if you select a single entry. If you select more than one definition, or do 
not select any definitions, the Export option is not available.

If you want to export a definition on the Revision History table, select the 
definition, click the Export button and then follow the instructions that are 
presented to you by the Repository Explorer.

There is also a delete option available for each revision of the definition. You 
cannot delete a definition that is currently being processed by the Business 
Impact Engine, if you do try to delete such a definition, the Repository 
Explorer issues a warning message and does not allow the delete action to 
progress.

You can select any version of a definition to delete, including the current 
version of a definition. In the case of the current definition, the Repository 
Explorer issues a warning message for you to confirm the delete action and 
then continues. 

You cannot recover any definition that is deleted using the Repository 
Explorer.
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Process Repository Explorer Log Files

The Repository Explorer uses the Repository Server to access its data and the 
Repository Server logging is recorded under Process Repository in the 
Administration Console. Refer to section Component Configuration - Logging 
on page 103 for details of the logging settings that are used for BPI 
components.

In addition, you can find log messages for the Repository Explorer in the 
Servlet Engine log file.
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7 Process Intervention
This chapter describes how you can make changes to your Business Process 
data, and delete completed instances of Processes and Data definitions using 
the Process Intervention pages. 

Specifically this chapter describes:

• Process Intervention Concepts on page 196

• Process Intervention Tasks on page 199

• Process Intervention Reference on page 205
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Process Intervention Concepts

The Process Intervention page enables you to access processes that you have 
deployed in order to modify or delete Process instances and their associated 
Data instances.

You might want to modify or delete instances to resolve problems with the 
process, or its data. This is more usually required after a period of new 
development or where progression rules are not behaving as expected; for 
example, you might need to:

• manually progress and delete process instances.

• update and delete Data Definition instances.

You use Process Intervention to remove individual process instances or data 
instances from the database. If you want to delete several completed or active 
instances on a regular basis you should use the Engine Instance Cleaner 
parameters as described in Chapter 14, Deleting Completed Instances from 
the Database.

The purpose of Process Intervention is to:

• enable you to access deployed Process and Data definitions, plus Process 
instances and Data instances. 

• enable you to delete Process and Data definitions, and clear the average 
and total counts associated with a specific definition.

• invoke a manual synchronization between BPI CIs and the UCMDB. 

You cannot open or use the Process Intervention page, unless you have 
installed the BPI Server. The Process Intervention page appears when the 
BPI Server is installed and the connectivity between the BPI Server and the 
Business Availability Gateway Server has been configured. This 
configuration is described in Chapter 3, Enhancing BAC with Process 
Instance Monitors.
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The following are some examples of why you might want to use the 
Intervention tool:

• where a process instance has progressed through a process, but one or 
more Steps that should be complete still appear as active. 

You can use the Intervention tool to change the state of the active Steps to 
Complete. Steps can get into this state if you have manually progressed a 
Process instance, for example, when an application that usually provides 
the service is not available and you have substituted another application 
to complete the Step. 

• when the start and complete conditions for a Step are incorrect and 
therefore cannot be satisfied. In this case, you might want to delete all 
instances of the process and any associated process data. 

• where you want to progress a specific process instance to its completion, 
for example, there might be and order processing instance waiting for an 
automated system to enter credit card information, and the automated 
system is not operational. In this case, you can modify a data instance to 
add credit card information manually and progress the order for a 
customer.

• to remove erroneous processes to tidy up your system. You might need to 
do this if you have been developing new processes and want to remove 
older versions, which are no longer required.

• where you want to search for all process instances over a certain age and 
remove them. You can also do this using the instance cleaner parameters 
tools (see Chapter 14, Deleting Completed Instances from the Database); 
however, you might not want to remove all the process instances, just for 
one specific process.

• to delete an orphaned Data definition that is not linked to a Process 
definition, or perhaps where the Data definition was linked to a Process 
that has been deleted.

• to test your BPI system. You might want to delete all the active Data 
definitions to reset the system.
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• to reset the totals and averages for Process and Data definitions. You 
might want to do this periodically (daily, weekly, monthly) so you can see 
the totals and averages in terms of a known period.

• to manually synchronize the BPI CIs with the UCMDB for reasons such 
as:

— an earlier synchronization failed when you deployed a definition using 
the Modeler, and you want to invoke another one immediately and not 
wait for the background synchronization to run.

— CIs have been deleted from the UCMDB in error and you want to 
reinstate them. In this case, the synchronization adds, removes and 
updates CIs for the latest installation of BPI (including upgrades). If 
you have previously installed BPI and then removed it without 
undeploying definitions, these definitions are not synchronized.

Using the option to delete all existing BPI CIs from the UCMDB provides 
the option to remove all BPI-related CIs regardless of who or what created 
them.The delete action is completed before the synchronization is started. 
This option is useful if you want to clean out CIs that have been created by 
prior BPI installations.

If you want to clean up your development system using the Intervention 
pages, it is recommended that you use the Intervention Client to remove the 
definitions and all their instances from the Business Impact Engine and then 
re-deploy the process or processes that you want to use.
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Process Intervention Tasks

The following are the tasks that you can complete using the Process 
Intervention tool:

• Opening the Process Intervention Page on page 199

• Deleting Process or Data Definitions and Clearing Data on page 200

• Search for Specific Instances on page 200

• Change the State of an Instance on page 201

• Delete All Instances on page 202

• Modify or Reset the Data within a Data Instance on page 203

• Synchronize with the CMDB on page 204

Before completing any of these options, you are advised to read section 
Process Intervention Reference on page 205, which provides information on 
the possible impacts of making these changes.

Opening the Process Intervention Page

You access the Process Intervention page as follows:

1. Select Admin > Business Process Insight

You are presented with a tabbed page that includes a tab for Process 
Intervention.

2. Click the tab for Process Intervention and you are presented with a 
page requesting you to select from Process Definitions, Data 
Definitions or Synchronize with the CMDB.

3. Select the option for the task that you want to complete.
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Deleting Process or Data Definitions and Clearing Data

This section describes how to:

• Delete Process and Monitor Definitions, and instances of these definitions.

• Delete Process, Monitor and Data Definitions and all related instances.

• Clear Average Time and Total Instance Count for both the Process and 
the Process Steps).

• Delete Data Definition and associated instances

• Clear Average Time and Total Instance Count

If you want to deleted individual instances and not the Process or Data 
definition refer to the sections below.

To make your required changes:

1. Open the Process Intervention page.

2. Select the Process Definitions or Data Definitions option as 
appropriate.

3. Select the Process or Data definition that you want to modify, or delete.

4. Select the option for the task that you want to complete.

When you have completed your changes you can exit from the Process 
Intervention page.

Search for Specific Instances

To search for a specific instances of a process or data definition:

1. Open the Process Intervention page.

2. Select the Process Definitions or Data Definitions option as 
appropriate

3. Click the Search option for the definition that you are interested in.

The search dialog various according to whether you are searching for a 
process or a data instance.
200 Chapter 7



4. Enter the criteria for the search as appropriate.

In the case of a Process instance, you can enter a Process instance 
identifier directly, or you can filter for instances according to the following 
criteria:

— Process instances with a specific identifier and value for the Process 
Value parameter.

— Process instances within specified time periods.

— Process instances that are in a particular state, for example: Active 
or Completed.

In the case of a Data instance, you can search based on the values of the 
properties of the Data instances. You are presented with a Data Instance 
List page where you can delete or edit the Data Instances that match the 
search criteria.

When you choose to edit a Data instance, you are presented with a Data 
instance screen where you have access to the properties of the Data 
instance in order to confirm that it is the definition that you are interested 
in.

When modifying the properties of a Data instance, make sure that you 
enter the correct Type for the property, for example, if the property is an 
Integer, a numeric value for the property must be specified.

5.  Click the Search button to initiate the search. If you want to return to the 
previous screen click Cancel.

You can leave the search criteria blank, in which case the Intervention 
tool returns all the instances for the selected definition.

Change the State of an Instance

To change the state of a process or data instance:

1. Open the Process Intervention page.

2. Select the Process Definitions or Data Definitions option as 
appropriate
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3. Click the search option for the definition that you want to list instances 
for.

The search option enables you to filter the list of instances that are 
presented.

4. Enter the criteria for the search; see section Search for Specific Instances 
on page 200 for information related to completing the search criteria. 
Click the Search button to initiate the filter. If you want to return to the 
previous screen click Cancel.

You can leave the search criteria blank, in which case the Intervention 
tool returns all the instances for the selected definition.

5. Select the instance that you want to modify and click the Edit option.

6. Make the change to the State of the instance at the required Step and 
click OK.

Continue and make changes to other instances in the same way.

When you have completed your changes you can exit from the 
Intervention page.

Delete All Instances

To delete all instances of a process or data definition:

1. Open the Process Intervention page.

2. Select the Process Definitions or Data Definitions option as 
appropriate

3. Click the Search option for the definition that you want to delete the 
instances for.

4. Enter the criteria for the search; see section Search for Specific Instances 
on page 200 for information related to completing the search criteria. 
Click the Search button to initiate the filter. If you want to return to the 
previous screen click Cancel.

You can leave the search criteria blank, in which case the Intervention 
tool returns all the instances for the selected definition.
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5. Click the Select All button to select all the instances.

6. Click the Delete button to delete all the instances.

When you have completed your changes you can exit from the 
Intervention page.

Modify or Reset the Data within a Data Instance

To modify the data in a data instance:

1. Open the Process Intervention page.

2. Select the Data Definitions option.

3. Click the Search option for the Data definition that you want to list 
instances for.

4. Enter the criteria for the search.

5. Make the required changes to the data Select the instance that you want 
to modify and click the Edit option.

You can leave the search option blank to select all the instances for the 
Data definition.

The full list of instances for the definition is presented.

6. Select the Data instance that you want to modify and click the Edit 
button.

The Data instance details are presented in on editable form.

7. Edit the Data instance as appropriate and click OK.

When you have completed your changes you can exit from the Process 
Intervention page.
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Synchronize with the CMDB

If you want to synchronize the BPI definitions with those held in the UCMDB, 
complete the following steps:

1. Open the Process Intervention page.

2. Select the Synchronize with the CMDB option.

You have the option to delete all existing BPI CIs from the UCMDB before 
synchronizing. This is useful if there are CIs in the UCMDB that have 
been created by previous installations and processes were not undeployed 
before BPI was uninstalled.

3. Select the checkbox if you want to delete all existing BPI CIs, clear the 
checkbox if you do not want to delete them.

4. Click the Synchronize button to commence the synchronization.

When the synchronization is complete, you can exit from the Process 
Intervention page.
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Process Intervention Reference

This section provides background information relating to using the Process 
Intervention tool to delete or modify definitions and instances. 

Typically, you have identified an anomaly using the Business Process Insight 
Application, and are therefore using the Process Intervention tool to solve a 
specific problem. In this case, you have the identifier of the definition that you 
want to modify and you can enter this identifier directly on the search page to 
access the definition that you want to modify. Alternatively, you can use the 
Intervention tool’s filtering capability to search for the instance that you 
want.

You need to be aware of the following when using the Intervention tool:

• When selecting the option to delete a Process and associated Data 
definition, make sure that the Data definition is not also a dependency for 
other Process definitions. If the Intervention tool detects that by deleting 
the Data definition other deployed processes are affected, it presents you 
with a page that lists all the processes that also depend on the Data 
definition, where appropriate.

• When you select the option to delete a data instance, or a process instance 
including all its data instances, you can potentially leave other process 
instances in an indeterminate state.

This is a similar scenario to the previous bullet describing Process and 
Data definitions; however, in the case of instances, the Business Impact 
Engine cannot determine any relationships between the data instance 
that is being deleted and other process instances that might have a 
dependency on it.

If you do delete a data instance and there are process instances that 
depend on it, the process can no longer progress.

If you want to delete a significant number of process instances or data 
instances, the quickest way to achieve this is to delete the Process definition 
or Data definition; however, this deletes all instances of the Process and Data 
definitions, including any active instances. You can then redeploy the Process 
and Data definitions using the BPI Modeler. 
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Using the Process Intervention Option

On the Process Intervention page, you are offered the following menu options:

• Process Definitions

• Data Definitions

• Synchronize with the CMDB

When you select one of the options (Process Definitions or Data 
Definitions), you are presented with a list of definitions within the selected 
category. The actions that you can complete at this point depend on the 
definition that you have selected:

• for Process definitions, refer to section Process Definitions on page 206.

• for Data definitions, refer to section Data Definitions on page 207.

Process Definitions

When you select the Process Definitions option from the Intervention tool 
menu, you are presented with a list of Process definitions that are deployed in 
the Business Impact Engine.

The Process definitions within the Modeler are not impacted by the actions of 
the Intervention tool, so you can redeploy the Process; however active and 
completed instances of the process are potentially impacted by changes made 
through the Intervention tool.

At this stage, you can choose one of the following options:

• Delete Process and Monitor Definitions and instances

• Delete Process, Monitor and Data Definitions and all related instances

• Clear Average Time and Total Instance Count (Process and Steps)

This clears (or removes) the values for TotalFlows and AvrgTime from the 
Flows table in the BPI Instance database.

If you make changes to the values of data properties within a process, the 
progression rules associated with the data properties are evaluated and the 
process progresses, based on the new values.
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You can also choose to select:

• the Search option to identify specific instances of the definition; see 
section Search for Specific Instances on page 200.

• the Edit option and a process diagram is displayed. The process diagram 
shows the status of each Step in the process, for example, whether it is in 
the started or completed state. You can progress process instances from 
this option, by manually activating or completing Steps in the process.

The following are the icons that can be associated with each instance:

— a tick, which indicates that the Step instance has completed at least 
once

— a cog wheel, which indicates that the Step instance is started

— no icon, which indicates that the Step instance is not started or 
completed

Data Definitions

When you select the Data Definitions option from the Intervention tool menu, 
you are presented with a list of Data Definitions that are currently deployed 
in the Business Impact Engine.

At this stage, you can choose one of the following options:

• Delete Data Definition and instances

• Clear Average Time and Total Instance Count

This clears (or removes) the values for TotalInstances and AvrgTime from 
the Data Objects table in the BPI Instance database. Business Process 
Insight Reference Information describes the database tables in detail.

You can also choose to select the Search option to identify specific instances of 
the definition; see section Search for Specific Instances on page 200.

The Data definitions within the Modeler are not impacted by the actions of 
the Intervention tool, so you can redeploy the Data definition; however all 
active instances of the Data definition, and possibly the associated Process 
definition, are impacted by changes made through the Intervention tool.
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8 Notification
This chapter describes the BPI Notification Server pages and how to use them 
to configure the Notification Server to process subscriptions for notifications 
such as process impact and monitor instance threshold violations.

The chapter also describes how to configure the Notification Server email 
templates and scripts, which can then be used to deliver notifications that are 
received by the Notification Server.

This chapter covers the following topics:

Specifically, this chapter describes:

• Notification Server Concepts on page 210

• Notification Server Administration Tasks on page 213

You cannot open or use the Notification pages, unless you have installed 
the BPI Server. The Notification options appears when the BPI Server 
is installed and the connectivity between the BPI Server and the Business 
Availability Gateway Server has been configured. This configuration is 
described in Chapter 3, Enhancing BAC with Process Instance Monitors.
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Notification Server Concepts

The Notification Server is the BPI component responsible for sending email 
notifications and HP Operations Manager messages for events. These 
messages provide details of the process impact, monitor instance threshold 
and out-of-sequence events. You can receive these notifications through your 
email client or through an HP BTO Software client according to your 
requirements. 

You also have the option to execute a script when an impact event is received; 
for example, the script might update a file, or send an SMS message.

The Notification component can be considered in two parts:

1. The server, which is responsible for receiving the impact events from the 
Business Impact Engine and converting them into the appropriate email 
messages and HP Operations Manager Messages for delivery. This is 
described in section Notification Server Concepts on page 210. 

2. The Notification Server administration console, which enables you to 
create subscriptions for users to receive email notifications. It also enables 
you to create subscriptions for HP Operations Manager messages and 
scripts; see section Notification Server Administration Tasks on page 213. 

Notification Server Component

The Notification Server is a component of the BPI Server and is responsible 
for notifying you of the process-impact, out-of-sequence and monitor-threshold 
violations that you have configured through the Notification option for the 
Business Process Insight Application. The tasks for using the Notification 
options are described in section Notification Server Administration Tasks on 
page 213.

Notifications can be sent either through an SMTP server to an email client, or 
as an HPOM message to an HPOM Server. There is a retry mechanism for 
both types of notifications if either the SMTP server or HP Operations 
Manager is not available for any reason. Notifications are queued and retried 
after a configurable interval.
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Figure 16 shows the architecture of the Notification Server and its 
relationship to other BPI Server components.

Figure 16 Notification Server

Business violations are created by the Notification Server as a result of 
receiving:

• process-impact and out-of-sequence notification events from the business 
object manager through the Business Event Handler Transmitter.

• monitor instance threshold violation notification events from the Monitor 
Engine.

The Notification Server sends these events as business violations to you, 
based on a set of filters. These are filters that you create and that specify the 
impact events for which you want notification. You can filter email 
notifications based on event name, event type and the name of the Business 
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In addition to sending violations when an event is received, the Notification 
Server can also run any script (.bat file) that you have created. Creating 
scripts is described in section Creating Script Files on page 237.

Email Notification Messages

The email notifications contain impact information about:

• the Business Processes that you are monitoring.

• out-of-sequence events.

Out-of-sequence events are those events that you have chosen to monitor 
using the Check sequence option, which is an option on the BPI Modeler.

• monitor instance threshold violations.

There is a default template for these email notifications; however, you can 
change the layout of the email messages that are sent by the Notification 
Server. You can also configure the templates for the email notifications and 
add properties from the business violations into the messages and configure 
how many email notifications that you receive for a particular monitor 
instance threshold violation.

The default templates are provided as part of the BPI installation and 
instructions for creating your own templates and configuring monitor 
thresholds are provided in Chapter 5, Monitor Definer.

The following are the template types that you can use to change the format of 
your messages, if required:

• Velocity, which is a Java-based template Engine.

• XSLT, which transforms one XML document into another text document. 

It does not matter which tool you use, it is entirely dependent on your own 
preferences.
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Notification Server Administration Tasks

The following are the tasks that you can complete when using the Notification 
option:

• Managing Email Subscriptions on page 213

• Managing HP Operations Manager Message Subscriptions on page 217

• Managing Script Subscription on page 220

• Creating Notification Server Templates on page 222

• Creating Script Files on page 237

Managing Email Subscriptions

This section includes creating:

• subscriber accounts to receive specific process impact events that are 
generated by the BPI Server.

• subscriber accounts to receive specific monitor instance threshold events 
that are generated by the BPI Server.

• subscriber accounts to receive specific out-of-sequence events that are 
generated by the BPI Server.

Complete the following steps to configure the Notification Server: 

1. Make sure the Servlet Engine component is started using the BPI 
Administration Console, which is located on the system where the BPI 
Server is running.

2. On the system where Business Availability Center is running:

Select Admin > Business Process Insight

You are presented with a tabbed page that includes a tab for 
Notification.

3. Click the tab for Notification and you are presented with a page 
requesting you to select from Email Subscriptions, Script 
Subscriptions or HPOM Message Subscriptions.

4. Select Email Subscriptions.
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5. Click the New User button to add a new user.

You are presented with a User Information screen.

6. On the User Information screen:

a. Enter a User Name 

This is a name that you want to assign to the user; it can be any name 
that identifies the user subscription.

b. Enter an Email Address

This is the email address for the user named in the previous step. This 
must be a valid email account.

c. Click OK.

The new user now has an account on the Notification Server and is 
listed in the User List with the other users. 

You now have the option to:

• add another new user as described in the above steps.

• subscribe the new user account to the events that you want it to receive. 
To do this refer to section Configuring the Events Received by Notification 
Server Users on page 215.

• return to the main menu, where you can add more email subscriptions or 
add HP Operations Manager message subscriptions.

• delete an entry in the User List. To do this select the checkbox next to the 
User Name entry that you want to delete and then click the Delete 
button.
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Configuring the Events Received by Notification Server Users 

When you have added the user accounts for the users to receive notifications, 
you then need to configure these user accounts to subscribe to BPI events that 
you want them to receive. To do this, select the Subscriptions link on the 
Users List screen, under the Email Subscriptions column, for the user that 
you want to configure. This link takes you to the Process Subscriptions list 
for that user.

1. Click the New Subscription button.

You are taken to the EMail Subscription Details screen where you can 
add the email subscription details.

2. Select the Event Name and the Process Name for your new event 
subscription:

— Event Name:

You can select from: Process Impacted events, Process Monitor 
Threshold Violation Events, Process Out Of Sequence events, or 
All events. If you select All you subscribe to all types of event.

— Process Name:

You can select all process names to report on, or you can choose a 
specific process that is deployed to the Business Impact Engine. There 
is a drop down list provided, which lists all the deployed processes for 
you to select from, including the All option.

Click Next.

3. If you selected Process Monitor Threshold Violation Events, 
continue at step 5.
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4. If you selected All, Process Impacted or Process Out Of Sequence as 
the Event name, you are prompted to select the Minimum Severity Level 
and the Template for your new subscription:

— Minimum Severity Level:

This is the minimum severity level for which you want to receive 
email notifications; for example, if you select Critical you will receive 
email notifications only for violations that are critical. If you select 
Minor, you receive email notifications for Minor, Warning, Major and 
Critical violations.

— Template:

Select the template that is appropriate to your Event Name, for 
example, you might have created your own template for the event. If 
you have selected Process Impacted as the Event Name, choose the 
EMAIL-ProcessImpactedDefault.vm template. If you have selected 
Process Monitor Threshold as the Event Name, choose the 
EMAIL-MonitorThresholdDefault.vm template. If you have selected 
Process Out of Sequence, choose the 
EMAIL-OutOfSequenceDefault.vm template. If you have selected All 
for the Event Name, choose the EMAIL-GenericDefault.vm template, 
as it provides the most detailed information.

5. If you selected Process Monitor Threshold Violation Events, you are 
prompted for the following information, in addition to that requested in 
step 4.:

— Monitor Name

— Monitor Threshold Name

6. Click OK to commit the subscription to the administration database.

The new Event Subscription is now added to the list of Process 
Subscriptions for the user.

If you create two subscriptions for the same event type, each with 
different templates, BPI uses the template from the more restrictive 
subscription to format the violation. For example, if you create a 
subscription for all process impact events using one template and a 
subscription for a specific process impact event using a different 
template; the template for the specific process impact event is the one 
used to format the violation.
216 Chapter 8



You now have the option to:

• add another subscription as described above.

• delete an entry in the subscription list. To do this select the checkbox next 
to the entry that you want to delete and then click the Delete button.

• logout of the Notification Server Administration Console. You do this by 
closing the Web Browser Window where the console is running.

Managing HP Operations Manager Message Subscriptions

The Notification Server uses Velocity and XSLT templates to create HP 
Operations Manager messages before forwarding the message to the HP 
Operations Manager agent.

The HP Operations Manager agent then applies one or more templates to 
filter out unwanted messages and to make any additional changes to the HP 
Operations Manager message format.

Before configuring BPI to send events to HP Operations Manager, ensure that 
the HP Operations Manager Agent and Message Interface template are 
installed and set up on the system where the BPI Server, including the 
Notification Server are installed.

Complete the following steps to configure the Notification Server to send HP 
Operations Manager message notifications to the HP Operations Manager 
Agent for process impact, out-of-sequence or monitor instance threshold 
notification events: 

1. Make sure the Servlet Engine component is started using the BPI 
Administration Console, which is located on the system where the BPI 
Server is running.

2. On the system where Business Availability Center is running:

Select Admin > Business Process Insight

You are presented with a tabbed page that includes a tab for 
Notification.

3. Click the tab for Notification and you are presented with a page 
requesting you to select from Email Subscriptions, Script 
Subscriptions or HPOM Message Subscriptions.

4. Select HPOM Message Subscriptions.
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5. Click the New Subscription button.

You are presented with an HPOM Subscription Details screen where 
you can enter the subscription details for the HP Operations Manager 
messages.

6. From the New Event Subscription screen, select the Event Name and 
the Process Name for your new event subscription:

— Event Name

You can select to filter for Process Impacted events, Process 
Monitor Threshold events, Process Out Of Sequence events, or 
All events. If you select All, you receive HP Operations Manager 
impact violations for all BPI notification events.

— Process Name

You can select all process names to report on, or you can choose a 
specific process that you have defined. There is a drop down list 
provided, which lists all the deployed processes for you to select from, 
including the All option.

7. Click Next.

8. If you selected Process Monitor Threshold Violation Events, 
continue at step 10.

9. If you selected All, Process Impacted or Process Out Of Sequence as 
the Event name, you are prompted to select the Minimum Severity Level 
and the Template for your new subscription:

— Minimum Severity Level:

This is the minimum severity level for which you want to receive 
email notifications; for example, if you select Critical you will receive 
email notifications only for violations that are critical. If you select 
Minor, you receive email notifications for Minor, Warning, Major and 
Critical violations.

— Template:

Select the template that is appropriate to your Event Name, for 
example you might have created a custom template. If you have 
selected Process Impacted as the Event Name, choose the 
OVO-ProcessImpactDefault.vm template. If you have selected 
Process Monitor Threshold as the Event Name, choose the 
OVO-MonitorThresholdDefault.vm template. If you have selected 
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Process Out of Sequence, choose the template for the 
OVO-OutOfSequence.vm for the template. If you have selected All for 
the Event Name, choose the OVO-GenericDefault.vm template, as it 
provides the most detailed information.

10. If you selected Process Monitor Threshold Violation Events, you are 
prompted for the following information, in addition to that requested in 
step 9:

— Monitor Name

— Monitor Threshold Name

11. Click OK to commit the subscription to the Notification Server 
Administration database.

The new HP Operations Manager Message Subscription is now added to 
the list of HP Operations Manager Subscriptions.

You now have the option to:

• add another HP Operations Manager Message Subscription as described 
above.

• delete an entry in the HP Operations Manager Message Subscription list. 
To do this select the checkbox next the entry that you want to delete and 
then click the Delete button.

You can configure the template set used by HP Operations Manager and you 
can filter the events received through HP Operations Manager by customizing 
the HP Operations Manager Message Interface template. Details of how to do 
this are provided in the HP Operations Manager documentation.

If you create two subscriptions for the same HP Operations Manager 
message subscription, each with different templates, BPI uses the 
template from the more restrictive subscription to format the 
violation. For example, if you create a subscription for all process 
impact events using one template and a subscription for a specific 
process impact event using a different template; the template for the 
specific process impact event is the one used to format the violation.
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Managing Script Subscription

You can configure the Notification Server to run a script when it receives 
specific notification events. Section “Creating Script Files” on page 237 
describes how you can create these scripts and provides details of the 
variables that you can include in your scripts to report details of the violation 
as required.

This section describes how to configure the Notification Server to run the 
scripts for specific notifications that it processes for process impact, 
out-of-sequence or monitor instance threshold notification events: 

1. Make sure the Servlet Engine component is started using the BPI 
Administration Console, which is located on the system where the BPI 
Server is running.

2. On the system where Business Availability Center is running:

Select Admin > Business Process Insight

You are presented with a tabbed page that includes a tab for 
Notification.

3. Click the tab for Notification and you are presented with a page 
requesting you to select from Email Subscriptions, Script 
Subscriptions or HPOM Message Subscriptions.

4. Select Script Subscriptions.

5. Click the New Subscription button.

You are presented with a New Subscription screen where you can enter 
the subscription details for the script.
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6. From the New Script Subscription screen, enter the following details:

— Event Name

You can select to filter for Process Impacted events, Process 
Monitor Threshold events, Process Out Of Sequence events, or 
All events. If you select All, you receive HP Operations Manager 
impact violations for all BPI notification events.

— Process Name

You can select all process names to report on, or you can choose a 
specific process that you have defined. There is a drop down list 
provided, which lists all the deployed processes for you to select from, 
including the All option.

7. Click Next.

If there are no scripts defined, an the following error is displayed and you 
cannot continue:

No scripts currently available for selection.

Refer to section Creating Script Files on page 237 for details of creating 
scripts.

8. If you selected Process Monitor Threshold Violation Events, 
continue at step 10.

9. If you selected All, Process Impacted or Process Out Of Sequence as 
the Event name, you are prompted to select the Minimum Severity Level 
and the Template for your new subscription:

— Minimum Severity Level:

This is the minimum severity level for which you want to receive 
email notifications; for example, if you select Critical you will receive 
email notifications only for violations that are critical. If you select 
Minor, you receive email notifications for Minor, Warning, Major and 
Critical violations.

— Script Name

Select the script that you want the Notification Server to run when it 
received a notification event for the specified event and process. All 
the scripts that you have defined and saved in the notify-scripts 
are presented in the drop-down list for you to select from.
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10. If you selected Process Monitor Threshold Violation Events, you are 
prompted for the following information, in addition to that requested in 
step 9:

— Monitor Name

— Monitor Threshold Name

11. Click OK to commit the subscription to the administration database.

The new Script Subscription is added to the list of Script Message 
Subscriptions.

You now have the option to:

• add another New Script Subscription as described above.

• delete an entry in the Script Subscription list. To do this select the 
checkbox next the entry that you want to delete and then click the Delete 
button.

Creating Notification Server Templates

The Notification Server uses templates to format email messages and 
messages sent to HP Operations Manager. The templates contain instructions 
on how to format event information, for example, event name and event time. 
You might want customize an email template if you want to generate email 
messages for different locales. 

This section describes how BPI uses these templates and some guidance in 
how you can modify them. You need to be familiar with either XSLT, or 
Velocity to make the changes; XSLT is a standard for transforming XML 
documents. It is up to you which format you choose.

The Notification Server uses the Apache Velocity template engine to process 
Velocity templates. There is a user guide available with the template engine 
that provides details of creating and using Velocity templates. Details of 
Velocity templates, including a user guide for creating them, can be found at 
the following location:

http://jakarta.apache.org/velocity/

You configure the template used for each event when you create the event 
subscription through the Notification pages. The Notification Server then 
uses the template that you have defined to format all notifications related to 
the specified event. 
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Creating an Email Template

You create a custom email template for a specific event. These custom email 
templates must have a file name that starts with the string EMAIL- and a file 
extension of .vm for Velocity templates and .xsl for XSLT templates. 

The Notification Server reads the custom templates from the following 
directory:

• bpi-install-dir\data\conf\bia\notify-templates\flows

If you want to modify these templates, make a copy of the appropriate 
example template from the files in the following directory:

bpi-install-dir\examples\bia\NotifSvrTemplates

Make sure that you add your template to the correct directory as the 
Notification pages presents the templates in the context of the selection, 
based on the contents of the above directories. 

You also need to make sure that you copy the template from the examples 
directory to the data directory as the examples directory is updated and files 
replaced if you reinstall BPI.

The Notification Server uses an email template to create XML that describes 
an email. Then the notification server uses the XML to create an email. 

The email XML is very simple; it contains a subject, content type, and body. 
The actual schema is described in the file email.xsd, which is located at:

bpi-install-dir\misc\bia 

The Notification Server applies the Velocity or XSLT templates that you 
define to a violation from the Business Impact Engine. From this the 
Notification Server is able to create an email XML document based on your 
templates. 

Creating an HP Operations Manager Template

The Notification Server uses a template to create XML that describes the HP 
Operations Manager message. It then uses this XML to create an HP 
Operations Manager message. 

You configure the templates that are used to send HP Operations Manager 
messages through the Notification pages.
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Custom HP Operations Manager template files must start with the string 
OVO- and a file extension of .vm for Velocity templates and .xsl for XSLT 
templates. Store custom templates in the following directory:

bpi-install-dir\data\conf\bia\notify-templates\flows

The following is an example of an HP Operations Manager message XML 
document:

<?xml version="1.0" encoding="UTF-8"?>
<OVOMessage xmlns:xsi="http://www.w3.org/2001/XMLSchema
   instance"xsi:noNamespaceSchemaLocation="ovomessage.xsd" >
<Severity>critical</Severity>
<Application>HPBPI application</Application>
<Object>PROCESS_IMPACTED or PROCESS_OUT_OF_SEQUENCE</Object>
<MessageGroup>NOTIFICATIONS</MessageGroup>
<MessageText>A PROCESS_OUT_OF_SEQUENCE violation occurred at 
7.10pm.</MessageText>
<Option>example_option_variable_1=this is an example option 
value</Option>
<Option>example_option_variable_2=this is another example option 
value</Option>
</OVOMessage>

The example XML document contains an element for each message attribute:

• message severity

• application

• object

• message group

• message text

Optionally, the XML document, can contain message options. An option has 
the form variable=value. Refer to the VantagePoint Operations for Unix 
Administrator's Reference Volume I for more information about HP 
Operations Manager messages. The notification server applies Velocity and 
XSLT templates to an violation from the Business Impact Engine to create an 
HP Operations Manager message XML document.

The schema for the message is available at the following location:

bpi-install-dir\misc\bia\ovomessage.xsd
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Creating a Velocity Template

This section describes the list of the BPI notification methods that have been 
defined for use within your Velocity template. A variable in the Velocity 
context contains information from an Business Impact Engine event.

A Velocity template is a file that contains the XML describing an email or HP 
Operations Manager message.   

In addition to text, the file can contain Velocity formatting directives. The 
following is an example of an email Velocity template:

<?xml version="1.0" encoding="UTF-8"?>
<Email xmlns:xsi='http://www.w3.org/2001/XMLSchema-instance'
    xsi:noNamespaceSchemaLocation='email.xsd'>
<Subject>
$alert.getSeverity() $alert.getEventName() Alert
</Subject>
<ContentType>text/plain</ContentType>
<Body>
A "$alert.getEventName()" alert has occurred.

Severity: $alert.getSeverity()
Event Group: $alert.getEventGroup()
Event Name: $alert.getEventName()
Event Time: $alert.getEventTime()
Process Name: $alert.getFlowName()
Frocess Guid: $alert.getFlowGuid()
</Body>
</Email

A formatting directive starts with a hash (#) or a dollar ($); these formatting 
directives are described more fully in the Velocity Users’ Guide. A formatting 
directive is used to insert event information into the XML document. In the 
case of BPI this event information is provided through the alert variables.
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The $alert variable contains information from a Business Impact Engine 
event, for example, the service name for the event. The $alert variable 
contains methods such as getFlowName() and getServiceName(), which can 
be used to insert the event flow name and the event service name into the 
XML. (getServiceName() inserts the service name).

When the Notification Server generates an email notification message, it adds 
data to the message, where the display language is determined by the locale of 
the BPI Server. If your email recipients are not in the same locale as the BPI 
Server, you can use the Velocity templates to specify the locale for the 
language used for the email notifications. This enables you to provide email 
notifications in several languages if required.

The java Locale() class is used to identify the language string used within the 
alert methods. The definition for the Locale() class can be found at the 
following URL: 

http://java.sun.com/j2se/1.4.2/docs/api/java/util/Locale.html

The Locale() class takes a parameter comprising the language code and the 
country code as described in the definition for the Locale() class; for example: 
ko_KR for Korea and en_CA English-speaking Canadian.

If the Velocity templates that you create contain non-ASCII characters, you 
must encode and save the template as UTF8. This UTF8 needs to be created 
without a byte order mark (BOM). BOMs are added automatically by some 
Windows editors; for example, Notepad and Wordpad. Choose an editor that 
enables you to exclude the BOM.

If you include a BOM in your template encoding, it is not recognized as an 
XML file.
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Methods for All Violations

The following table lists the alert methods that can be used for all violations: 
Process Impact, Process Out-Of-Sequence, Business Monitor and Monitor 
instance threshold.

Table 40 Velocity Template Alert Methods for all Violations

Alert Method Name Alert Method Description

$alert.getVersion() Returns a STRING containing the version 
number for the BPI event.

$alert.getSeverity(locale) Returns a STRING containing the severity of the 
BPI event. Possible values are Critical, Major, 
Minor, Warning, and Normal. The language used 
for these values is determined by the locale for 
the BPI Server or, if specified, the locale of the 
country and language specified in locale, for 
example:

• $alert.getSeverity("ja"), for a Japanese locale
• $alert.getSeverity("ko"), for a Korean locale

The value returned is also used to determine the 
color of the text in the email notification.

$alert.getEventGroup() Returns a STRING containing the name of the 
event group for the BPI event, that is, 
NOTIFICATIONS.

$alert.getEventName() Returns a STRING containing the name of the 
BPI event, that is, PROCESS_IMPACTED, 
PROCESS_MONITOR_THRESHOLD_VIOLATION or 
PROCESS_OUT_OF_SEQUENCE

$alert.getEventTime(locale) Returns a STRING containing the time of the 
BPI event, formatted using the locale for the BPI 
Server or, if specified, the locale of the country 
and language specified in locale.

$alert.getEventDataListSize() Returns the number of event data items in the 
BPI event.
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Methods Specific to Process Impact Violations

The following table lists the alert methods that can be used for Process Impact 
violations. Using any of these methods for other violations results in a 
message containing erroneous data.

$alert.getEventDataNames() Returns an ARRAYLIST of the names of the 
event data items in the BPI event.

$alert.getEventDataByName
(Stringname, locale)

Returns a STRING containing the value of the 
data item with the given name using the locale 
for the BPI Server or, if specified, the locale of 
the country and language specified in locale.

$alert.getEventDataByIndex
(index, locale)

Returns a STRING containing the value of the 
data item located at the supplied index using the 
locale for the BPI Server or, if specified, the 
locale of the country and language specified in 
locale.

Table 41 Velocity Template Violation Methods for Process Impact 
Violations Only

Alert Method Name Alert Method Description

$alert.getFlowName() Returns a STRING containing the process name 
for the BPI event.

$alert.getFlowGuid() Returns a STRING containing GUID for the 
process definition in the BPI event.

$alert.getServiceName() Returns a STRING containing the name of the 
service for the BPI event.

$alert.getServiceGuid() Returns a STRING containing the service GUID 
for the BPI event.

$alert.getFlowNodeString() Returns a STRING containing step names for 
the BPI event. An example of a string returned 
by this method is: Bill Customer, Check Stock, 
Remove Item.

Table 40 Velocity Template Alert Methods for all Violations

Alert Method Name Alert Method Description
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$alert.getFlowNodeList() Returns an ARRAYLIST of step names in the 
BPI event. You can use the methods defined in 
the ArrayList class. For example, you can access 
the first element of an array list named 
flowNodeList using $flowNodeList.get(0)

$alert.getFlowNodeListSize() Returns the number of elements in the process 
step list in the BPI event.

$alert.getRootCause() Returns a STRING containing the labels of the 
root cause services in the BPI event. (Note that 
this string cannot be localized.) An example of a 
string returned by this method is: Oracle 
Financial System-&gt;Oracle System 
Europe-&gt;Network Resources

Table 41 Velocity Template Violation Methods for Process Impact 
Violations Only

Alert Method Name Alert Method Description
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$alert.getFlowNodeStatusList() Returns an ARRAYLIST of the status of the 
Steps in the BPI event. You can use the methods 
defined in the ArrayList class. For example, you 
can access the first element of an array list 
namesFlowNodeStatusList using 
$flowNodeStatusList.get(0).

$alert.getFlowNodeStatusString
(locale)

Returns a STRING containing the labels for the 
step status in the BPI event. For example, 
Critical, Major, Minor, Warning and Normal. 
These status correspond to the HP Operations 
Manager severity levels.

The language used for these values is 
determined by the locale for the BPI Server or, if 
specified, the locale of the country and language 
specified in locale, for example:

• $alert.getFlowNodeStatusString("ja"), for a 
Japanese locale

• $alert.getFlowNodeStatusString("ko"), for a 
Korean locale

$alert.getFlowNodeStatusList
Size()

Returns the number of elements in the process 
step status list in the BPI event.

Table 41 Velocity Template Violation Methods for Process Impact 
Violations Only

Alert Method Name Alert Method Description
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Methods Specific to Out-of-Sequence Violations

The following table lists the methods for out-of-sequence events only. Using 
any of these methods for other violations results in a message containing 
erroneous data.

Table 42 Velocity Template Methods for Out-of-Sequence Violations 
Only

Alert Method Name Alert Method Description

$alert.getFlowName() Returns a STRING containing the process name 
for the BPI event.

$alert.getFlowGuid() Returns a STRING containing GUID for the 
process definition in the BPI event.

$alert.getFlowInstanceGuid() Returns a STRING containing GUID for the 
process instance in the BPI event.

$alert.getSourceNode() Returns a STRING containing the name of the 
step that is the source step for the out-of 
sequence violation.

$alert.getDestinationNode() Returns a STRING containing the name of the 
step that is the destination step for the out-of 
sequence violation.

$alert.getFlowIdentifier() Returns a STRING containing the identifier for 
the impacted process instance.
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Methods Specific to Monitor and Instance Threshold Violations

The following table lists the monitor and instance threshold violation 
notification events only. Using any of these methods for other violations 
results in a message containing erroneous data.

Table 43 Velocity Template Methods for Monitor and Instance 
Threshold Violations Only

Alert Method Name Alert Method Description

$alert.getThresholdAlertGuid() Returns a STRING containing the internal 
unique identifier (GUID) of the instance 
threshold violation event raised for a specific 
instance threshold violation.

The following six methods are duration periods that correspond to the Threshold 
violation notification polling interval (seconds) as set in the 
Administration Console for Monitor Engine threshold violation 
notification settings.

It is called the actual period because it can differ from the requested configuration 
interval according to the other priorities that the machine, and the JVM, have at the 
times the requests to start and stop tracking are made.

getThresholdAlertNotification
PeriodDurationHours()

Returns a STRING containing the duration of 
actual notification period in terms of hours.

getThresholdAlertNotification
PeriodDurationHours(locale)

Returns a STRING containing the duration of 
actual notification period in terms of hours, 
using the locale for the BPI Server or, if 
specified, the locale of the country and language 
specified in locale.

getThresholdAlertNotification
PeriodDurationMinutes()

Returns a STRING containing the duration of 
actual notification period in terms of minutes.

getThresholdAlertNotification
PeriodDurationMinutes(locale)

Returns a STRING containing the duration of 
actual notification period in terms of minutes, 
using the locale for the BPI Server or, if 
specified, the locale of the country and language 
specified in locale.

getThresholdAlertNotification
PeriodDurationSeconds()

Returns a STRING containing the duration of 
actual notification period in terms of seconds.
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getThresholdAlertNotification
PeriodDurationSeconds(locale)

Returns a STRING containing the duration of 
actual notification period in terms of seconds, 
using the locale for the BPI Server or, if 
specified, the locale of the country and language 
specified in locale.

$alert.getThresholdAlert
NotificationPeriodStart()

Returns a STRING containing the start time of 
the Threshold violation notification 
period. Start time is the time from and including 
the time specified.

$alert.getThresholdAlert
NotificationPeriodEnd()

Returns a STRING containing the end time of 
the Threshold violation notification 
period. End time is the time up to but not 
including the time specified.

$alert.getThresholdAlertStatus
ChangeTime()

Returns a STRING containing the time that the 
Metric_Fact_Alerts table was updated with 
the instance threshold alert notification.

$alert.getThresholdAlertRaised
Time()

Returns a STRING containing the time that the 
event notification was sent to the Notification 
Server.

$alert.getThresholdGuid() Returns a STRING containing the internal 
unique identifier (GUID) for the monitor 
instance threshold defined for the Business 
Process monitor in the BPI event.

$alert.getThresholdMessage() Returns a STRING containing the monitor 
instance threshold message in the BPI event.

This is the message that you have defined to be 
displayed when the event is triggered. 

$alert.getThresholdName() Returns a STRING containing monitor instance 
threshold name in the BPI event.

Table 43 Velocity Template Methods for Monitor and Instance 
Threshold Violations Only

Alert Method Name Alert Method Description
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$alert.getThresholdNumber
NotificationsInPeriod()

Returns a STRING containing the total number 
of notifications sent for the instance threshold in 
the Threshold violation notification 
polling interval. 

$alert.getThresholdNumber
AlertsInPeriod()

Returns a STRING containing the total number 
of instance threshold violations generated for the 
instance threshold in the Threshold violation 
notification polling interval.
The number of instance threshold violations 
generated might be different to the number of 
notifications sent, depending on how you have 
configured the instance threshold violation 
notification settings.

$alert.getThresholdNumber
NormalAlertsInPeriod()

Returns a STRING containing the total number 
of Normal instance threshold violations 
generated for the instance threshold in the 
Threshold violation notification polling 
interval.
This number is a subset of getThresholdNumber
AlertsInPeriod().

$alert.getThresholdNumber
WarningAlertsInPeriod()

Returns a STRING containing the total number 
of Warning instance threshold violations 
generated for the instance threshold in the 
Threshold violation notification polling 
interval.
This number is a subset of getThresholdNumber
AlertsInPeriod().

$alert.getThresholdNumber
MinorAlertsInPeriod()

Returns a STRING containing the total number 
of Minor instance threshold violations generated 
for the instance threshold in the Threshold 
violation notification polling interval.
This number is a subset of getThresholdNumber
AlertsInPeriod().

Table 43 Velocity Template Methods for Monitor and Instance 
Threshold Violations Only

Alert Method Name Alert Method Description
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$alert.getThresholdNumber
MajorAlertsInPeriod()

Returns a STRING containing the total number 
of Major instance threshold violations generated 
for the instance threshold in the Threshold 
violation notification polling interval.
This number is a subset of getThresholdNumber
AlertsInPeriod().

$alert.getThresholdNumber
CriticalAlertsInPeriod()

Returns a STRING containing the total number 
of Critical instance threshold violations 
generated for the instance threshold in the 
Threshold violation notification polling 
interval.
This number is a subset of getThresholdNumber
AlertsInPeriod().

$alert.getFlowMetricGuid() Returns a STRING containing the Business 
Process monitor GUID in the BPI event.

$alert.getFlowMetricName() Returns a STRING containing the Business 
Process monitor name in the BPI event.

$alert.getFlowMetricValue() Returns a STRING containing the Business 
Process monitor value in the BPI event.

Table 43 Velocity Template Methods for Monitor and Instance 
Threshold Violations Only

Alert Method Name Alert Method Description
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XSLT Templates

An XSLT template is a file containing XML that transforms event XML into 
email or HP Operations Manager message XML. An example of an email 
XSLT template is shown below.

<?xml version="1.0" encoding="UTF-8"?>
<xsl:stylesheet xmlns:xsl="http://www.w3.org/1999/XSL/Transform" 
version="1.0"
        xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
        xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
        xmlns:etype="http://www.hp.com/openview/bia/eventtype"
        xmlns:edata="http://www.hp.com/openview/bia/eventdata">
  <xsl:output method="xml"
       indent="no" />

<xsl:template match="/">
<Email xsi:noNamespaceSchemaLocation='email.xsd'>
<Subject>
<xsl:apply-templates select="//env:Body/*/etype:Severity/*"/><xsl:text> </
xsl:text><xsl:value-of select="//etype:EventName" /> Alert</Subject>
<ContentType>text/plain</ContentType>
<Body>
A "<xsl:value-of select="//etype:EventName" />" alert has occurred.

Severity: <xsl:apply-templates select="//env:Body/*/etype:Severity/*"/>
Event Group: <xsl:value-of select="//etype:EventGroup" />
Event Name: <xsl:value-of select="//etype:EventName" />
Event Time: <xsl:value-of select="//etype:EventTime" /><xsl:text>
</xsl:text>
<xsl:for-each select="//edata:DataItem" >
<xsl:choose>
<xsl:when test="edata:Name = 'RootCause'" >
<xsl:text>Root Cause: </xsl:text>
<xsl:for-each select="//edata:Value/Services/Service" >
<xsl:text>-&gt;</xsl:text><xsl:value-of select="Label" />
</xsl:for-each>
</xsl:when>
<xsl:otherwise>
<xsl:value-of select="edata:Name" /><xsl:text>: </xsl:text><xsl:value-of 
select="edata:Value" />
</xsl:otherwise>
</xsl:choose>
<xsl:text>
</xsl:text>
</xsl:for-each>
</Body>
</Email>
</xsl:template>
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<xsl:template match="etype:Critical" >
<xsl:text>Critical</xsl:text>
</xsl:template>

<xsl:template match="etype:Major" >
<xsl:text>Major</xsl:text>
</xsl:template>

<xsl:template match="etype:Minor" >
<xsl:text>Minor</xsl:text>
</xsl:template>

<xsl:template match="etype:Warning" >
<xsl:text>Warning</xsl:text>
</xsl:template>

<xsl:template match="etype:Normal" >
<xsl:text>Normal</xsl:text>
</xsl:template>

</xsl:stylesheet>

The style sheet is applied to the event sent by the Business Impact Engine. 
The style sheet contains email XML text as well as XSL elements. XSL 
elements format information from the form of the event and insert it into the 
email XML. 

The schemas for the event are located in the files eventtype.xsd and 
eventdata.xsd in the following directory:

bpi-install-dir/misc/bia

The message header contains a business event type, which is described in 
eventtype.xsd. The message body contains a business event type followed by 
business event data; Business event data is described in eventdata.xsd.

Creating Script Files

You can define a script, which is a Windows .bat file, to be run when a 
notification event is received by the Notification Server; for example, this 
script might send an SMS message to a recipient directly (bypassing the email 
server), or it might update an entry in a database or spreadsheet.
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You can create a script to complete any action that you want, and you can also 
include any of the environment variables that have been defined for use 
within your scripts. These environment variables identify configuration 
information relating to the BPI data available for notifications and are 
defined in section “Environment Variables for Scripts” on page 240.

These environment variables are included in your scripts using the following 
notation:

%env_name%

where %env_name% is an environment variable name, for example, 
%OVBPI_FLOWNAME%.

The following examples show how you can create a script and configure the 
Notification Server to run the script when a specific notification event is 
received.

Example Script to Write a String to a File

The following is an example of the steps that you need to complete in order to 
configure the Notification Server to write the string Hello World to a file on 
receipt of a specific process impact event:

1. Create the script that you want to be executed when the notification event 
is received, for example:

echo "hello world" >>c:\notif.txt

This script writes the string "hello world" to the file notif.txt in the 
root of your c: drive.

2. Save the script to the following location with a unique file name and a 
.bat file extension:

bpi-install-dir/data/conf/bia/notify-scripts

The Notification Server looks in this directory for scripts and presents 
these scripts to your through the Web Administration Console for the 
Notification Server when you are configuring subscriptions. Note that if 
the script that you create does not have a .bat file extension, it is ignored.

3. Follow the instructions in section “Managing Script Subscription” on 
page 220 to create a subscription for the script selecting Process 
Impacted as the Event Name and the name of the process for the Process 
Name.
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If you have the Web Administration for the Notification Server 
administration open at the New Event Subscription page, you might 
need to click the Refresh option on your Web Browser. This refreshes the 
page and adds the new script to the list.

Example Script to Write Process Name and Blocked Instances to a File

The following is an example of the steps that you need to complete in order to 
configure the Notification Server to take the process name and the number of 
blocked instances from the event data and write the information to a file on 
receipt of a specific process impact event:

1. Create the script that you want to be executed when the notification event 
is received, for example:

echo %OVBPI_FLOWNAME%, 
%OVBPI_NOOFBLOCKEDINSTANCES%>>c:\notif2.txt

This script writes the values of the process name and the number of 
blocked instances to the file notif2.txt in the root of your c: drive.

2. Save the script to the following location with a unique filename:

bpi-install-dir/data/conf/bia/notify-scripts

The Notification Server looks in this directory for scripts and presents 
these scripts to your through the Web Administration Console for the 
Notification Server when you are configuring subscriptions.

3. Follow the instructions in section “Managing Script Subscription” on 
page 220 to create a subscription for the script selecting Process 
Impacted as the Event Name and the name of the process for the Process 
Name.

If you have the Web Administration for the Notification Server 
administration open at the New Event Subscription page, you might 
need to click the Refresh option on your Web Browser. This refreshes the 
page and adds the new script to the list.
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Environment Variables for Scripts

The following tables list the environment variables that can be used within 
your scripts to report data on process impact, process out-of-sequence and 
monitor instance threshold violations.

Table 44 on page 240 lists the environment variables that are available for all 
BPI violations.

Table 45 on page 240 lists the environment variables available for process 
impact violations. Using these environment variables for other alerts results 
in erroneous data being returned.

Table 44 Environment Variables for All Violations

Variable Description

OVBPI_EVENTGROUP name of the event group, which is always 
NOTIFICATIONS.

OVBPI_EVENTNAME name of the event: PROCESS_IMPACTED, 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
or PROCESS_OUT_OF_SEQUENCE.

OVBPI_SEVERITY severity of the BPI event. Possible values 
are Normal, Warning, Minor, Major or 
Critical

Table 45 Environment Variables for Process Impact Violations

Variable Description

OVBPI_FLOWGUID internal unique identifier (GUID) for the 
process definition in the BPI event.

OVBPI_FLOWNAME name of the process in the BPI event

OVBPI_NOOFBLOCKEDINSTANCES number of blocked process instances at 
the time of the PROCESS_IMPACTED event. 
A blocked instance is an instance of the 
process that is active at a step and cannot 
proceed as there is a problem in an 
underlying operational service.
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OVBPI_NOOFIMPEDEDINSTANCES number of at risk process instances at 
the time of the PROCESS_IMPACTED event. 
An at risk instance is where one or more 
process instance has the potential to be 
blocked in the future.

OVBPI_SERVICEGUID internal unique identifier (GUID) for the 
service in the BPI PROCESS_IMPACTED 
event.

OVBPI_SERVICENAME name for the service in the BPI 
PROCESS_IMPACTED event.

OVBPI_ROOTCAUSE the label of the root cause service, or 
services, in the BPI PROCESS_IMPACTED 
event.

Table 45 Environment Variables for Process Impact Violations

Variable Description
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Table 46 on page 242 lists the environment variables available for instance 
threshold violations. Using these environment variables for other violations 
results in erroneous data being returned.

Table 46 Environment Variables for Instance Threshold Violations

Variable Description

OVBPI_FLOWGUID internal unique identifier (GUID) for the 
process definition in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event.

OVBPI_FLOWIDENTIFIER identifier for the process instance in the 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event. This property contains a value only 
if the instance threshold violation is an 
instance violation, for example, Absolute 
duration. It does not contain a value if the 
property is for a statistical violations, for 
example, a Backlog count. This the 
property that you have nominated to be the 
identifier for the processe.

OVBPI_FLOWINSTANCEGUID internal unique identifier (GUID) for the 
process instance in the 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event. This property contains a value only 
if the instance threshold violation is an 
instance violation, for example, Absolute 
duration. It does not contain a value if the 
property is for a statistical violations, for 
example, a Backlog count. 

OVBPI_FLOWMETRICGUID internal unique identifier (GUID) for the 
process monitor in the 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event.

OVBPI_FLOWMETRICNAME name of the process monitor in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event. 
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OVBPI_FLOWMETRICVALUE value of the process monitor in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event.

OVBPI_FLOWNAME name of the process in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event

OVBPI_THRESHOLDALERTGUID internal unique identifier of the instance 
threshold identified in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event.

OVBPI_THRESHOLDMESSAGE message defined for the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event. This is the message that you have 
defined to be displayed when the event is 
triggered.

OVBPI_THRESHOLDNAME name of the monitor instance threshold in 
the 
PROCESS_MONITOR_THRESHOLD_VIOLATION 
event.

Table 46 Environment Variables for Instance Threshold Violations

Variable Description
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Table 47 on page 244 lists the environment variables for the Out-of-Sequence 
violations. Using these environment variables for other violations results in 
erroneous data being returned.

Table 47 Environment Variables for Out-of-Sequence Violations

Variable Description

OVBPI_FLOWIDENTIFIER identifier for the process instance in the 
BPI event. This the property that you 
have nominated to be the identifier for 
the process.

OVBPI_FLOWINSTANCEGUID internal unique identifier (GUID) for the 
process instance in the BPI event. 

OVBPI_SOURCENODE name of the step that is the source step 
for the out-of-sequence violation.

OVBPI_DESTINATIONNODE name of the step that is the destination 
step for the out-of-sequence violation.
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9 BPI Application Concepts
The BPI Application provides the interface that enables you to track all the 
Business Processes, Business Process Monitors and Monitor Thresholds that 
you have defined and deployed, including their associated data. You can also 
track the status of the IT operational resources that the Business Process 
relies on.

The BPI Application can be accessed from the following menu option:

Applications > Business Process Insight

This chapter provides an overview of the key features of the BPI Application 
pages and explains how to use the application to track and monitor your 
Business Processes. Following chapters describe the content of the application 
in more detail. 

The chapter covers the following topics:

• Overview of the BPI Application on page 246

• Key Elements of Business Process Insight Application on page 247
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Overview of the BPI Application

The BPI Application enables you to monitor and track your Business 
Processes. It is the interface that you use to view the overall status of your 
Business Processes and Business Process monitors, including any links that 
you might have to IT operational resources. 

The BPI Application provides:

• an overall view of the health and status of the Business Processes that 
you have deployed in your BPI system, including the status of any 
Business Process monitors.

• an overall view of the status of the IT operational resources that you have 
linked your Business Process Steps to.

• details of the individual process instances and their progression through 
the steps in the process.

• details of the active process instances at individual steps in the process.

• details of any thresholds that have been violated.

• details of the transactions that you have linked your Business Process 
Steps to within TransactionVision.

• graphical representation of your monitor data, which can be displayed in 
terms of times, where appropriate.

• a view of the aggregated Monitor data, which can include minimums, 
maximums and standard deviations.

• ability to configure the types of graphs and the period over which the 
monitor data should be presented.

• ability to search for specific process instances.

The Business Process Insight Application pages are available and data 
available only when you have installed the BPI Server and configured the 
Server to send data samples to the Gateway Server.
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Key Elements of Business Process Insight Application

There are three options provided for the BPI Application that enable you to 
track and monitor your Business Processes. These options are in addition to 
the Flow Map, which is available from the Application > Dashboard menu.

• Scorecard

Provides a report-style view of all the Business Processes that are 
currently selected to be monitored. The view is presented in terms of the 
current values of the KPIs configured for the Scorecard; see Chapter 10, 
BPI Application Scorecard. 

The monitor Value is based on the Process Value property of the Business 
Process. The Process Value is assigned when you create the Business 
Process in the Modeler.

• Health

Provides a graphical view of a selected Business Process in the form of the 
process diagram. The process diagram is annotated with information 
relating to the health and Business Process Monitor details of the overall 
Business Process in both business and operational terms, and the 
individual Steps in the process.

In addition, there are links to more details of the various components of 
your Business Process; see Chapter 11, BPI Application Health.

• Reports

Provides report data for Business Processes and Business Process steps. 
The following reports are available for the BPI Application:

— BPI Process Summary

— BPI Monitors Over Time

— Business Process Step Summary

The Reports are described in section Chapter 12, BPI Application Reports.

In addition, you can customize your Business Process diagrams and define 
annotations specific to your processes. Some level of annotation is provided by 
default; however, you can modify the form of these annotations for your 
Process Diagrams. These customizations are described in Chapter 13, 
Annotations for Process Diagrams.
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10 BPI Application Scorecard
This chapter provides an overview of the key features of the BPI Application 
Scorecard pages and explains how to use the Scorecard pages to provide 
summary information for your Business Processes. 

The Scorecard presents a type of report and enables you to display the real 
time status, trend, and changes-over-time data for the selected BPI Business 
Processes and Business Process Steps. These are organized by best and worst 
statuses.

This chapter covers the following topics:

• Common Header on page 252

• Results Area on page 254

• Understanding KPI Statuses on page 257

• How the Scorecard Builds its Display on page 258
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Figure 17 is an example of the BPI Scorecard

Figure 17 Scorecard.

The Scorecard is divided into the following areas:

• The common header, which enables you to tailor the content of the main 
body of the page; see section Common Header on page 252.

• The main body of the page, where the selected Business Process data is 
presented; see section Results Area on page 254.
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Figure 18 shows these areas of the Scorecard.

Figure 18 Scorecard Structure

Common Header Area

Results Area
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Common Header

Table 48 General Information

Description Enables you to select the criteria that you 
want to use for presenting Scorecard results. 

To access: Select Applications > 
Business Process Insight > Scorecard

Important Information The Scorecard sorts and displays the ordered 
Business Processes and their KPIs statuses 
for the selected time period; for details, see 
section “How the Scorecard Builds its 
Display” on page 258. 
The Scorecard page is available only when 
you have configured the Business Process 
Insight Server to be integrated with BAC 
and configured to send data samples and 
configured a Profile database.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Table 49 GUI Elements

GUI Element (A-Z) Description

<Common report
settings>

For details see section Common Report 
Elements in Reports.

Business Processes Click to open the Business Processes 
dialog where you can select the Business 
Process that you want to display. 
If one Business Process is selected, its name 
is displayed to the right of the link. If more 
than one Business Process is selected, (n/m) 
Filtered is displayed to the right of the link, 
where n represents the number of selected 
Business Processes and m represents the 
total available for selection.

KPIs Enables you to select the KPIs that you want 
to display on the filtered results area for 
each Business Process. All KPIs that have 
been configured for the Business Process CI 
and any child CIs are available for selection. 
Select one or more KPIs and click OK. 
If more than one KPI is selected, (n/m) 
Filtered is displayed to the right of the link, 
where n represents the number of selected 
KPIs and m represents the total available for 
selection

View Enables you to select the viewing period used 
for the over-time bar in the results area. 
Select the viewing period from the 
drop-down selection box and click the Apply 
button to apply the changes to the page.
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Results Area

This part of the Scorecard shows the results of the selections made from the 
Common Area; see section Common Header on page 252.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Table 50 General Information

Description Enables you to display the real time status, 
trend, and over time data of the Business 
Process. The results are organized by worst 
to best statuses.

To access: Select Applications > 
Business Process Insight > Scorecard

Important Information The Scorecard page is available only when 
you have configured the Business Process 
Insight Server to be integrated with BAC 
and configured to send data samples.
The Scorecard page sorts and displays the 
ordered Business Processes and their KPIs 
statuses for the selected time period; for 
details, see section “How the Scorecard 
Builds its Display” on page 258. 

Table 51 GUI Elements

GUI Element (A-Z) Description

Click the button to the right of the Business 
Process to display the available menu 
options. The context menu options are 
described in the Using Dashboard Help.

<Business Process Name> The name of the Business Process.
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<Over-time bar> Displays an over-time line, which comprises 
a colored band representing the KPI status 
results over the selected time; each color 
represents a specific KPI status. 
The width of the colored bands corresponds 
to the length of time the KPI is in a 
particular status. The most recent status in 
the time bar is on the right 
Example:

KPI The name of the KPI for the Business 
Process. The column lists the KPIs that were 
selected in the KPIs dialog box for the 
Scorecard.

Status Indicates the status of the KPI. For details 
on the statuses, see Understanding KPI 
Statuses on page 257.
Tooltip: Provides the value of the status, 
and indicated when the status was changed 
to the current value.

Trend Indicates the trend of the KPI as compared 
to its previous state. 
For details on the trend information refer to 
the Dashboard Application documentation.
Tooltip: Provides the description of the 
trend.

Table 51 GUI Elements
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All the data sample information sent by the BPI Server is displayed using the 
following KPIs:

• Backlog

• Business Health

• Business Impact

• Duration

• Value

• Volume
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Understanding KPI Statuses

A full description of KPI statuses can be found in the section Understanding 
KPI Statuses in the Using Dashboard Help.

When a KPI is not relevant to the Business Process, the Status column 
displays [NA], the Trend column is empty, and the over time bar does not 
exist. 

When a KPI is relevant for the Business Process but has a No Data status, the 
Status column displays a grey icon, the Trend column is empty, and the 
relevant part of the over time bar is grey. 

When the Business Processes are listed in one column only, the KPIs that are 
not relevant for the Business Process are not displayed and each table 
includes as many rows of KPIs as needed.
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How the Scorecard Builds its Display

The Scorecard pages sort and display selected Business Processes and their 
KPI’s statuses from worst to best. The sorting mechanism compares the 
selected Business Process CIs in pairs as shown in Figure 19.

Figure 19 Scorecard Sorting Process
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If a pair of Business Process CIs have the same number of KPIs with a specific 
status, the sorting mechanism compares the number of KPIs with the next 
better status using the critical, major, minor and warning statuses in this 
order. The Business Process with the highest number of those KPIs is then 
given a lower grade than the other Business Processes. 

If a pair of Business Process CIs have the same number of warning KPIs, then 
the mechanism compares the number of KPIs with OK status. The CI with the 
highest number of KPIs with the OK status is given a higher grade than the 
other CI. The same sorting is used for the Info status. 

KPIs without data are not used in the comparison.

If a pair of Business Process CIs have exactly the same numbers of KPIs at 
each status level, the page sorts the CIs alphabetically (from A to Z) and the 
first CI in the alphabetical list, is given the lower grade.

Splitting Mechanism

When all Business Process CIs have a grade, the CIs are sorted into the Worst 
and Best columns. If you select four or more Business Process CIs, the 
Scorecard page is divided into two columns where:

• The Worst column displays the worst half of the CIs (lower grades) 
ordered from worst (first row) to best (last row).

• The Best column displays the best half of the CIs (higher grades) ordered 
from best (first row) to worst (last row).

Business Process CIs with no data KPIs always appear at the bottom of each 
Worst/Best column. The splitting mechanism removes them from the list 
before it lists the other CIs in the proper order and distributes these CIs 
between the Worst and Best columns. The CIs with no data KPIs are then 
sorted in alphabetical order and distributed between the Worst and Best 
columns and put at the bottom of each column.

The Worst column includes one more Business Process CI if you select an odd 
number of CIs

A single column displays the Business Process CIs ordered from worst to best 
from top to bottom when you select less than four CIs.
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11 BPI Application Health
This chapter describes the BPI Application Health pages and explains how to 
navigate and use the them to track and monitor the health of your Business 
Processes. 

The Health pages show the operational and business health of the Business 
Processes that you have defined using the BPI Modeler. The Health pages also 
include data on the Business Monitors, Thresholds and KPIs that you have 
defined for the Business Processes.

The Health pages provides:

• a graphical representation of a selected Business Process, in the form of 
the process diagram. The process diagram is annotated with information 
relating to the health of the overall Business Process and the individual 
Steps in the process.

• Business Process or Business Process Step summary information 
according to the selection criteria. This shows the overall business health 
of the Business Process or Business Process Step, in tabular and in 
graphical form. You can drill down and view related BPI reports if 
required.

• details of the business objective KPI that you have defined for the selected 
Business Process or Business Process Step.

• dials that show the status of the Monitor Thresholds for a selected 
Business Process. You can drill down for more detailed information 
relating to the Monitor, Monitor Instance Threshold or Process Instance if 
required. 

• instance violation counts for the selected Business Process or Business 
Process Step.

• the ability you to view the status of the IT operational resources that are 
linked to Steps in the Business Process.
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• a list of the related transaction CIs and KPIs for the selected Business 
Process or Business Process Step. You can drill down to the 
TransactionVision Aggregated Topology Report if required. 

If there are no TransactionVision CIs linked to the Business Process that 
you are viewing, no data is available from this option 

The following are the different components of the Health Page:

• Process Diagram Area on page 265

You can collapse and expand the Process Diagram if you want to provide 
more space for the information shown on the tabbed areas under the 
diagram.

• Summary Tab on page 272

The Summary Tab displays process instance information and the 
Scorecard over time graph for the selected Business Process.

From the Summary Tab you can link to additional pages, which enable 
access to details of Instances; see section Instances Dialog on page 280

• Business Health Tab on page 276

The Business Health Tab displays KPI details in the form of a dial and 
instance violation details in the form of a table. 

From the Business Health Tab, you can link to additional pages, which 
enable access to details of:

— Violations; see section Instance Violations Dialog on page 292.

— Monitor details; see section Monitor Dialog on page 295.

— BPI Monitors Over Time Report; see section BPI Monitors Over Time 
on page 325.

— Process Over Time Report; see section Business Process Over Time 
Report on page 334.

— Step Over Time Report; see section Business Process Step Over Time 
Report on page 337.

• Transactions Tab on page 279

From the Transactions Tab, you can link to pages with TransactionVision, 
which provide more details of the selected Transaction Event.
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Figure 20 is an example of the BPI Application Health page

Figure 20 Health Page

Figure 20 shows the top-level Health Page for the Business Process Insight 
Application.

The Health Page is subdivided into different areas of focus, but at the 
top-level it provides an overall view of both the business and operational 
health of your deployed Business Processes.
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To access the Health Page select:

Applications > Business Process Insight > Health

The Health Page tab is divided into the following areas, each of which 
provides more detailed information:

• Process Diagram; see Process Diagram Area on page 265

• Process Summary information; see Summary Tab on page 272

• Business Health information; see Business Health Tab on page 276

• Transaction information see section Transactions Tab on page 279

The Health page is available only when you have configured the Business 
Process Insight Server to be integrated with BAC and configured to send 
data samples; see Chapter 3, Enhancing BAC with Process Instance 
Monitors for details of the integration with BAC.
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Process Diagram Area

Figure 21 shows the Process Diagram area on the Health Page.

Figure 21  Process Diagram Area

The Process Diagram shows the components and structure of the Business 
Process when created using the Modeler.

This enables you to visualize the Business Process, which includes the Step 
annotations to indicate how many process instances are active at a particular 
step and the process values.

When displayed in the Process Diagram page, the Business Process layout is 
the same as when created in the Modeler.
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The data displayed on the Health page changes according to whether you 
select:

• the whole process; in this case. the data relates to all the instances for all 
the Steps in the process.

• a specific process Step; in this case, the data relates to all the instances for 
the selected Step.

Click a specific Step to obtain data for the Step. Click anywhere in the process 
diagram area, but not another Step, to deselect it and move to a whole process 
view.

Table 52 describes the elements of the Process Diagram Area (unlabeled GUI 
elements are shown in angle brackets):

Table 52 Process Diagram

GUI Element (A-Z) Description

Selected Business Process Click to open a drop-down list where you can 
select a different Business Process that you 
want to display on the Health page.

Business Health Status Overall Business Health of the Business 
Process. The worst case status is presented 
here.

Operational Status Overall IT operational resource status for 
the Business Process. The worst case status 
is presented here.
This is the IT operational resource status as 
it is known to BPI.

Last Update The date and time the data presented on the 
Health page was last updated.
Note: If you have configured a delay for 
sending data samples to BAC, the data 
presented is not for Last Update time, but for 
the Last Update time adjusted by the delay 
you have configured; refer to section “Data 
Sample Settings” on page 133 for more 
information.
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Click this icon to collapse and expand the 
pane where the Process Diagram is located. 
This allows more room for the tabbed areas 
below the diagram.
The arrows point upwards when the process 
diagram is displayed.

This and the icon that follows enable you to 
toggle between a fit-to-pane view and a 
normal view.
Click this icon to stretch or shrink the 
Process Diagram such that it fits within the 
available space.

This and the icon above enables you to toggle 
between a fit-to-pane view and a normal 
view.
Click this icon to revert the Process Diagram 
to the size it was when defined within the 
Modeler

This icon is the Step that represents a 
normal starting point for a process.
Note: A visual representation of the health 
of the Business Process with respect the IT 
operational resources on which it depends. 
The health of each Step is shown as an icon 
overlay. Step Overlay on page 270 describes 
these overlays and their meaning.
Customization: You can customize the Step 
graphic as described in Chapter 13, 
Annotations for Process Diagrams.

Table 52 Process Diagram
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This icon is the Step that represents an 
activity within your Business Process, for 
example, a check for account details.
Note: A visual representation of the health 
of the Business Process with respect the IT 
operational resources on which it depends is 
shown in terms of an icon overlay. Step 
Overlay on page 270 describes these overlays 
and their meaning.
Customization: You can customize the Step 
graphic as described in Chapter 13, 
Annotations for Process Diagrams.

This icon is the Step that represents a 
normal end point for a process.
Note: A visual representation of the health 
of the Business Process with respect the IT 
operational resources on which it depends is 
shown in terms of an icon overlay. Step 
Overlay on page 270 describes these overlays 
and their meaning.
Customization: You can customize the Step 
graphic as described in Chapter 13, 
Annotations for Process Diagrams.

This icon represents a junction point within 
your Business Process and is a visual Step 
and is used to help define the structure of the 
Business Process. 
It shows the start and end point of a 
structural element in the process and has no 
IT operational resource status or count and 
value information associated with it.

Table 52 Process Diagram
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<Normal Arc> Process Steps are linked using Arcs, which 
are dotted lines that join Steps. The Arc 
shows the direction of the flow in the 
Business Process; they do not imply any 
sequence or processing order, but they do 
imply an expected order. Arcs are not 
enforced; however, they are used when 
determining the business impact status of 
the process. 
If you want to know when the Steps in your 
process are executed in an unexpected order, 
use a Sequence Arc.

<Sequence Arc> A Sequence Arc is a solid line and is a 
notification that the Steps, which are 
connected by the arc, are not being activated 
in the correct order. The connect order is 
determined by the direction of the arc 
between the steps. 

<Step overlay> A visual representation of the health of the 
Business Process with respect the IT 
operational resources on which it depends. 
The health of each Step is shown as an icon 
overlay.
The Step overlay provides additional 
information to show the health of the of the 
selected Business Process with respect to the 
IT operational resources on which the 
process depends; see section Step Overlay on 
page 270 for more information about the 
meanings of the overlays.

<Text below the Step icon> This is the name of the Step as entered in the 
BPI Modeler when the process was created; 
for example: Confirm Identity.

Table 52 Process Diagram
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Step Overlay

The Step Overlays provide additional information on the Process Diagram to 
show the health of the Business Process.This is the health of the Business 
Process in terms of the IT infrastructure of the underlying systems on which 
the individual Business Process Steps are linked. The IT infrastructure is 
linked to the Steps in your Business Process when you model the process 
using the BPI Modeler.

The overlays are presented as visual representations and are shown in terms 
of an icon overlay on the Step of the Business Process. 

<Text in upper left-hand 
corner of Step icon>

In the case of an Activity Step, this 
represents the total Business Process value 
of all the instances that are currently active 
at that Step.
In the case of an End Step, this represents 
the total value of all the instances that have 
completed at that Step.
If the locale for the system is set, a currency 
symbol appears with the text for values that 
are currencies.
Customization: You can customize this text 
as described in Chapter 13, Annotations for 
Process Diagrams.

<Text in upper right-hand 
corner of Step icon>

This is the count of the number of instances 
that are currently active at the Step. The 
End Step shows the total of the completed 
instances for the business; this is the total of 
all instances since the process was deployed 
in the Modeler or the counts were reset. 
If the locale for the system is set correctly, 
the count is displayed in a locale-sensitive 
format.
Customization: You can customize this text 
as described in Chapter 13, Annotations for 
Process Diagrams.

Table 52 Process Diagram
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The diagram displays the operational status as an overlay on a Step if the 
status is OK or above.

Table 53 describes the overlays in more detail (unlabeled GUI elements are 
shown in angle brackets):

Table 53 Icon Overlays

GUI Element (A-Z) Description

A system health status of OK. All the system 
KPIs fell within their configured settings.

A system health status of Warning. The 
worst status of any system KPI, for a 
dependent CI, was reported as a warning 
(using the worst-child rule).

A system health status of Minor. The worst 
status of any system KPI, for a dependent 
CI, was reported as minor (using the 
worst-child rule).

A system health status of Major. The worst 
status of any system KPI, for a dependent 
CI, was reported as major (using the 
worst-child rule).

A system health status of Critical. The 
worst status of any system KPI, for a 
dependent CI, was reported as critical (using 
the worst-child rule).

The system health status is No Data. This 
means there is insufficient data to make a 
decision on the system health status.
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Summary Tab

Figure 22 is an example of the Summary Tab on the Health Page.

Figure 22 Summary Tab

The Summary Tab shows business and operational summary information 
relating to either the selected Business Process (Table 54), or the selected 
Process Step (Table 55).

If you select a Business Process, you can then select specific categories of 
process instances; for example, blocked instances. You are then moved to the 
Instances Details page, where the list of instances is filtered to show only 
those process instances that are blocked. 

Table 54 describes the elements presented on the Summary Tab when the 
Business Process is selected; that is, you have not selected a specific Step in 
the Business Process (unlabeled GUI elements are shown in angle brackets):

Table 54 Summary Tab for a Business Process

GUI Element (A-Z) Description

<Name> The name of Business Process is shown in 
the title bar of the tabs area and is the name 
of the Business Process as entered using the 
Modeler.

Description Content of description field entered using 
Modeler. If no description is provided, [NA] is 
displayed as a value.
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Business Impact Breakdown of the health status of all the 
process instances for the selected Business 
Process. It includes instances that are:
• Healthy
• At Risk
• Blocked
Section Process Status on page 311 provides 
more details about the status field.
Click the status label to open the Process 
Instances Page, which is filtered to show only 
instances with the selected status; see 
section Instances Dialog on page 280.

Instances Numbers of instances for the Business 
Process in each of the specified statuses; see 
section Process Status on page 311 for a 
description of the status field.
The total Count for all instances is also 
presented and the count of Violations.

Value Value of the instances for the Business 
Process in each of the specified statuses; see 
section Process Status on page 311 for a 
description of the status field.
The total Value for all instances is also 
presented.

Completed Click to open the Process Instances Page, 
which is filtered to show only instances with 
the status of Completed.

<Scorecard summary> Scorecard display for the selected Business 
Process showing the over-time bar; see also 
Chapter 10, BPI Application Scorecard.

Table 54 Summary Tab for a Business Process
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Table 55 describes the elements presented on the Summary Tab when a 
specific Business Process Step is selected (unlabeled GUI elements are shown 
in angle brackets)

Table 55 Summary Tab for a Business Process Step

GUI Element (A-Z) Description

<Name/Step name> Name of Business Process and the Business 
Process Step is shown in the title bar of the 
tabs area and is the name of the Business 
Process and Business Process Step as 
entered using the Modeler.

Description Content of description field for the Business 
Process Step when entered using the 
Modeler. If no description is provided, [NA] is 
displayed as a value.

Instances Lists the Active instances for the selected 
Step.
Active instances are still progressing 
through the process. 
Click the Total Active link to open the 
Instances Page; see section Instances Dialog 
on page 280. The instances page is filtered to 
show all the process instances for the 
selected Step within the selected Business 
Process.
Click Violations to open the Instances 
Violations Page; see section Instance 
Violations Dialog on page 292. 

Count Label for the instance counts, which lists the 
number of Active instances at the selected 
Step.
Active instances are still progressing 
through the process. 
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Value Labels for the value, which lists the values of 
the instances that are Active at the selected 
Step.
Active instances are still progressing 
through the process.

<Scorecard summary> Scorecard display for the complete Business 
Process Step showing the over-time bar; see 
also Chapter 10, BPI Application Scorecard.

Table 55 Summary Tab for a Business Process Step
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Business Health Tab

Figure 23 shows an example of the Business Health Tab on the Health Page. 

Figure 23 Business Health Tab

The Business Health tab displays:

• objective dials for the objectives set on a KPI associated with a Business 
Process Monitor using the option: 

Admin > Dashboard > KPIs

See section Business Health Dials on page 277 for more details.

• a table showing the Instance Violation Counts for the selected Business 
Process or Business Process Step; see section Instance Violation Counts 
on page 278.

• Violation details for the selected Business Process or Business Process 
Step.

Click to open the Violations page; see section Instance Violations Dialog 
on page 292.
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Business Health Dials

When you open the Business Health tab, you are presented with a series of 
dials representing the KPI objective statuses that you have configured.

The dials provide a visual representation of the business objectives that have 
been set on KPIs associated with Business Process Monitor CIs. 

The dial shows the current monitor value and is formatted according to the 
type of monitor CI. The needle on the dial indicates status of the Business 
Process Monitor value with respect to the objectives that have been set for the 
Monitor CI. 

The name of the KPI and the appropriate Process or Process Step name are 
displayed below the dial.

If the dial represents objectives set on a custom monitor, the KPI name is 
shown as the custom monitor data units value.

There is a tooltip for each dial showing the monitor status, plus the monitor 
and objective values. The background color for the tooltip indicates the 
Business Process Monitor CI status. 

You can select a dial and drill down for more information, according to the 
Monitor scope, as follows:

• For dials representing Business Process Monitors and Custom Monitors 
configured using the Monitor Definer, you can drill down to the Monitors 
Over Time Report; see section BPI Monitors Over Time on page 325.

• For dials representing process Step monitors, you can drill down to the 
Business Process Step Over time Report; see section Business Process 
Step Over Time Report on page 337

You can also drill down to the Monitors page for more details of the Monitors; 
see section Monitor Dialog on page 295.

The KPI status shows the current status of all the KPIs for which you have set 
objectives.
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Instance Violation Counts

In addition to the dials, the Business Health option presents an Instance 
Threshold table summaries for the selected Business Process or Business 
Process Step. 

The Instance Threshold table show the status of the instance Thresholds over 
the latest collection period and as adjusted by any delay that you might have 
configured for your data samples; see section “Data Sample Settings” on 
page 133. for more details.

You can select an Instance Threshold and drill down to the Threshold 
Violations table for more information on the individual threshold instances.

The status of the instance threshold is shown and described in Table 53 on 
page 271.

You cam also click the All Violations link to open the Violation page, which 
is filtered to show violations for the selected Business Process, or Business 
Process Step; see section Instance Violations Dialog on page 292.
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Transactions Tab

Figure 24 is an example of the Transaction Tab on the Health Page.

Figure 24 Transaction Tab

The Transactions tab displays summary information relating to the 
TransactionVision CIs that are linked to the selected Business Process or 
Business Process Step. 

Table 56 describes the Transactions Tab.

Table 56 describes the elements that are presented on the Transaction Tab. 
The elements are the same if you select the whole Business Process, or a 
Business Process Step (unlabeled GUI elements are shown in angle brackets):

Table 56 Transactions Tab

GUI Element (A-Z) Description

Business Transactions The name of the Business Transaction as 
defined in TransactionVision and as linked 
to the BPI Business Process.
Select a Business Transaction to view the 
TransactionVision Aggregated Topology 
report. See the TransactionVision Help for 
the TransactionVision Application under:
Applications > TransactionVision

<column data> This column data is as defined under:
Admin > Dashboard > Business 
Transactions.
The columns included on the Transactions 
Tab are variable to match the KPI defined 
for Business Transaction and as shown in 
Dashboard.
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Instances Dialog

Figure 25 is an example of the Instances Dialog. This dialog is accessible 
directly from the Healthy, At Risk and Completed links on the Summary Tab 
of the Health page. 

Figure 25 Instances Dialog

The Process Instances dialog displays information relating to the process 
instance counts. The display is filtered according to the status of the instances 
and whether the instance counts have been requested from a Business 
Process, or a Step context. The most recent instances are listed first.
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• Section Process Instances for a Selected Business Process on page 281 
describes the information for a selected Business Process.

• Section Process Instances for a Selected Business Process Step on 
page 283 describes the information for a selected Business Process Step.

Process Instances for a Selected Business Process

This section describes the Process Instances dialog when selected from a 
Business Process context. The Process Instances dialog is divided into the 
following areas:

• Instances Dialog settings; see Table 57

• Instances Dialog results area; see Table 58

Table 57 describes the elements for the settings area of the Instances dialog 
(unlabeled GUI elements are shown in angle brackets):

Table 57 Instances Dialog Settings

GUI Element (A-Z) Description

Process Step Indicates the selection criterion for the 
dialog. You can list all the steps in the 
selected process, or you can select a specific 
Step and list only the Instances that are 
active at the Step.
The number of Process Instances found and 
the number of Process Instances listed in the 
results area is displayed underneath 
Process Step.

Identifier The Identifier of the Process Instance that 
you want to list in the results area. You can 
search for a specific instance, or leave this 
field blank if you want to list all Process 
Instances. Wildcard searches are also 
available.

Instance Status The status of the Process Instances that you 
want to list in the results area. 
Select the value Any to list all Process 
Instances in all states.
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Table 58 describes the elements in the results area (unlabeled GUI elements 
are shown in angle brackets):

Maximum List Size The number of Process Instances that you 
want to list in the results area. You can 
select from a list size of 12, 20 50 or 100.

Export all Enables you to export all the process 
instances and their values to a file in comma 
separated value (CSV) format. You can 
optionally include Data definition values 
when exporting the process instance 
information; this is set from the Servlet 
Engine option within the BPI 
Administration Console; see section 
Component Configuration - Servlet Engine 
on page 89. 
The exported CSV file can then be imported 
into Microsoft Excel for analysis.

Table 58 Instances Dialog Results Area

GUI Element (A-Z) Description

Identifier The identifier for the Process Instance. Click 
to open the Process Instance page to obtain 
more information relating to the selected 
Process Instance; see section Process 
Instance Dialog on page 287.

Process Value The content of the Value attribute for the 
listed Process Instance.
Process Value is based on the Process 
Value property of the Business Process. The 
Process Value is assigned when you create 
the Business Process in the Modeler, the 
value is typically assigned from a Business 
Event when the processes is active.

Start Time The time that this Process Instance fulfilled 
the Start Condition for the Start Step.

Table 57 Instances Dialog Settings
282 Chapter 11



Process Instances for a Selected Business Process Step

This section describes the Process Instances dialog when selected from a 
Business Process Step view.

The Process Instances dialog is divided into the following areas:

• Instances Dialog settings; see Table 59

• Instances Dialog results area; see Table 60

Table 59 describes the elements for the settings area (unlabeled GUI elements 
are shown in angle brackets):

End Time The time that this Process Instance fulfilled 
the End Condition for the End Step, if 
applicable.

Status The status of the listed Process Instance, and 
can be one of:
• Healthy
• At Risk
• Blocked
• Completed
See section Process Status on page 311 for 
descriptions of the status values.

Table 58 Instances Dialog Results Area

Table 59 Instances Dialog Settings

GUI Element (A-Z) Description

Step Name Select box that shows the current selection 
criterion for the dialog. You can list all the 
instances in the selected process, or you can 
select a specific Step and list only the 
Instances that are active at the Step.

<Step Name> Name of the selected Step
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Operational Status Status of selected Step, and can be one of:
• Healthy
• At Risk
• Blocked
• Completed
See section Process Status on page 311 for 
descriptions of the status values.

Average Duration (H:M:S) The average time taken for all process 
instances to fulfill the Start and End 
condition for the Step. This time is measured 
across all the instances that have passed 
through this Step.
A value for this field is provided only when 
there is sufficient data to generate a 
statistical result.

Instance Rate (per hour) The rate at which instances of the step are 
being completed, expressed as an hourly 
rate.
A value for this field is provided only when 
there is sufficient data to generate a 
statistical result.

Process Value Rate (per 
hour)

The value of the process instances as they 
are processed on an hourly basis. 
A value for this field is provided only when 
there is sufficient data to generate a 
statistical result.

Identifier The Identifier of the Process Instance that 
you want to list in the results area. Leave 
this field blank if you want to list all Process 
Instances for the selected Step.

Step Status The status of the Process Instances that you 
want to list in the results area. 
Select the value Any to list all Process 
Instances in all states.

Table 59 Instances Dialog Settings
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Maximum List Size The number of Process Instances (Active and 
Completed) that you want to list in the 
results area. You can select from a list size of 
8, 20 50 or 100.

Export all Enables you to export all the process 
instances and their values to a file in comma 
separated value (CSV) format. You can 
optionally include Data definition values 
when exporting the process instance 
information; this is set from the Servlet 
Engine option within the Administration 
Console; see section Component 
Configuration - Servlet Engine on page 89. 
The exported CSV file can then be imported 
into Microsoft Excel for analysis.

Table 60 Instances Dialog Results Area

GUI Element (A-Z) Description

Identifier The identifier for the Process Instance. Click 
to open the Process Instance page to obtain 
more information relating to the selected 
Process Instance; see section Process 
Instance Dialog on page 287.

Process Value The content of the Value attribute for the 
listed Process Instance.

Process Start Time The time that this Process Instance fulfilled 
the Start Condition for a Start Step.

Table 59 Instances Dialog Settings
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Step Start Time The time that this Process Instance fulfilled 
the Start Condition for the selected Step. If a 
Step fulfils its Start Condition multiple time, 
the most recent start time is listed.

Step Stop Time The time that this Process Instance fulfilled 
the End Condition for a selected Step.

Table 60 Instances Dialog Results Area
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Process Instance Dialog

Figure 26 is an example of the Process Instance dialog.

This dialog is accessible from the:

• Instances dialog; see section Instances Dialog on page 280.

• Monitor dialog; see section Monitor Dialog on page 295.

• Monitor Threshold dialog; see section Monitor Threshold Dialog on 
page 304.

• Violations dialog; see section Instance Violations Dialog on page 292.
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Figure 26 Process Instance Dialog

Displays information relating to the selected process instance.

The Process Instance dialog is divided into the following tabbed areas:

• Process Diagram on page 289

• Process Timeline on page 289

• Monitor Thresholds on page 289

• Process Steps on page 289

• Data Definition on page 290
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Process Diagram

This shows the process diagram for the selected Process Instance; see section 
Process Diagram Area on page 265 for a description of the process diagram.

Click a Step in the process diagram and open the Step Instance dialog; see 
section Step Instance Dialog on page 291.

Process Timeline

This shows the Process Instance details as a time line, so you can easily see 
the order in which Steps are executed and graphically see the length of time 
spent at each Step.

Click a Step on the timeline and open the Step Instance dialog; see section 
Step Instance Dialog on page 291.

Monitor Thresholds

This shows the monitor instance threshold details. Each instance threshold is 
shown in the form of a dial. The dial shows the status of the Monitor Instance 
Threshold.

Click the associated Monitor to open the Monitor dialog; see section Monitor 
Dialog on page 295. 

Click the instance threshold name to open the Threshold instance dialog; see 
section Monitor Threshold Dialog on page 304.

Process Steps

This page lists the details of selected Process Step and includes:

• Step Name

• time taken to complete the Step

• time that the Process Instance fulfilled the Start Condition for the Step
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• time that the Process Instance fulfilled the End Condition for the Step.

• whether or not the Step fulfilled its start condition more than once.

Click a specific Step to open the Step Instance dialog; see section Step 
Instance Dialog on page 291.

Data Definition

This page lists the Data definition property values for the Associated Data 
definition that has been defined in the Modeler for the Business Process as 
follows:

• Property Name

The name of the Data Definition property as entered in the Modeler.

• Property Value

The value for the Data Definition property at the selected Step.

If you have configured BPI to integrate with TransactionVision, an additional 
column is listed. This column provides a link to the Transaction Tracking 
Report (managed by TransactionVision) for the selected Data Definition 
property. The Transaction Tracking Report is generated using the filter 
criteria that you have specified for the process instance.
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Step Instance Dialog

This page lists all the instances that have fulfilled their Start and End 
conditions for the selected Step, and includes the following details:

• Details relating to the selected Step:

— Name

The name of the selected Step.

— Step Status

The status of the selected Step, see section Process Status on page 311 
for details of the possible statuses for the Step.

— Overall Step Duration (H:M:S)

The time taken to complete the Process Step.

• Maximum List Size

A drop-down list box that enables you to configure the number of items 
that appear in the list.

• Paired Start and End Times

This is a list of the history of the Step with respect to the number of times 
the selected instance has fulfilled the Start and End Conditions for the 
Step; it includes the Duration, Start Time and End Time.
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Instance Violations Dialog

Figure 27 is an example of the Instances Violation dialog, which is accessible 
from the All Violations link on the Health Tab.

Figure 27 Instances Violations Dialog

The Instance Violation dialog lists all the Threshold Violations instances 
related to the selected Business Process, or Business Process Step.

The most recent instance Threshold violations are listed first.
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Table 61 lists the elements for the Instance Violation settings (unlabeled GUI 
elements are shown in angle brackets):

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Table 61 Instance Violation Settings

GUI Element (A-Z) Description

Step Name The Step Name for the single-step Monitor.

Identifier Enter a Process Identifier to list violations 
related to a specific process instance. Leave 
this blank to list violations for all process 
instances, or enter a partial string to search.

Severity Select a severity level (Warning, Minor, 
Major or Critical) to list violations that are 
greater than or equal to a specific violation 
level. Enter All to list all violation levels.

Maximum List Size The number of instance violations that you 
want to list in the results area. You can 
select from a list size of 10, 20 50 or 100.

Export all as CSV Enables you to export all the process 
instances and their values to a file in comma 
separated value (CSV) format. You can 
optionally include Data definition values 
when exporting the process instance 
information; this is set from the Servlet 
Engine option within the Administration 
Console; see section Component 
Configuration - Servlet Engine on page 89. 
The exported CSV file can then be imported 
into Microsoft Excel for analysis.

Table 62 Instance Violation Results Area

GUI Element (A-Z) Description

Time Threshold Violated The time that the instance threshold 
condition was violated.
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Time Threshold Raised The time that the instance threshold 
condition was detected by BPI.
The time that a instance threshold is 
detected can be different if you have stopped 
the BPI Monitor Engine, or the BPI system 
has been disabled for some reason. 

Monitor Name Name of the Monitor that this instance 
threshold is defined for.
Click to open the related Monitor Dialog; see 
section Monitor Dialog on page 295.

Threshold Name Name of the instance threshold.
Click to open the related Monitor Threshold 
dialog; see section Monitor Threshold Dialog 
on page 304.

Monitor Value At Time of 
Threshold Violation

Value of Monitor when instance threshold 
was violated.

Severity Level of the violation, which can be one of:
• Normal
• Warning
• Minor
• Major
• Critical
For descriptions of the violations, refer to 
Understanding KPI Statuses in the Using 
Dashboard section of the BAC 
documentation library.

Process Identifier Identifier for Process Instance listed for the 
selected Step and affected by the instance 
threshold violation.
Click to open the related Process Instance 
page; see section Process Instance Dialog on 
page 287.

Table 62 Instance Violation Results Area
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Monitor Dialog

Figure 28 is an example of the Monitor dialog, which is accessible from the:

• Business Health Tab; see section Business Health Tab on page 276.

• Process Instance dialog; see section Process Instance Dialog on 
page 287.

• Monitors dialog; see section Monitor Dialog on page 295.

• Violations dialog; see section Monitor Threshold Dialog on page 304.

• Monitor Threshold dialog; see section Monitor Threshold Dialog on 
page 304.

Figure 28 Monitor Dialog
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Shows the data collected that relates to the Business Process Monitors that 
you defined for a Business Process.

The Monitor dialog is divided into the following tabbed areas:

• Monitor Diagram on page 296

• Monitor Description on page 296

• Monitor Values on page 297

• Monitor Graph on page 300

• Monitor Summary on page 303

Information about defining Business Process Monitors can be found in the:

• Business Process Insight Modeler Online Help

• Integration Training Guide - Modeling Processes

Monitor Diagram

This page shows a graphical representation of the selected Monitor as a 
process diagram, see section Process Diagram Area on page 265 for a 
description of the process diagram. 

Click a Step on the process diagram to open the Process Instances dialog in 
the selected Step context.

The additional information on the process diagram are the red flags. These 
red flags reflect those added when you defined the Monitor in the Monitor 
Definer and show the start and end points for this Monitor Definition. The 
flags do not appear in the case of a Business Process Monitor with a scope of 
Whole Process.

Monitor Description

This page displays the details of the Monitor as defined when you created the 
Monitor using the Monitor Definer: 

• Monitor Name

• Monitor Description

• Monitor Scope
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In the case of a Monitor Definition that has been defined with a scope of 
Single Step or Multiple Step, the Start Step and End Step values are also 
listed.

You can use this page to gain an overview of all the monitors reported for the 
selected process. 

Monitor Values

This page lists the values for the Monitor instances, starting with the most 
recent.

The page is divided into an area to set the filter criteria (Table 63) and a 
results area. The results shown in the results area varies according to 
whether you are viewing a Value or Duration Monitor:

• Table 64 describes the Value Monitor.

• Table 65 describes the Duration Monitor.

Table 63 describes the elements for the Monitor Instance settings (unlabeled 
GUI elements are shown in angle brackets):

Table 63 Monitor Instance Settings

GUI Element (A-Z) Description

Monitor Name Name of the selected Monitor.
The number of Monitor Instances found and 
the number of Monitor Instances listed in 
the results area is displayed underneath 
Monitor Name.

Process Identifier Enter a Process Identifier to filter the list 
based on a specific Process Instance, or leave 
the field blank to filter on all instances.

Monitor Status Select the value of the status for the Monitor 
that you want to filter the results on:
• All 
• Active

• Completed
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Table 64 describes the elements for the Monitor Instance results area for a 
Value Monitor (unlabeled GUI elements are shown in angle brackets):

Maximum List Size The number of Monitor instances that you 
want to list in the results area. You can 
select from a list size of 10, 20 50 or 100.

Export All as CSV Enables you to export all the Monitor 
instance data to a file in comma separated 
value (CSV) format.
The exported CSV file can then be imported 
into Microsoft Excel for analysis.

Table 64 Monitor Instance Results Area - Value Monitor

GUI Element (A-Z) Description

Process Identifier The identifier for the Process Instance.

Start Time Time when process instance entered the 
scope of the Monitor.

End Time Time when process instance exited the scope 
of the Monitor.

Monitor Status Status of the Process Instance, which can be 
one of All, Active or Completed,

Table 63 Monitor Instance Settings
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Table 65 describes the elements for the Monitor Instance results area for a 
Duration Monitor (unlabeled GUI elements are shown in angle brackets):

Process Value The configured value of each Process 
Instance that is currently within the scope of 
the monitor

Severity The worst status of any instance threshold in 
this monitor and which the process instance 
has violated. The status can be:
• Normal
• Warning
• Minor
• Major
• Critical
• Unknown
For descriptions of the violations, refer to 
Understanding KPI Statuses in the Using 
Dashboard section of the BAC 
documentation library.

Table 65 Monitor Instance Results Area - Duration Monitor

GUI Element (A-Z) Description

Process Identifier The identifier for the Process Instance.

Start Time Time when process instance entered the 
Monitor scope.

End Time Time when process instance exited the 
Monitor scope.

Monitor Status Status of the Monitor instance, which can be 
one of All, Active or Completed,

Table 64 Monitor Instance Results Area - Value Monitor
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Monitor Graph

This page shows the Monitor results as a graph based on the statistics 
collected for the Monitor; these statistics are selected from the Data 
Aggregation Method. The graph can be either a bar chart or a line. The data 
shown on the graph is tailored to your filter criteria. When you have 
completed the settings for the filters, the graph is drawn automatically as 
required.

The page is divided into an area to select the filter criteria (Table 66) and a 
results area, which show the required data in graphical form. 

Monitor Duration The value of the Monitor specified as a time. 

Severity The worst status of any instance threshold in 
this monitor and that the process instance 
has violated. This status can be:
• Normal
• Warning
• Minor
• Major
• Critical
• Unknown
For descriptions of the violations, refer to 
Understanding KPI Statuses in the Using 
Dashboard section of the BAC 
documentation library.

Table 65 Monitor Instance Results Area - Duration Monitor
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Table 66 describes the elements of the Monitor Graph settings (unlabeled GUI 
elements are shown in angle brackets):

Table 66 Monitor Graph Settings

GUI Element (A-Z) Description

Monitor Name Name of the selected Monitor. You can 
change the Monitor that you want to see the 
results for using this drop-down selection 
box.

Data Aggregation Method The statistical sources that you want to use 
as the data to be plotted on the graph.

Graph Type Select the type of graph that you want to 
show. This can be either a bar chart, or a line 
graph.

Graphing Period Select the time period that you want to plot 
results for. If you select All, then all the data 
collected is plotted.
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Chart by group If you have defined Groups for your 
Monitors, in the Monitor Definer, you have 
the option to chart your data using the 
Group definitions. Select Yes to chart using 
your Group definitions, or No to chart the 
data without using groups.

Export Graph as CSV Enables you to export the statistical data 
plotted on the graph to a file in comma 
separated value (CSV) format. You can 
optionally include Data definition values 
when exporting the process instance 
information; this is set from the Servlet 
Engine option within the Administration 
Console; see section Component 
Configuration - Servlet Engine on page 89.
The exported CSV file can then be imported 
into Microsoft Excel for analysis.

Export all data sources as 
CSV

Enables you to export all the statistical data 
for all the data sources to a file in comma 
separated value (CSV) format. You can 
optionally include Data definition values 
when exporting the process instance 
information; this is set from the Servlet 
Engine option within the Administration 
Console; see section Component 
Configuration - Servlet Engine on page 89. 
The exported CSV file can then be imported 
into Microsoft Excel for analysis.

Table 66 Monitor Graph Settings
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Monitor Summary

This page displays summary information relating to recent and all values of 
the Monitor. The page includes: 

• Recently Completed Monitor Values

The data relating to each listed Monitor value over the last collection 
interval (Data sample collection period). 

• Monitor Values to date

The data relating to each listed Monitor value since the Monitor was 
deployed.
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Monitor Threshold Dialog

Figure 29 is an example of the Monitor Threshold dialog, which is accessible 
from:

• Health Page; see section Business Health Tab on page 276.

• Monitor dialog; see section Monitor Dialog on page 295.

• Violations dialog; see section Instance Violations Dialog on page 292.

Figure 29 Monitor Threshold Dialog
304 Chapter 11



Shows the statistical data collected that relates to the Business Process 
Monitor Thresholds that you defined in the Monitor Definer.

The Monitor Threshold dialog is divided into the following tabbed areas:

• Threshold Definitions on page 305

• Threshold Violations on page 306

Threshold Definitions

This tab displays the details of the Monitor Threshold as defined using the 
Monitor Definer: 

• Threshold Name

• Description

• Threshold Type

• Monitor Field

• Warning Level

• Minor Level

• Major Level

• Critical Level

For descriptions of the violations, refer to Understanding KPI Statuses in the 
Using Dashboard section of the BAC documentation library.

The following is additional information relating to the parent Monitor 
Definition:

• Recent Monitor Average

The average Monitor value as measured over the latest collection interval; 
see section “Collection Interval” on page 177 for information relating to 
the collection interval.

• Associated Monitor, where you can link to the Monitor Page that shows 
information for the Monitor that is associated with the selected 
Threshold. 
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Threshold Violations

This tab displays a list of all the violations found for the selected instance 
threshold.

The data shown in the list is tailored to your filter criteria. When you have 
completed the settings for the filters, the list is populated automatically as 
required.

The page is divided into an area to select the filter criteria (Table 67) and a 
results area (Table 68), which show the required data in list form.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Table 67 Threshold Violation Settings

GUI Element (A-Z) Description

Identifier Enter a Process Identifier to list violations 
related to a specific process instance. Leave 
this blank to list violations for all process 
instances.

Severity Select the violation level that you want to 
list. If you select the value All, all violation 
levels are listed.

Maximum List Size The number of Threshold Violations that you 
want to list in the results area. You can 
select from a list size of 8, 20 50 or 100.

Export all as CSV Enables you to export all the Threshold 
Violation data to a file in comma separated 
value (CSV) format. You can optionally 
include Data definition values when 
exporting the process instance information; 
this is set from the Servlet Engine option 
within the Administration Console; see 
section Component Configuration - Servlet 
Engine on page 89.
The exported CSV file can then be imported 
into Microsoft Excel for analysis.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Table 68 Threshold Violation Results Area

GUI Element (A-Z) Description

Process Identifier The identifier for the Process Instance. Click 
to open the Process Instance page to obtain 
more information relating to the selected 
Process Instance; see section Process 
Instance Dialog on page 287.

Time Threshold Violated The time that the instance threshold 
condition was violated.

Time Violation Raised The time that the instance threshold 
condition was detected by BPI.
The time that an instance threshold is 
detected can be different if you have stopped 
the Monitor Engine, or the BPI or BAC 
system has been disabled for some reason. 

Monitor Value At Violation 
Time

Value of parent Monitor instance at the point 
where the Violation occurred.

Severity The level of the instance threshold violation, 
which can be:
• Normal
• Warning
• Minor
• Major
• Critical
• Unknown
For descriptions of the violations, refer to 
Understanding KPI Statuses in the Using 
Dashboard section of the BAC 
documentation library.
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Synchronization and Delay in Seeing Updates to Data

The data displayed on the BPI Scorecard and the BPI Reports is based on data 
sample data. The frequency that the data samples are sent are configured 
using the Data samples settings within the BPI Server Administration 
Console. 

The remaining BPI Application data is obtained directly from the BPI 
Instance database.

It is therefore possible that when you view data within the Health page that 
you might see a CI before it is available within either the Scorecard or the 
Reports.
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BPI Instance and Violation Health Information

Some of the information presented from the Health pages (links from the 
Health Tab) is sourced directly from the BPI Server and some is sourced from 
the BAC system.

When you open the Health Page, the page comprises a set of Java Server 
Pages (JSPs) and Java beans, which run on the Web Server configured for 
your BAC installation. The data presented within the Process Diagram area, 
the Summary Tab and the Business Health Tab is sourced using the BAC Web 
Server, which obtains its count information directly, from the BPI Server 
database; see Figure 30.

Figure 30 Health Page Count Data

If the BPI Server is not running for any reason, but the BPI Instance database 
is still available, this information can be seen using within the Health Pages. 
If the Business Impact Engine database is not available, this count data is not 
available within the Health pages.
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The BPI Instance and Violation pages, which you access when you drill down 
from the top-level Health page to subordinate pages and dialogs, are managed 
by a set of Java Server Pages (JSPs) and Java beans. These JSPs run on the 
Web Server configured for the BPI installation and the instance and violation 
data is obtained from the BPI Instance database; see Figure 31.

Figure 31 Instance and Violation Information

If the BPI Server, or Servlet Engine, is not running for any reason, this 
information is not available within the Health Pages.
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Process Status

When displaying the status of a process, the following terms are used:

• Blocked

This means that at least one instance of the process is active for a Step, 
and this instance cannot proceed due to a problem in an underlying IT 
operational service.

• At Risk

This means that there are currently no process instances in a blocked 
state, however there are process instances in progress that might reach 
the blockage some point in the future.

• Healthy

This means that all active process instances are currently past the 
blockage and can therefore continue to run to completion, or there is no 
problem with the IT infrastructure.

There is also an icon representing each of the statuses, which is used in place 
of text. These icons are shown in Figure 32.

Figure 32 Business Process Status Icons

Step Rates

Within the instance and violation information, you can display the overall 
details of a process and then drill down into a particular Process Step to view 
details of the overall statistics for that Step. These statistics include the 
current node Instance Rate and current node Weight Rate. These rate 
values provide information about the current throughput at a given Step. The 
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rates are expressed as a value per hour in much the same way as the 
speedometer in your car tells you how far you would travel in a hour if you 
kept traveling at your current speed.

The rates eventually reset themselves to zero, if there is a prolonged period of 
inactivity.

Be aware that these rate values can give slightly incorrect values when the 
Step activity is low.
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12 BPI Application Reports
The BPI Application Report pages display historical data relating to 
summaries of Business Processes, Business Process Steps, and Monitors that 
you have defined.

This chapter covers the following topics:

• Profile Database Configuration Requirements on page 314

• Enrich the Business Process Report View on page 315

• Business Process Summary Report on page 316

• BPI Monitors Over Time on page 325

• Business Process Step Summary on page 329

• Business Process Over Time Report on page 334

• Business Process Step Over Time Report on page 337

The BPI reports customized BAC Reports and comprise charts and tables that 
help you track and analyze the health of your monitored BPI environment. 

You can view and generate the BPI reports, as well as drill down and apply 
various filtering criteria to examine performance trends and pinpoint the 
cause of health and performance issues. 

Reports enable you to examine and analyze the data that is collected for 
Business Process Insight in the Profile database. When generating reports, 
you can specify various report settings, including time range and resolution, 
profile, grouping, and filters. 

As with all BAC reports, you can customize the BPI reports by adding a 
header and a footer, by selecting to automatically or manually generate the 
report, or by customizing other display elements. More details of using reports 
can be found in Report Manager.
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Profile Database Configuration Requirements

In order to see report information for your Business Processes, you need to 
make sure that you have created a Profile database using the following option 
within BAC:

Admin > Platform > Manage Profile Databases

When there is data available in the Profile database; that is, BPI is sending 
data samples, the following BPI reports are available to help you analyze the 
BPI Business Process data:

• Business Process Summary

Displays summary data for the selected Business Process; see section 
Business Process Summary Report on page 316.

You can drill down to the following reports from the Business Process 
Summary report:

— Business Process Over Time

— BPI Monitor Over Time

— Business Process Step Summary 

• BPI Monitors Over Time

Displays two graphs for each selected Monitor definition; see section BPI 
Monitors Over Time on page 325.

The first graph displays the average/minimum/maximum/weighted value 
or duration of the selected Monitor over time.

The second graph displays the number of Monitor instance violations over 
time.

• Business Process Step Summary

Displays summary data for the selected Business Process Step; see section 
Business Process Step Summary on page 329.

You can drill down to the Business Process Step Over Time report from 
this report.
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Figure 33 shows the hierarchy of reports for Business Process Insight.

Figure 33 Hierarchy of Reports

Enrich the Business Process Report View

You can additionally attach IT Universe CIs to the appropriate Business 
Process Step. This enables you to add additional CI information to your 
reports to enhance the level of information that the reports provide.
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Business Process Summary Report

Figure 34 is an example of a Business Process summary report.

This report is accessible from:

Applications > Business Process Insight > Reports >Business 
Process Summary

Figure 34 Business Process Summary Report

The Business Process summary report displays the summary data for the 
selected Business Processes.
Use this report to gain an overall view of the historical health of your 
Business Processes.
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The Business Process Summary report is divided into the following areas:

• Report settings; see Table 69

• Report Value area; see Table 70

• Report Count area; see Table 71

Table 69 describes the elements of the Business Process Summary report 
settings (unlabeled GUI elements are shown in angle brackets):

Table 69 Business Process Summary Report Settings

GUI Element (A-Z) Description

<Common report
settings>

For details see section Common Report 
Elements in Reports.

Business Processes Click to open the Business Processes dialog 
box where you can select the view and the 
processes that you want to display.
You can select only Business Processes for 
which you have a Business Process Monitor 
defined. If one Business Process is selected, 
its name is displayed to the right of the link. 
If more than one Monitor is selected, Filtered 
(n) is displayed to the right of the link, where 
n represents the number of selected 
Processes.

Show Select one of the following options:
• Value. Select to display value data for the 

Business Processes in the Value area.
• Count. Select to display Business Process 

count values in the Count area.
• Both. Select to display both the counts 

and the values. This is the default for the 
Report.
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Table 70 describes the elements of the Business Process Summary Value area. 
The Value area is displayed when you select Value or Both from the Show: 
option (unlabeled GUI elements are shown in angle brackets).

Table 70 Business Process Summary Value Area Settings

GUI Element (A-Z) Description

Select a Business Process and click the 
Drill Down to Business Process Over 
Time Report button to drill down to the 
Business Process Over Time report for the 
selected Business Process. The report is 
displayed with the most appropriate option 
selected.

Select a Business Process and click the 
Drill Down to Business Process Step 
Summary Report button to drill down to the 
Business Process Step Summary report for 
the selected Business Process. The report is 
displayed with the most appropriate option 
selected.

Select a Business Process and click the 
Drill Down to Duration Monitors Over 
Time Report button to drill down to the BPI 
Monitors Over Time report for the selected 
Business Process where only the Duration 
Monitors are shown in the report.
The button is enabled only if the selected 
Business Process has Duration Monitors 
defined.
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Select a Business Process and click the 
Drill Down to Value Monitors Over 
Time Report button to drill down to the 
Monitors Over Time report for the selected 
Business Process where only the Value 
Monitors are shown in this report.
Custom Monitor can also be selected for this 
report. 
The button is enabled only if the selected 
Business Process has a Value Monitor 
defined.

Business Process The name of the selected Business Process.
Note: You can sort on this column.
Tooltip: Displays the name of the Business 
Process and the currency symbol, in cases 
where the value is a currency type.

Total Value of Completed 
Instances

Displays the total of the value attribute for 
all the Business Process instances that were 
completed in the selected time period.
The background color of the table row is set 
to gray.
Tooltip: Displays the value of the table cell 
with a currency unit if it is available.

Avg. Value of Backlog 
Instances

Displays the average of the value attributes 
for all the Business Process instances with a 
status of Active over the specified period of 
time.
The background color of the table row is set 
to gray.
Tooltip: Displays the value of the table cell 
with a currency unit if it is available.

Table 70 Business Process Summary Value Area Settings
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Avg. Value of Healthy 
Instances

Displays the average of the value attributes 
for all the Business Process instances that 
have a Healthy status over the specified 
period of time. The background color of the 
table row is set to green.
Tooltip: Displays:
• The value of the table cell.
• The value of the Avg. Number of 

Backlog Instances cell.
• The percentage of the current table cell 

value compared to the value of the Avg. 
Number of Backlog Instances cell.

Avg. Value of At Risk 
Instances

Displays the average of the value attributes 
for all the Business Process instances that 
have an At Risk status over the specified 
period of time. The background color of the 
table row is set to yellow.
Tooltip: Displays:
• The value of the table cell.
• The value of the Avg. Value of Backlog 

Instances cell.
• The percentage of the current table cell 

value compared to the value of the Avg. 
Value of Backlog Instances cell.

Table 70 Business Process Summary Value Area Settings
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Table 71 describes the elements of the Business Process Summary Count 
area. The Count area is displayed when you select Count or Both from the 
Show: option (unlabeled GUI elements are shown in angle brackets).

Avg. Value of Blocked 
Instances

Displays the average of the value attribute 
for all the Business Process instances that 
are in the Blocked status over the specified 
period of time.
The background color of the table row is set 
to red.
Tooltip: Displays:
• The value of the table cell.
• The value of the Avg. Number of Backlog 

Instances cell.
• The percentage of the current table cell 

value compared to the value of the Avg. 
Number of Backlog Instances cell.

Table 71 Business Process Summary Count Area Settings

GUI Element (A-Z) Description

Select a Business Process and click the 
Drill Down to Business Process Over 
Time Report button to drill down to the 
Business Process Over Time report for the 
selected Business Process. The report is 
displayed with the Count option selected.

Select a Business Process and click the 
Drill Down to Business Process Step 
Summary Report button to drill down to the 
Business Process Step Summary report for 
the selected Business Process. The report is 
displayed with the Count option selected.

Table 70 Business Process Summary Value Area Settings
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Select a Business Process and click the 
Drill Down to Duration Monitors Over 
Time Report button to drill down to the 
Monitors Over Time report for the selected 
Business Process where only the Duration 
Monitors are shown in the report.
The button is enabled only if the selected 
Business Process has a duration Monitor 
defined.

Select a Business Process and click the 
Drill Down to Value Monitors Over 
Time Report button to drill down to the 
Monitors Over Time report for the selected 
Business Process where only the Value 
Monitors are shown in this report.
Custom Monitors can also be displayed in 
this report. 
The button is enabled only if the selected 
Business Process has a Value Monitor 
defined.

Business Process The name of the selected Business Process.
Note: You can sort on this column.
Tooltip: Displays the name of the Business 
Process.

Number of Completed 
Instances

Displays the total number of the Business 
Process instances that were completed in the 
selected time period.
The background color of the table row is set 
to gray.
Tooltip: Displays the value of the table cell.

Table 71 Business Process Summary Count Area Settings
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Avg. Number of Backlog 
Instances

Displays the average number of backlogged 
Business Process instances out of the 
number of samples reported over the 
specified period of time.
The background color of the table row is set 
to gray.
Tooltip: Displays the value of the table cell.

Avg. Number of Healthy 
Instances

Displays the average number of the Business 
Process instances that have a Healthy 
status, out of the number of samples 
reported over the specified period of time. 
The background color of the table row is set 
to green.
Tooltip: Displays:
• The value of the table cell.
• The value of the Avg. Number of 

Backlog Instances cell.
• The percentage of the current table cell 

value compared to the value of the Avg. 
Number of Backlog Instances cell.

Table 71 Business Process Summary Count Area Settings
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Avg. Number of At Risk 
Instances

Displays the average number of the business
process instances that have an At Risk 
status, out of the number of samples 
reported over the specified period of time. 
The background color of the table row is set 
to yellow.
Tooltip: Displays:
• The value of the table cell.
• The value of the Avg. Number of Backlog 

Instances cell.
• The percentage of the current table cell 

value compared to the value of the Avg. 
Number of Backlog Instances cell.

Avg. Number of Blocked 
Instances

Displays the average number of Business 
Process instances that are in the Blocked 
status, out of the number of samples 
reported over the specified period of time.
The background color of the table row is set 
to red.
Tooltip: Displays:
• The value of the table cell.
• The value of the Avg. Number of Backlog 

Instances cell.
• The percentage of the current table cell 

value compared to the value of the Avg. 
Number of Backlog Instances cell.

Table 71 Business Process Summary Count Area Settings
324 Chapter 12



BPI Monitors Over Time

Figure 35 is an example of the BPI Monitors Over Time Report.

This report is accessible from:

• Applications > Business Process Insight > Reports > BPI 
Monitors Over Time

• The Process Summary Report; see section Business Process Summary 
Report on page 316.

Figure 35 BPI Monitors Over Time Report
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The BPI Monitors Over Time report displays two graphs for a selected 
Business Process Monitor:

• Monitor Data, which plots the average/minimum/maximum/weighted 
value or duration of the selected Business Process Monitor over time.

• Status Distribution, which plots the Monitor instance violations over 
time, based on their status.

Use this report to list information relating to the Business Process Monitors 
status for your Business Processes over a selected time period. The report 
data is shown in graphical form and can also be published in tabular form.

The BPI Monitors Over Time Report is divided into the following areas:

• Report settings; see Table 72

• Monitor Data; see Monitor Data Area on page 327

• Status Distribution; see Status Distribution on page 328

Table 72 describes the elements of the BPI Monitor Over Time Report settings 
(unlabeled GUI elements are shown in angle brackets).

Table 72 Business Process Monitors Over Time Report Settings

GUI Element (A-Z) Description

<Common report
settings>

For details see section Common Report 
Elements in Reports.

BPI Monitors Click to open the BPI Monitors dialog box.
If one Monitor is selected, its name is 
displayed to the right of the link. If more 
than one Monitor is selected, Filtered (n) is 
displayed to the right of the link, where n 
represents the number of selected Monitors.

Graph by Group This option appears when one Business 
Process Monitor is selected. If more than one 
monitor is selected, this option is not 
available. 
Click Graph by Group to drill down to a 
Monitor Graph with a display that is split 
according to the different elements in the 
Group definition
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Monitor Data Area

The Monitor Over Time Report displays a separate set of charts for each 
selected Monitor and for the selected time period in the Monitor Data area.

If you have selected an BPI Value or Custom Monitor, the graph displays the 
following information:

• Average Value per Instance

The average value of the completed instances of the selected Monitor out 
of the total number of completed instances.

• Maximum Value 

The maximum value of all the completed instances of the selected 
Monitor.

• Minimum Value

The minimum value of all the completed instances of the selected Monitor.

If you have selected an BPI Duration Monitor, the graph displays the 
following information:

• Average Duration 

The average duration of the completed instances of the selected Monitors 
out of the total number of completed instances of the selected Monitors.

• Weighted Average Duration

The weighted average duration of all the completed instances of the BPI 
Monitors out of the total number of completed instances of the Monitor. 
Maximum Duration.

The maximum duration of all the completed instances for the selected 
Monitor.

• Minimum Duration

The minimum duration of all the completed instances for the selected 
Monitor.

There is tooltip for each point on the graphs and you can progressively drill 
down to a specific hour for more detailed data.
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Status Distribution

The Monitor Over Time Report displays a separate bar chart for each of the 
selected Monitors for the selected time period in the Status Distribution area.

The Monitor Over Time report displays the following data for the selected 
Monitor over the selected time period:

• Total % of Value/Duration Critical Violated Instances

The percentage of the total number of instances of the Monitor instances 
that completed with a Critical Violated status out of the total number of 
completed instances of the Monitor.

• Total % of Value/Duration Major Violated Instances

The percentage of the total number of instances of the Monitor instances 
that completed with a Major Violated status out of the total number of 
completed instances of the Monitor. 

• Total % of Value/Duration Minor Violated Instances 

The percentage of the total number of instances of the Monitor instances 
that completed with a Minor Violated status out of the total number of 
completed instances of the Monitor.

• Total % of Value/Duration Warning Violated Instances

The percentage of the total number of instances of the Monitor instances 
that completed with a Warning Violated status out of the total number of 
completed instances of the Monitor.

• Total % of Value/Duration Non-Violated Instances

The percentage of the total number of instances of the Monitor instances 
that completed with a Non-Violated status out of the total number of 
completed instances of the Monitor.

Tooltips for bars in the bar chart display the number of instances, the total 
number of instances, and the percentage and you can progressively drill down 
to a specific hour for more detailed data.
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Business Process Step Summary

Figure 36 is an example of a Business Process Step Summary report. Use this 
report to show summary information for a Business Process Step over a 
selected period of time.
The report is accessible from:
Applications > Business Process Insight > Reports > Business 
Process Step Summary

Figure 36 Business Process Step Summary Report
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The Business Process Step Summary Report displays two tables for a selected 
Business Process Step:

• Value table

This table lists the value of completed process instances at each Step, plus 
the average value of the active instances at each Step (backlog). 

• Count table

This table lists the total number of completed process instances at each 
Step, plus the average number of the active instances at each Step 
(backlog). 

The Business Process Step Summary Report is divided into the following 
areas:

• Report settings; see Table 73

• Value table; see Table 74

• Count table; see Table 75
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Table 73 describes the elements of the Business Process Step Summary 
Report settings (unlabeled GUI elements are shown in angle brackets).

Table 73 Business Process Step Summary Report Settings

GUI Element (A-Z) Description

<Common report
settings>

For details see section Common Report 
Elements in Reports.

Business Processes Click to open the Business Processes dialog 
box where you can select the Business 
Process whose Steps you want to report on. 
Select the required Business Process and the 
name of the process is displayed to the right 
of the link.

Show Select one of the following options:
• Value - Select to display value data for 

the Business Process Steps in the Value 
area.

• Count - Select to display Business 
Process Step count values in the Count 
area

• Select Both to display both the Step 
Value and Step Count values for the 
Business Process Steps. Both the Value 
and the Count area are displayed. This is 
the default.
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Table 74 describes the elements of the Value table (unlabeled GUI elements 
are shown in angle brackets).

Table 74 Business Process Step Summary Value Area Settings

GUI Element (A-Z) Description

Select a Business Process and click the 
Drill Down to Step Over Time Report 
button to drill down to the Step Over Time 
report for a selected Business Process Step. 
The report is displayed with the Value 
option selected.

Step Name The name of the selected Business Process 
Step. You can select to list the Steps in 
ascending or descending alphabetical order.
Tooltip: Displays the name of the Business 
Process Step.

Total Value of Completed 
Instance

Displays the total of the value attribute for 
all the Business Process Step instances that 
were completed in the selected time period.
Tooltip: Displays the value of the table cell, 
with value units (where value units are set).

Avg. Value of Backlog 
Instances

Displays the average value (backlog) of the 
active instances at each Step in the process 
over the selected time period.
Tooltip: Displays the value of the table cell.
332 Chapter 12



Table 75 describes the elements of the Count table (unlabeled GUI elements 
are shown in angle brackets).

Table 75 Business Process Step Summary Count Area Settings

GUI Element (A-Z) Description

Select a Business Process and click the 
Drill Down to Step Over Time Report 
button to drill down to the Business Process 
Step Over Time report for the selected 
Business Process Step. The report is 
displayed with the Count option selected.

Step Name The name of the selected Business Process 
Step.
Tooltip: Displays the name of the Business 
Process Step.

Number of Completed 
Instances

Displays the total number of the Business 
Process Step instances that were completed 
in the selected time period.
Tooltip: Displays the value of the table cell.

Avg. Number of Backlog 
Instances

Displays the average value (backlog) of the 
active instances at each Step in the process 
over the selected time period.
Tooltip: Displays the value of the table cell.
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Business Process Over Time Report

Figure 37 is an example of a Business Process Over Time Report. Use this 
report to show an over-time graph of information relating to the Business 
Process value and count data over a selected time period. 
The report data is shown in graphical form and can also be published in 
tabular form.
The report is accessible from:
Applications > Business Process Insight > Reports > Business 
Process Summary > Business Process Over Time

<Business Process Over Time Report displays two charts for each selected 
Business Process:

• Data

The Data graph displays data relating to the Value or Count for the 
selected Business Process over the selected time period.

• Health

The Health bar chart displays the overall health of the Business Process 
over the selected time.

The Business Process Over Time Report is divided into the following areas:

• Report settings; see Table 76

• Data; see “Data” on page 335

• Health; see Health on page 336
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Table 76 describes the elements for the Business Process Over Time Report 
settings (unlabeled GUI elements are shown in angle brackets).

Data

The Business Process Over Time report displays the following data for the 
selected Business Process over the selected time period:

• Total Value/Count of Completed Instances 

The total Value or Count of the completed instances for the selected 
Business Process.

• Avg. Backlog Value/Count 

Table 76 Business Process Over Time Report Settings

GUI Element (A-Z) Description

<Common report
settings>

For details see section Common Report 
Elements in Reports.

Business Processes Click to open the Business Processes dialog 
box where you can select a Business Process 
that you want to display.
You can select only Business Processes that 
have a Business Process Monitor defined for 
them. The name of the Business Process is 
displayed to the right of the link.

Show Is preselected when you enter the report 
according to the setting at the Parent 
Business Process Summary, you can change 
the selection as follows:
• Select Value to display value-related data 

for the Business Processes in the Value 
area.

• Select Count to display count-related 
data for the Business Processes in the 
Count area.
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The average Value or average Count for the backlog KPI for the selected 
Business Process. This average is taken from the total number of 
completed Business Process instances.

Tooltips for the over time graph display the same information for the selected 
entry and you can progressively drill down to a specific hour for more detailed 
data.

Health

The Business Process Over Time report displays the following health 
information for the selected Business Process over the selected time period:

• Avg. % of Blocked Instances or Avg. % of Blocked Instances 
Value

The percentage of the average number of instances of the Business 
Process, which are in the state of Blocked, measured from the total 
number of instances over the period. 

• Avg. % of At Risk Instances or Avg. % of At Risk Instances 
Value

The percentage of the average number of instances of the Business 
Process, which are in the state of At Risk, measured from the total 
number of instances over the period. 

• Avg. % of Healthy Instances or Avg. % of Healthy Instances 
Value

The percentage of the average number of instances of the Business 
Process, which are in the state of Healthy, measured from the total 
number of instances over the period.

Tooltips for the bars in the bar chart display the same information for the 
selected entry and you can progressively drill down to a specific hour for more 
detailed data.
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Business Process Step Over Time Report

Figure 37 is an example of a Business Process Step Over Time Report. Use 
this report to show an over-time graph of information relating to the Business 
Process Step status. The report data is shown in graphical form and can also 
be published in tabular form.
The report is accessible from:

Applications > Business Process Insight > Reports > Business 
Process Step Summary > Business Process Step Over Time

Figure 37 Business Process Step Over Time Report

Use this report to show information relating to the values and counts for 
Steps in the selected Business Process Step over a selected time period. 
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You can display either Value or Count information for the Steps as follows:

• Value 

This over-time graph shows the total value of completed instances and the 
average Backlog value of process instances at the selected Step.

• Count

This over-time graph shows the number of completed instances and the 
average number of Backlog instances at the selected Step.

Table 77 describes the elements for the Business Process Step Over Time 
Report settings (unlabeled GUI elements are shown in angle brackets).

Value

The Business Process Step Over Time report displays the following Value 
data for the selected Business Process Step over the configured time period:

Table 77 Business Process Step Over Time Report Settings

GUI Element (A-Z) Description

<Common report
settings>

For details see section Common Report 
Elements in Reports.

Business Processes Click to open the Business Processes dialog 
box where you can select the Business 
Process that you want to display data for. 

Steps: Click to open the Steps dialog box where you 
can select the Business Process Step that you 
want to display.

Show Is preselected when you enter the report 
according to the setting at the Parent 
Business Process Step Summary, you can 
change the selection as follows:
• Select Value to display value-related data 

for the Business Process.
• Select Count to display count-related 

data for the Business Process.
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• Total Value of Completed Instances 

The total Value of the completed instances for the selected Business 
Process Step.

• Avg. Value of Backlog Instances 

The average Value for the backlog KPI for the selected Business Process 
Step. This average is taken from the total number of completed Business 
Process instances.

Tooltips for the over time graph display the same information for the selected 
entry and you can progressively drill down to a specific hour for more detailed 
data.

Count

The Business Process Step Over Time report displays the following Count 
data for the selected Business Process Step over the configured time period:

• Number of Completed Instances 

The total number of the completed instances for the selected Business 
Process Step.

• Avg. Number of Backlog Instances 

The average number of instances for the backlog KPI for the selected 
Business Process Step. This average is taken from the total number of 
completed Business Process instances.

Tooltips for the over time graph display the same information for the selected 
entry and you can progressively drill down to a specific hour for more detailed 
data.
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13 Annotations for Process Diagrams
This chapter describes how to add annotations to your process diagram within 
the Flow Map on the Dashboard Application Flow Map page and the Business 
Process Insight Application Health page.

The chapter covers the following topics:

• Overview on page 342

• Customizing your Process Diagram on page 343

• Character Set Encoding on page 354
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Overview

BPI enables you to view any deployed Business Process. When displaying the 
process diagram, it annotates each of the steps by showing the number of 
active process instances and the Value of the total instances at each step.

Figure 38 shows an example of a process diagram when shown from the 
Health Page.

Figure 38 Process Diagram

BPI enables you to customize a process diagram as follows:

• You can configure a customized image for each step in the process.

• You can configure the text that is shown above each step.

As an example, you can customize your process diagram to be displayed as 
shown in Figure 39. In Figure 39, the instance values and the instance counts 
are shown on two of the steps and the End step is configured to show the total 
value of all completed instances.

Figure 39 Customized Process Diagram

USD8,821  1 USD26,457  3 T=USD77k
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Customizing your Process Diagram

You configure the changes that you want to make to your Process Diagram 
within a file called annotations.xml.

You create an annotations.xml file and then copy it to the following location, 
under the BAC installation hierarchy:

BAC-install-dir\lib

where BAC-install-dir is the installation directory for the Business 
Availability Center Gateway Server that the BPI Server is configured to 
connect to.

When BPI detects that the file exists, it uses the file when it draws a Process 
Diagram.

If the file annotations.xml does not exist, or if there is an error processing 
the xml, the file is ignored and the process diagram is shown as it would if the 
file does not exist. 

The Business Process Insight Problem Solving Guide provides some 
information on troubleshooting your system when your annotations are not 
displayed as expected.

annotations.xml File Format

The file annotations.xml is structured as follows:

<?xml version="1.0" encoding="..." ?>
<annotations>
    <step name="...">
      <texttype> ... </texttype>
      <textsymbol> ... </textsymbol>
      <textdp> ... </textdp>
      <scalesymbol> ... </scalesymbol>
      <image> ... </image>
    </step>

    ...further steps...

</annotations>

The following sections describe this structure in more detail and provide some 
examples configuration options.
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encoding=

The first line of the annotations file declares that this file contains XML and it 
declares the encoding used within this XML.

If your annotations include 8-bit Western European characters, then you 
could set the first line of the file to be:

<?xml version="1.0" encoding="ISO-8859-1"?>

The following are examples of other XML encodings you could use:

windows-1252
UTF-8
UTF-16

The XML encoding that you use depends on the editor you are using to create 
the annotations file and the type of characters you are using.

<annotations>

The annotations element simply encloses the set of step elements.

You must have one, and only one, annotations element within the 
annotations.xml file.

<step>

You define a <step> element for each step in the Process Diagram that you 
want to annotate.

BPI uses only one annotations.xml file, and there is no way to specify a 
Process Name in the annotations.xml. This means that when you specify a 
<step> element for a particular Process Step name, any process with a 
Process Step matching that name has that Process Step annotated when the 
process diagram is displayed within the process diagram. As a result, you 
might want to consider making sure that your step names are unique across 
your process definitions.

As an example, you might have a <step> element structured as follows:

<step name="New Order">
...
</step>

In this case, any process with a Process Step named New Order is annotated 
when BPI displays it as a Process Diagram.
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<texttype>

The texttype element enables you to specify the data that is displayed 
above the image of the Process Step.

You can specify one of the following values:

• count

This displays the number of active instance at this Process Step.

For example:

<texttype>count</texttype>

If you do not specify a texttype element, a value for count is 
automatically added to the Process Diagram.

When displayed within the Process Diagram, the value for count is 
displayed above, and slightly to the right, of the Process Step.

• value

This is the value of all the current active instances at the specified Process 
Step and as defined by the Process Value property for the Process.

For example:

<texttype>value</texttype>

When displayed within the Process Diagram, the Process Value of the 
active instances is displayed above, and slightly to the right, of the 
Process Step.
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• both

This enables you to display both the active count of process instances at 
this Process Step, and the active value of these instances.

For example:

<texttype>both</texttype>

When displayed within the process diagram, the value of the active 
instances is displayed above, and slightly to the left, of the Process Step, 
and the count of the active instances is displayed above, and slightly to 
the right, of the Process Step.

• none

If you do not want to show any text above the Process Step use option.

For example:

<texttype>none</texttype>

<textsymbol>

The textsymbol element enables you to specify a character sequence to 
display as part of the active instance value. This character sequence is usually 
displayed before the active instance value, but its position is localizable.

The textsymbol element is used only if you have specified a texttype 
setting of value or both.

For example:

<textsymbol>$</textsymbol>

<textdp>

The textdp element enables you to specify the number of decimal places to 
use when displaying the value attribute for active instances at a specified 
Process Step.

The textdp element is used only if you have specified a texttype setting of 
value or both.
346 Chapter 13



For example, you might set the value for textdp to be 2 as follows:

<textdp>2</textdp>

If you then have a value of 2.8765, this is shown as follows on the Process 
Diagram:

2.88

If you do not specify a textdp element, the value is shown with zero decimal 
places on the Process Diagram.

If you specify a negative value for the value of textdp, that is, a number 
between -1 and -100, then the number that you want to display is truncated 
by that number of digits, and the value rounded.

For example, you might set the following value for textdp:

<textdp>-3</textdp>

If you then have a value of 234567, this is shown as follows on the Process 
Diagram:

235

If you specify a negative value for textdp, you also need to specify a 
scalesymbol element, as described in section <scalesymbol> on page 348.
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<scalesymbol>

The scalesymbol element is used to define the symbol you want to be 
displayed with the active instances value to reflect the scaled number. In 
other words, if you have specified a textdp with a negative value then you 
need to set a scalesymbol to show the scaling that has occurred.

The following are examples of how you might set values for textdp and 
scalesymbol and the results that are displayed:

1 Example 1.
<textdp>-3</textdp>
<scalesymbol>K</scalesymbol>

If you then have a value of 234567, this is shows as follows on the Process 
Diagram:

235K

2 Example 2.
<textdp>-6</textdp>
<scalesymbol>M</scalesymbol>

If you then have a value of 1234567, this is shown as follows on the 
Process Diagram:

1M

<image>

The image element specifies a file name of an image that you want to be 
displayed in place of the standard Process Step image. The file name for the 
image is relative to the webapps directory.

For example, you might set the following:

<image>customimages/myImage.gif</image>

In this example, BPI looks for the file myImage.gif in the following 
directories; one under the BAC installation directory and one under the BPI 
installation directory:

bac-install-dir\AppServer\webapps\bpi.war\customimages

bpi-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\hpbpi-bpd\
                                                  customimages

You need to create the directory customimages, if it does not already exist.
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Examples

The following are examples of using the annotation element:

No Text on Process Step

If you do not want any text shown above your Process Steps, specify your XML 
as follows:

<step name="Process Order">
   <texttype>none</texttype>
</step>

In this example, the Process Order step is shown as in Figure 40.

Figure 40 No Text

A Custom Image for Process Step Image

If you want to replace the default Process Step image with a custom image, 
specify your XML as follows:

<step name="Process Order">
   <texttype>none</texttype>
   <image>customimages/engineer_on_call.gif</image>
</step>

In this example, the Process Order step is shown as in Figure 41.

Figure 41 Custom Image

This example assumes that the image file exists in the following directory:

BAC-install-dir\AppServer\webapps\bpi.war\customimages
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Value for Active Instances and Custom Image on a Process Step

If you want to show the value for the active instances on a custom image for a 
Process Step, specify your XML as follows:

<step name="Process Order">
   <texttype>value</texttype>
   <textsymbol>$</textsymbol>
   <image>customimages/engineer_on_phone.gif</image>
</step>

In this example, the Process Order step is shown as in Figure 42.

Figure 42 Active Value

This example assumes that the image file exists in the following directory:

BAC-install-dir\AppServer\webapps\bpi.war\customimages
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Scaled Active Value

If you want to show the value for the active instances that has been scaled and 
that also includes a custom image for a Process Step, specify your XML as 
follows:

<step name="Process Order">
   <texttype>value</texttype>
   <textsymbol>$</textsymbol>
   <textdp>-3</textdp>
   <scalesymbol>K</scalesymbol>
   <image>customimages/engineer_on_phone.gif</image>
</step>

In this example, the Process Order step is shown as in Figure 43.

Figure 43 Active Value Scaled

This example assumes that the image file exists in the following directory:

BAC-install-dir\AppServer\webapps\bpi.war\customimages
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Value and Instance Count

If you want to show both a value, which has been scaled, for the active 
instances and the number of active instances, plus a custom image for a 
Process Step, specify your XML as follows:

<step name="Process Order">
   <texttype>both</texttype>
   <textsymbol>$</textsymbol>
   <textdp>-3</textdp>
   <scalesymbol>K</scalesymbol>
   <image>customimages/engineer_on_phone.gif</image>
</step>

This displays the Process Order step as shown in Figure 44.

Figure 44 Both Value and Instance Count

This example assumes that the image file exists in the following directory:

BAC-install-dir\AppServer\webapps\bpi.war\customimages
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A Complete Process

The following is an example of the file annotations.xml for a complete 
process:

<?xml version="1.0" encoding="ISO-8859-1"?>
<annotations>
    <step name="New Order">
      <texttype>none</texttype>
      <image>customimages/phone_receiver.gif</image>
    </step>
    <step name="Process Order">
      <texttype>both</texttype>
      <textsymbol>$</textsymbol>
      <textdp>2</textdp>
      <image>customimages/engineer_on_phone.gif</image>
    </step>
    <step name="Ship Order">
      <texttype>both</texttype>
      <textsymbol>$</textsymbol>
      <textdp>2</textdp>
      <image>customimages/ship.gif</image>
    </step>
    <step name="End">
      <texttype>value</texttype>
      <textsymbol>$</textsymbol>
      <textdp>-3</textdp>
      <scalesymbol>K</scalesymbol>
      <image>customimages/success.gif</image>
    </step>
</annotations>

In this example, the Process Diagram is displayed as shown in Figure 45.

Figure 45 A Complete Process Diagram

This example assumes that the image files exists in the following directory:

BAC-install-dir\AppServer\webapps\bpi.war\customimages
Annotations for Process Diagrams 353



Character Set Encoding

If you want to create an annotations file that contains a specific character set 
encoding, for example, UTF-8, you need to ensure that:

• you use an editor that supports UTF-8.

• the editor that you use does not add any extra characters (hidden 
characters) to the file. As an example, Notepad writes three additional 
bytes to the start of a file, which although not visible within Notepad, 
create errors in the XML file that you create.

• you specify the first line of your XML as follows:

<?xml version="1.0" encoding="UTF-8"?>

In the UTF-8 example, if you specify UTF-8 as the XML encoding and do not 
use a corresponding UTF-8 editor when entering the UTF-8 characters, BPI 
fails to parse the file annotations.xml and therefore ignores your settings. 

You need to make sure that you use an editor that supports the character set 
encoding that you specify in your annotations file.
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14 Deleting Completed Instances from the 
Database
This chapter describes how to delete completed Process, Data and Monitor 
instances using the database instance cleaner options. 

Use the Business Impact Engine Instance Cleaner parameters for regular 
removal of completed instances from the database.

The instance cleaner parameters are not designed to enable individual 
instances to be manipulated nor do they enable you to name the process 
definitions or data definitions whose instances are to be deleted; these 
functions are provided by the Intervention tool.

Specifically this chapter describes:

• Business Impact Engine Process and Data Instance Cleaner Parameters 
on page 356. 

• Monitor Engine Instance Cleaner Parameters on page 363
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Business Impact Engine Process and Data Instance 
Cleaner Parameters

The Business Impact Engine (BIE) Instance Cleaner parameters enable you 
to control the numbers of Completed and Active Process and Data instances 
that are stored in the database. There are separate parameters for deleting 
Completed and Active Monitor instances from the database; see section 
Monitor Engine Instance Cleaner Parameters on page 363.

Using the BIE instance cleaner parameters, you can control: 

• how often the BIE Instance Cleaner thread marks Completed and Active 
Process and Data instances as candidates to be deleted.

• when the BIE Instance Cleaner clean-up thread is run

• how often active and completed process and data instances are deleted 
from the database (if at all) 

• the age of the instances that you delete

Following a new BPI installation, the BIE Instance Cleaner thread does not 
run and Completed and Active instances therefore accumulate in the 
database.

This section describes the behavior of these parameters and the SQL 
procedures, which you can modify to enable you to archive the data, before it 
is deleted, to a location of your choice. By archiving the data you have it 
available for your reporting tools, but it is no longer stored in the BPI 
database tables and therefore does not impact the performance of your 
system.

In summary, the instance cleaner parameters are intended for regular 
removal of Completed and Active instances as they occur during normal 
operations. They are not intended to be used for the removal of individual 
completed instances, or removal of instances in states other than the 
COMPLETED or ACTIVE state. Use the Intervention tool to remove individual 
instances; see section Chapter 7, Process Intervention.
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Configuring the BIE Instance Cleaner Parameters

You modify the instance cleaner parameters using the BPI Administration 
Console as described in section BIE Process and Data Instance Cleaner 
Settings on page 39.

These parameters enable you to mark instances as being candidates to be 
deleted. Instances are initially marked to be deleted but are not immediately 
deleted, to reduce the impact of the database activity on other Business 
Impact Engine activities. Once the instances have been marked as candidates 
to be deleted, they are subsequently deleted by the clean-up thread at 
intervals specified by the instance cleaner parameter values. You can specify 
the frequency that you want them deleted and the numbers of instances that 
you want deleted in one database Delete statement, using the parameters. 

In addition to modifying the instance cleaner parameters, you can modify the 
stored procedures invoked by the instance cleaner thread and add SQL 
commands to archive the Business Impact Engine data to a location of your 
choice; see section Archiving Completed and Active Process Instances on 
page 360. You should only archive BIE data when you understand the 
performance of the database.
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The following are some examples of how you can set the instance cleaner 
parameters to achieve specific outcomes, or requirements.

Example for Deleting Completed Instances

In the following example. you are deleting complete process instances from 
the database that are more than one day old and with a candidacy of once a 
day:

• From the Engine Process and Data Instance Cleaner settings:

— Set the Mark instances for deletion: option to Once a Day.

Enter 01:00 as the time for the instances to be marked. Pick a time 
when the database is not busy processing other BPI data.

— Set the Delete interval: option to 1 minute.

This is the interval at which the Process and Data instance cleaner 
thread runs and attempts to delete any Process and Data instances 
that are marked as being candidates to be deleted.

— Set the Delete batch size to 500

This is the number of instances that the instance cleaner thread 
attempts to delete each time it runs.

• From the Completed Process and Data Instances settings:

— Set the Delete completed instances from the database option to 
As scheduled above

The Completed instances are then deleted on the basis of the times set 
for the Engine Instance Cleaner thread.

— Set the Age of the completed instances to be removed 
(minutes) to two days, which is expressed in minutes (2880 minutes).
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Example for Deleting Active and Completed Instances

In the following example, you are deleting Completed process instances that 
have an age of more than 30 days, and Active process instances that have an 
age of more than 50 days, with a candidacy set to once a day:

• From the Engine Process and Data Instance Cleaner settings:

— Set the Mark instances for deletion: option to Once a Day.

Enter 01:00 as the time for the instances to be marked. Pick a time 
when the database is not busy processing other BPI data.

— Set the Delete interval: option to 1 minute.

This is the interval at which the Process and Data instance cleaner 
thread runs and attempts to delete any Process and Data instances 
that are marked as being candidates to be deleted.

— Set the Delete batch size to 1000

This is the number of instances that the instance cleaner thread 
attempts to delete each time it runs.

• From the Completed Instances settings:

— Set the Delete completed instances from the database option to 
As scheduled above

— Set the Age of the completed instances to be removed 
(minutes) to 30 days, which is expressed in minutes (43200 
minutes).

• From the Active Instances settings:

— Check the Delete active instances from the database? check 
box so the active instances are deleted on the basis of the Engine 
Instance Cleaner thread settings.

— Set the Age of the active instances to be removed to 50 days.
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Example for Deleting Completed Instances as Soon as They Are Complete

In the following example, Completed instances are deleted as soon as they are 
complete:

• Set the Engine Process and Data Instance Cleaner settings as 
required for the Active instances, as these settings are ignored in the case 
of the Completed Instances setting Immediately on completion.

• From the Completed Instances settings:

— Set the Delete completed instances from the database option to 
Immediately on completion

— Age of the completed instances to be removed (minutes) is 
also not applicable and is not an editable field.

Be aware that using this setting has the effect of removing data that 
might have a value for tracking purposes. If your process instances do not 
have long lives, then there is going to be very little data in the database to 
be reported on. Make sure that you do not need the data that you are 
deleting from the database.

• Set the Active Instances settings as required. 

Archiving Completed and Active Process Instances

You have the option to archive Completed and Active instances before they are 
deleted from the database by the instance cleaner thread. This enables you to 
remove data from the BPI database to improve performance, but still keep the 
data for reporting purposes. 

To archive the instance data, you need to make changes to the stored 
procedures or functions provided with BPI to delete the process and data 
instances. There are stored procedures for Microsoft SQL Server and 

You cannot archive Completed instances if you choose the option to Delete 
completed instances from the database Immediately on completion. 
This is because for this option, the instances are deleted as soon as the event 
that completes the instance is received.
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functions for the Oracle Server, both contain the SQL commands required to 
delete data from the BPI database and also provide a return code to the 
calling program. The following are the stored procedures/functions:

• bia_DeleteDataInstances

This procedure deletes the data instances in the COMPLETED state and that 
meet the criteria specified in the configuration. This stored procedure also 
provides the following SQL Cursor that you can use:

completedInstances_cursor

This stored procedure is available for Microsoft SQL Server only. 

You can add your custom SQL statements to the stored procedure in order 
to archive the Business Process data before it is deleted.

• bia_DeleteFlowInstances

This procedure deletes all process instances in the COMPLETED state that 
meet the criteria specified by the configuration. This stored procedure also 
deletes the associated Step instances, Step started and Step completed 
times, and any monitors that are defined for the process instance.

• DeleteActiveDataInstances

This procedure deletes the data instances in the ACTIVE state and that 
meet the criteria specified in the configuration. This stored procedure also 
provides the following SQL Cursor that you can use:

activeInstances_cursor

This stored procedure is available for Microsoft SQL Server only.

As for the bia_DeletedDataInstances procedure, you can add your 
custom SQL statements to the stored procedure in order to archive the 
Business Process data before it is deleted.

• DeleteActiveFlowInstances

This procedure deletes all process instances in the ACTIVE state that meet 
the criteria specified by the configuration. This stored procedure also 
deletes the associated Step instances, Step started and Step completed 
times, and any monitors that are defined for the process instance.

These stored procedures or functions are contained in the following SQL file:

bpi-install-dir\misc\bia\EngineStoredProcedures_script.sql
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There are also examples of this file located at:

• bpi-install-dir\examples\bia\EngineScripts

• the examples directory on the distribution media

The example files are named as follows, according to the database:

• EngineStoredProcedures_script.mssql

• EngineStoredProcedures_script.oracle 

You need to make your changes to the stored procedures, which have been 
created in the database for BPI, to add the SQL to archive the Completed or 
Active instances.

You are also advised to make changes to the following SQL script and make a 
backup copy of the script to ensure that you have a copy of the changes:

bpi-install-dir\misc\bia\EngineStoredProcedures_script.sql

The instance cleaner parameters are executed at the frequencies specified in 
the Engine Instance Cleaner Settings. The value of the Age of the 
completed instances to be removed and Age of the active instances 
to be removed parameters is passed to the stored procedure, or function, 
when it is called.

Be aware that changes to the SQL file 
EngineStoredProcedures_script.sql are lost if you reinstall or upgrade 
BPI. Make sure that you have made backup copies of your modifications, 
which you can then reapply following a reinstallation.

It is possible for two data instances to be created, each representing the same 
Business Process: one in the BPI Instance database and one in the archive 
database. This occurs when an out-of-sequence event is received by the 
Engine after the Completed or Active instances are archived and deleted. An 
out-of-sequence event is where an event is received by the Business Impact 
Engine for an activity in a process instance that is earlier than the latest 
event received for the same process instance.

In summary, you need to ensure that your archive code can take account of 
the fact that there might be more than one instance that represents the same 
Business Process when this scenario exists.
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Monitor Engine Instance Cleaner Parameters

The Monitor Engine Instance Cleaner parameters enable you to control the 
numbers of monitor instances that are stored in the database. These include:

• Active monitor instances

• Completed monitor instances

• Monitor statistics

• Monitor alarm instances

There are separate parameters for deleting Completed and Active business 
impact Engine instances from the database; see section Business Impact 
Engine Process and Data Instance Cleaner Parameters on page 356.

Using the Monitor Engine instance cleaner parameters, you can control:

• how often the Monitor Engine Instance Cleaner thread is run.

• how often active and completed monitor instances are deleted from the 
database (if at all).

• how often monitor statistics are deleted from the database (of at all).

• how often monitor violation instances are deleted from the database (of at 
all)

• for all monitor instances, the time and the age of the instances that you 
delete.

Following a new BPI installation, the Monitor Engine Instance Cleaner 
thread does not run and the different monitor instances therefore accumulate 
in the database.
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Configuring the Monitor Engine Instance Cleaner Parameters

You modify the Monitor Engine instance cleaner parameters using the BPI 
Administration Console as described in section Monitor Engine Instance 
Cleaner Settings on page 63.

These parameters enable you to delete the Monitor Engine instances 
periodically, using the instance cleaner thread, as specified by the instance 
cleaner parameter values. 

You can control how often the monitor instance cleaner thread is executed and 
the age of the specific monitor instances that you want to delete. Each type of 
monitor instance can be separately controlled. 

The following are some examples of how you can set the Monitor Engine 
instance cleaner parameters to achieve specific outcomes, or requirements.

Example for Deleting Completed Monitor Instances

If you want to delete completed monitor instances from the database, which 
are more than one day old and once a day, set the monitor engine instance 
cleaner parameters as follows:

• From the Monitor Engine Instance Cleaner settings:

— Set the Instance cleaner execution interval (minutes) to 5.

• From the Completed Monitor Instances settings:

— Select the Delete completed monitor instances from the 
database? option in order to activate the Age of completed 
monitor instances to be removed (days) option.

— Set the Age of completed monitor instances to be removed 
(days) option to 2.

• Set the other option as appropriate for your implementation.
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15 Servlet Engine Authentication
This chapter describes how to use the Memory Realm mechanism within the 
Servlet Engine (Tomcat) to:

• modify the login details for the BPI Web-based interfaces, which are the 
process instance and violation pages, which are accessible from the 
Business Process Insight Application pages.

• configure the use of HTTP over SSL for BPI

The chapter is structured as follows:

• Tomcat Realm Mechanism on page 366

• Tomcat and HTTP Over SSL on page 372

The BPI components that can be configured for authentication using the 
Servlet Engine are:

• Process Repository, which affects both the Repository Explorer and the 
Modeler.

Setting authentication for the Process Repository also impacts any 
Contributed components that use the repository.

• Intervention tool

• Notification pages

• Monitor Definer

• Process instance and violation pages

With the exception of the process instance and violation pages, each of these 
components requires you to provide a username and password in order to 
access the Web screens. Following a new BPI installation, the username and 
password for these components are predefined as:

• Username: admin

• Password: hpbpi
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Tomcat Realm Mechanism

BPI uses Tomcat as its Servlet Engine to present JSPs to the user, through a 
Web browser; starting the Servlet Engine is described in section Starting and 
Stopping the BPI Server Components on page 27. For authentication, BPI 
uses the Tomcat Realm mechanism, specifically it uses the Memory Realm 
mechanism, which is more fully described in the Tomcat documentation at the 
following URL:

http://jakarta.apache.org/tomcat/tomcat-5.0-doc/realm-howto.html

Within the Tomcat documentation, a Realm is described as a database of 
usernames and passwords, which identify valid users of a Web application (or 
set of Web applications), plus a list of roles associated with each valid user.

Within BPI the following roles have been defined:

• ovbpi-model-repository, which is the role for the Repository Explorer 
and the Modeler; see Chapter 4, Modeler and Chapter 6, Process 
Repository Explorer.

• ovbpi-notify-admin, which is the role for the Notification pages; see 
Chapter 8, Notification.

• ovbpi-int-client, which is the role for the Intervention tool; see 
Chapter 7, Process Intervention.

• ovbpi-metric-definer, which is the role for the Web-based Monitor 
definition interface; see Chapter 5, Monitor Definer.

• ovbpi-event-injector, which is for a contributed tool and is provided on 
the BPI media.
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There is an XML file called tomcat-users.xml, which the credentials for 
these roles. The file is located at:

bpi-install-dir/nonOV/jakarta-tomcat-5.0.19/conf

If you have upgraded from a previous version of BPI, there is another XML 
file located in the same directory as follows:

bpi-install-dir/nonOV/jakarta-tomcat-5.0.19/conf/
tomcat-users.xml.versionstring

where versionstring is the version number of the product. 

You need to compare the new file, which includes the version string, with your 
existing tomcat-users.xml configuration file and modify tomcat-users.xml 
to include any changes shown in the newly installed file.

The reason that the BPI installation procedure does not replace the file is 
because you might have made your own changes to the file, which you do not 
want to be overwritten.

Following a new installation, the file has the following content:

<?xml version='1.0' encoding='utf-8'?>
<tomcat-users>
  <role rolename="ovbpi-model-repository"/>
  <role rolename="ovbpi-int-client"/>
  <role rolename="ovbpi-notify-admin"/>
  <role rolename="ovbpi-metric-definer"/>
  <role rolename="ovbpi-event-injector"/>
   <user username="admin" password="hpbpi" 
roles="ovbpi-notify-admin,ovbpi-int-client,ovbpi-event-injector,
ovbpi-metric-definer,ovbpi-model-repository"/>
</tomcat-users>

You are strongly advised to assign different credentials to the different roles 
in order to increase the security of your system. This is particularly the case 
for the Intervention tool, from where you can delete active process instances 
and data instances.
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Modifying Login Credentials

To assign different credentials, you need to edit the XML file that defines the 
roles and the login credentials. The following is an example of how you can do 
this:

<?xml version=’1.0’ encoding=’utf-8’?>
<tomcat-users>
 <role rolename="ovbpi-model-repository"/>
  <role rolename="ovbpi-int-client"/>
  <role rolename="ovbpi-notify-admin"/>
  <role rolename="ovbpi-metric-definer"/>
  <role rolename="ovbpi-event-injector"/>

  <user username="inject" password="inject"
    roles="ovbpi-event-injector"/>
  <user username="interv" password="secret"
    roles="ovbpi-int-client"/>
  <user username="notif-admin" password="admin"
    roles="ovbpi-notify-admin"/>
  <user username="monitor" password="secret"
    roles="ovbpi-metric-definer"/>
  <user username="model-repository" password="admin"
    roles="ovbpi-model-repository"/>
</tomcat-users>

In this example, the following clients now have a separate username and 
password:

• The ovbpi-event-injector role for the contributed tool has a username 
and password of inject.

• The ovbpi-int-client role for the Intervention tool has a username of 
interv and a password of secret.

• The ovbpi-notify-admin role for the Notification pages has a username 
notif-admin with a password of admin.

• The ovbpi-metric-definer role for the Monitor Definer interface has a 
username of monitor and a password of secret.

• The ovbpi-model-repository role for the Process Repository (used 
within the BPI Modeler) has a username model-repository with a 
password of admin.
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To make changes to the tomcat-users.xml file, complete the following steps:

1. Make sure that you have logged out of the BPI Modeler, Notification pages 
and the Intervention tool.

2. If you are using the Event Injector contributed component, you must also 
close the Event Injector.

3. Open tomcat-users.xml in a text editor:

bpi-install-dir/nonOV/jakarta-tomcat-5.0.19/conf/
tomcat-users.xml

4. Make your required changes to the file.

5. Save and close the tomcat-users.xml file.

6. Make your changes to the Security settings in the Administration 
Console as required.

7. Stop and restart all the BPI components from the Status pane of the BPI 
Administration Console for the changes to take effect.

You must stop and restart all the BPI components when you change the 
security options, if you do not, some of the security settings can be 
compromised.

Memory Realm is a simple implementation of the Tomcat 5 Realm interface. 
It is described in the Tomcat documents as a demonstration implementation 
and not designed for production use.
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Modifying Servlet Engine Files

If you intend to modify the Servlet Engine configuration files, you need to be 
aware that changes made directly to the Servlet Engine files are overwritten 
by BPI configuration files. As an example, if you want to configure another 
form of Tomcat Realm security, you would expect to make the changes in the 
web.xml and server.xml files under the following directory:

bpi-install-dir\nonOV\jakarta-tomcat-5.0.19\conf

However, before making any changes to these files, you need to be aware of 
how BPI manages configuration changes to the Servlet Engine files. BPI 
overwrites the Servlet Engine configuration files in order to add BPI-specific 
configuration details and as a result of your making changes to configuration 
parameters using the Administration Console. BPI overwrites the Servlet 
Engine configuration files whenever a change is made to any parameter using 
the Administration Console, it does not have to be a Servlet Engine specific 
change.

If you want to make changes directly to the Servlet Engine configuration files, 
you need to make the modifications in the BPI-specific configuration files and 
then make sure that BPI propagates these modifications to the Servlet Engine 
files.

BPI has a number of configuration files and the Servlet Engine files related to 
web.xml and server.xml are located under the following directory:

bpi-install-dir\newconfig\DataDir\conf\bia\tomcat\conf
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These files are database specific and you need to modify the files that are 
appropriate to your configuration. 

If you are using Oracle, you need to modify the following files:

bpi-install-dir\newconfig\DataDir\conf\bia\tomcat\conf\
                                      server.engine.oracle.xml
bpi-install-dir\newconfig\DataDir\conf\bia\tomcat\conf\
                                      server.views.oracle.xml

If you are using SQL Server, you need to modify:

bpi-install-dir\newconfig\DataDir\conf\bia\tomcat\conf\
                                        server.engine.mssql.xml
bpi-install-dir\newconfig\DataDir\conf\bia\tomcat\conf\
                                        server.views.mssql.xml

When you have made the required changes to these files, you need to 
artificially make a change to any parameter using the Administration Console 
and apply the change. As a result of this change, the Administration Console 
updates all the relevant configuration files, including the Servlet Engine files, 
and your modifications are then propagated to these files.
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Tomcat and HTTP Over SSL

HTTP over SSL (secure socket layer) is a secure version of HTTP. SSL enables 
the data from a client, such as a Web browser, to be encrypted prior to 
transmission to prevent unauthorized access to the data being transmitted. 

Using SSL, the Web Server and the Web browser (client) establish a secure 
connection, which enables them to trust each other and send data knowing 
that the connection is secure. In order to do this, a level of authentication is 
required and this is provide through Certificates. You obtain Certificates from 
a Certificate Authority (CA).

You can configure HTTPS for the Tomcat Servlet Engine installed with BPI 
and then enable the use of HTTPS for your BPI Web applications using the 
Administration Console. Note that the use of SSL is between the BPI Servlet 
Engine and the BPI Web applications only. Other HP BTO Software products 
can also be configured to use SSL; however, BPI can not be configured to use 
SSL as a means of communicating with these other HP BTO Software 
products.

There are two aspects of configuring HTTPS for BPI, one aspect is related to 
the Servlet Engine configuration and one to the Web client configuration. 
These are described in the following sections.

Servlet Engine Configuration

In order to configure the Tomcat Servlet Engine to support HTTPS, you need 
to obtain an SSL certificate. SSL uses public key cryptography, which is based 
on key pairs. These key pairs contain one public key and one private key. 
These keys are used by the Servlet Engine to enable HTTPS on the machine 
where the BPI components are running. When installed the certificate 
encrypts the data that is sent from the Servlet Engine to the Web client, or 
Web browser.

There is more than one form of keystore, which is a repository of certificates 
used for identifying a client or a server. The Java Keytool generates a key 
based on the JKS format of keystore. There is also a PKCS12 format of 
keystore; however, this cannot be used with BPI. You can use only the JKS 
format as generated from the keytool command.
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The following are ways that you can obtain, or generate, a certificate:

1. Using the Java Keytool

Keytool is a key and certificate management utility that ships with your 
Java distribution. It enables users to administer their own public/private 
key pairs and associated certificates for use in self-authentication or data 
integrity and authentication services, using digital signatures.

Use the keytool command, from a Command Window, to generate a Java 
Key.

2. From a Certificate Authority

You can obtain SSL certificates from Certificate Authorities (CA) such as 
Verisign.

In order to obtain and SSL certificate from a CA, you first need to 
generate a Certificate Signing Request (CSR) for the Certification 
Authority to sign. You can do this using the Java Keytool. When 
generating this certificate make sure that you supply the fully qualified 
domain name of the machine where the BPI is installed as the common 
name (cn) attribute.

The CSR certificate and the certificate chain received from the CA need to 
be stored in a JKS keystore file.

When you have obtained all the required information and configured the 
Servlet Engine to send HTTPS requests, you can use the Administration 
Console to enable HTTPS as the protocol to be used to send data to one or 
more of the BPI Web Clients. This is done through the Security options; see 
section Security on page 91.

Web Client Certificate-Based Authentication

You can also use the Servlet Engine to provide certificate-based client 
authentication, based on HTTPS, for your Web applications:

• Process instance and violation Web pages

• Repository Explorer

• Monitor Definer

• Intervention tool 

• Notification Server Administration
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In order to use client authentication, you first need to configure the Servlet 
Engine to be able to send HTTPS requests to the Web Browser, as described in 
section Servlet Engine Configuration on page 372. You need to configure the 
Servlet Engine on each system where it installed. You then need to obtain a 
client certificate, which is signed by a CA, plus a CA root certificate.

In order for the Servlet Engine to be able to receive encrypted data from the 
Web Browser, you need to enable client authentication to ensure only Web 
browsers presenting a valid certificate can authenticate with the Servlet 
Engine. 

Each CA provides a root certificate, which you install, or import, for your Web 
Server (in this case the Tomcat Servlet Engine). The Servlet Engine uses this 
certificate to determine whether or not it trusts the data being sent from the 
Web Browser. You obtain this root certificate from your CA. When you have 
the certificate, you import it into the keystore for your Java distribution. The 
root certificate needs to be imported so it can become a trusted certificate, 
enabling a chain of authorization to be established between the Web Server 
and the Web Browser. 

The keystore location for the Servlet Engine is as follows:

Java-home\jre\lib\security\cacerts 

The Administration Console allows you to select a keystore file from any 
location; however, the Tomcat Servlet Engine requires the keystore to be 
located on a local hard drive. The keystore must not be located on a virtual or 
network drive.

You import the certificate using the keytool utility that comes with your Java 
distribution, using the following command:

keytool -import -keystore java-home/jre/lib/security/cacerts 
-storepass changeit -alias rootca -file rootca.pem -trustcacerts

where:

• java-home is the directory where your Java distribution is installed.

• changeit is the default password for the Java security keystore for a new 
Java installation.

Type yes when prompted if you trust this certificate
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When you have imported the root certificate on the Web Server, you then need 
to import both the root certificate and the client certificate on each Web 
Browser where you intend to use the BPI Web-based interfaces (or those for 
which you want to enable HTTPS). Follow the instructions in you Web 
Browser documentation for installing Certificates.

When you have completed the configuration to set up your Web Browser to 
Web Server HTTPS connection, you can use the Administration Console to 
enable certificate-based client authentication. This is done through the 
Security options; see section Security on page 91. Client authentication is 
used only for those clients where you have also enabled HTTPS as described 
in section Servlet Engine Configuration on page 372.
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16 High Availability Using Microsoft 
Clusters
A highly available system is one that enables applications and services to 
continue after hardware and software failures, thus reducing the time when 
the system is not available for use; also known as downtime. You can have 
planned downtime, where you have set aside time for maintenance tasks, such 
as upgrading, and you can have unplanned downtime. Unplanned downtime is 
where the system fails due to events such as hardware and software failures.

High availability in terms of BPI is where your BPI system is always available 
when it is planned to be available and fail over mechanisms are in place to 
minimize, or eliminate, unplanned downtime.

A Microsoft Server Cluster can provide some of the high availability 
capabilities, but it cannot provide a complete solution for high availability 
with no single point of failure. You need to make sure that your BPI 
deployment includes other protection mechanisms for disks, networks, power 
supplies, memory, controllers and systems; for example:

• dual power supplies to BPI systems

• dual paths from system to disks

• dual network controllers

• uninterruptable power supplies (UPS)

• disk mirroring and (or) the use of redundant arrays of inexpensive disks 
(RAID) 

In other words, to achieve the maximum availability of your system, you need 
to build in redundancy at all levels. 

You can install BPI in a Microsoft Server Cluster environment in order to 
provide a high-availability solution for BPI. By using the cluster technology 
when one node in a cluster fails or is taken offline another node in the cluster 
takes over the failed node’s operations. When BPI functions are moved from 
one node in the cluster to another node, users can experience some temporary 
interruption in their use of BPI, but this interruption is minimal.
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Modes of High Availability

There are two modes of high availability that are offered by Microsoft:

• Active / Passive

In this mode, one node in the cluster hosts an application at any given 
time; this can be likened to having a standby system in place.

• Active / Active

In this mode, different instances of the same application are running 
concurrently on different nodes in the cluster. In this mode, when a node 
fails the remaining nodes in the cluster need to take on additional load 
and this can impact performance.

BPI must be deployed in the Active/Passive mode within the cluster. You 
cannot use the Active/Active mode with BPI.

By supporting Microsoft Server Clusters in an Active/Passive mode, BPI 
Services are automatically restarted on an alternative machine, if the 
machine on which they are currently running fails for any reason.

A Microsoft Server Cluster can support up to eight nodes; however, in an 
Active/Passive mode, BPI requires only two nodes to be configured within the 
cluster. You can configure additional passive nodes for BPI to keep to a 
minimum the single points of failure, but it is not needed in order for BPI to 
operate within the Server Cluster.

Each node within the cluster can host one or more resource groups. A resource 
group is a collection of components that are managed and viewed as a single 
unit within the cluster; for example, a public file share, a Web server, and a 
database application can all be managed as resources. BPI is managed as a 
Resource Group within the cluster. The use of Resource Groups enables you to 
manage the order in which resources are started within the cluster, and 
dependencies between resources. This then enables you to specify specific 
dependencies for BPI; for example, the dependency between BPI and its 
database.

The nodes and the resources within the cluster are constantly monitored and 
in the event of a failure on the node where BPI is running, the workload of the 
failed node is re-started on another designated node. Note that there is an 
interruption to service while BPI is in the process of failing over and following 
the failover, the BPI Modeler needs to be restarted as it has lost its connection 
to the Process Repository. 
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In Figure 46 Node A and Node B are both configured to run BPI in Active/
Passive mode. Node A is currently hosting BPI. If Node A fails for any reason, 
the cluster can start BPI on Node B.

Figure 46 BPI Operating on Two Nodes in a Cluster

In order for the failover to be successful, both Node A and Node B must have 
access to the BPI data. This includes the installation data and configuration 
files on disk, plus all the Process, Monitor and Events data in the database. In 
Figure 46 it is only Nodes A and B that have this access. Nodes C and D are 
also operating in the cluster but are not available for BPI failover. 

The BPI shared data device is a resource that needs to be managed by the 
cluster and must therefore reside within the bounds of the cluster. The BPI 
database might or might not be managed by the cluster, depending on how 
you have configured your system. In this case, the device where the database 
is located might or might not be managed as part of the cluster.

The documentation for the Microsoft Server Cluster provides details of the 
hardware configuration require, plus recommendations for using technology 
such as RAID for the shared storage to minimize the single points of failure.
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There is also a cluster configuration database that must be accessible to all 
the nodes in the cluster and which contains information such as the 
membership of the cluster, the configuration data and quorum information.

You can have additional nodes in the cluster made available for BPI failover if 
you want to minimize the your single points of failure. In Figure 47 BPI has 
also been installed and configured on Node C, which means that either Node 
B or Node C can be used as a failover system if needed. Note that Node C is 
also available as a failover node for another application whose data is stored 
on a different device to that used by BPI.

Figure 47 BPI Operating on Three Nodes in a Cluster
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Configuring BPI Within a Microsoft Cluster

This section describes the BPI-specific tasks that you need to complete in 
order to have BPI operate within the Microsoft Server Cluster environment. 
The section assumes that the Server Cluster has been configured to meet your 
organizational requirements; it does not provide any information relating to 
the installation and setup of the cluster. Refer to the Microsoft Server Cluster 
documentation for this information.

In order to have BPI operate within a cluster environment, it is necessary to 
install BPI on each node in the cluster that you want BPI to run on. This does 
not mean you have to install BPI on every node in the cluster; see section 
Modes of High Availability on page 378.

You need to install BPI multiple times, even though each node has access to 
the same shared install directory and database. This is to ensure that the BPI 
Windows Services are created on every node where BPI is to run. You also 
need to install and register the BPI license on each node on the cluster where 
BPI is to run; see section Licenses for BPI in a Cluster Environment on 
page 385 for more information about licensing BPI in a cluster environment.

If you do not install on each node, it is not possible to configure the BPI 
Windows Services as generic service resources for the cluster. This is because 
the Cluster Administrator checks that each generic service exists on every 
node where the resource is configured in order to restart it in the event of a 
failover.

Groups

BPI installs a number of Windows services, therefore one way to configure 
BPI within the cluster is to set up the services using the Generic Service 
resource type; for example, resources can be grouped as self-contained 
resource groups, called Groups. How you configure a resource within the 
cluster is outside the bounds of this document. You need to read the 
information provided by Microsoft to determine the best configuration for 
your requirements.
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The following are suggested scenarios for grouping the BPI resources:

1. Configure a self-contained resource group for BPI resources and have the 
database outside the cluster environment. The means that if there is a 
catastrophic cluster failure, the BPI data is still accessible for browsing 
and for analysis.

This configuration enables a specific disk drive (or partition), IP address 
and virtual server name to be assigned to BPI and BPI can then be moved 
between nodes as an independent resource.

2. Configure a self-contained resource group for BPI resources and have the 
database installed as a cluster application. You then configure the BPI 
resources to be in the same resource group as the database. 

In this case, BPI can share the disk, virtual server name and IP address of 
the database. This enables you to define specific dependencies between 
BPI and the database and the database and BPI can be treated as a single 
entity and operates as described in scenario 1. In addition, you need only 
allocate one disk and host name.

3. Configure a self-contained resource group for BPI resources and have the 
database installed as a cluster application. You then configure the BPI 
resources to be in a different resource group to the database.

By allocating different resource groups to BPI and the database, each can 
failover independently of the other, which minimizes the potential 
downtime of the BPI system. In addition, BPI can be moved between 
nodes as an independent resource as in scenario 1. 

You also need to assign the following resource types to BPI:

• An IP Address resource

• A Network Name resource

These resource types become the virtual server name and address that BPI 
clients must use to access the BPI Server within the cluster. This virtual 
server name is valid for whichever node in the cluster BPI is configured to run 
on and should be used as the BPI Server name when configuring the BPI 
Host Name property in the Infrastructure Settings:

Admin > Platform > Infrastructure > Business Process Insight

Note that when a specific physical disk partition is assigned to BPI, it cannot 
be shared by another resource group.
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Having all the BPI resources in the same resource group enables you to define 
dependencies between the BPI services, and the disk and network resources. 
This means that the cluster manager does not try to start BPI unless all the 
required resources are available.

When you have identified how you want to manage the BPI resources within 
the cluster, use the Cluster Administrator to create the new resource groups.

Summary of Configuration Requirements on page 383 provides a summary of 
the nodes that you need to take to set up BPI within a Microsoft cluster 
environment.

Summary of Configuration Requirements

The following is a summary of the nodes that you need to complete in order to 
install and configure BPI on an existing Microsoft Server Cluster:

1. Make a decision on how you are going to configure the BPI Services as 
resource groups; that is, whether they have a dedicated resource group, or 
whether the BPI services are added to an existing resource group.

2. If BPI is to have a dedicated resource group, allocate a shared physical 
disk for BPI. 

If BPI is to share an existing resource group, you can choose to allocate a 
different (and unique) shared physical disk for BPI, or use the shared 
physical disk already defined for the group. As an example, there might be 
a resource group already allocated for the database and you can use the 
same shared physical disk or allocate a different one.

3. Allocate an IP address and network name for BPI. If BPI is sharing a 
resource group, these details already exist. If you are creating a resource 
group specifically for BPI, you need to allocate a unique IP address and 
network name.

4. If you are configuring a new resource group for BPI, use the Cluster 
Administrator to create a new resource group. In this new group, create 
the resources for the allocated physical disk, the BPI IP address and 
network name.
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5. Ensure that the version of the J2SE required by BPI is accessible to each 
node of the cluster where you want to install and run BPI.

To avoid multiple installations, you can install the J2SE on the shared 
disk, where it is accessible to all the BPI instances operating in the 
cluster. You can also choose to install it on a disk that is local to each node, 
in this case, the installation path must be the same on every node, for 
example c:\Program Files\java. 

6. From a node in the cluster where the physical disk resource that you want 
to use for BPI is active, install BPI. You need to provide the following, 
cluster specific, information as part of the installation:

a. When the BPI installer prompts for the installation directory, enter 
the drive letter of the allocated physical disk for BPI. 

b. When the BPI installer prompts for the database host name and the 
database is installed within the cluster environment, use the virtual 
network name allocated to the database; do not use localhost as the 
hostname.

7. For each of the other nodes where you want BPI to be able to run (or 
failover to), use the Cluster Administrator to make the disk for BPI active 
on that node. When the disk is active, you can install BPI on the node. 
These subsequent installations are identified and treated as 
reinstallations by the BPI installation procedure. The installer detects the 
previous installation on the shared disk and presents as defaults the 
installation details that it finds, including the database details. This 
means that any existing data in the database is preserved and it is 
therefore possible to add new nodes to the cluster at a later time.

8. Use Cluster Administrator to create the following new Generic Service 
resources in the BPI resource group for the following services:

— OVBPIAdminServer

— OVBPIBACDataSamplesProvider

— OVBPIEngine

— OVBPIEventHandler

— OVBPIJmsEventHandler

— OVBPIMetricEngine

— OVBPIModelRepository

— OVBPINotificationServer
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— OVBPIServiceAdapters

— OVBPIServletEngine

— OVBPIWebServicesProvider

If you have BPI adapters that also have services, you can create generic 
services for these in the same way.

9. Set the OVBPIAdminServer resource to be dependent on the shared disk 
and virtual network name resources used by BPI. If the 
OVBPIAdminServer service is in the same resource group as the 
database, it must also be made dependent on the database server 
resource.

10. For each of the BPI services, set the resource name to be the same as the 
service name. 

11. Set all the remaining BPI resources to be dependent on the 
OVBPIAdminServer resource.

12. Make sure that any BPI adapters access BPI using the virtual server 
name.

You can test the cluster installation and configuration by checking that the 
BPI group can be made online using the Cluster Administrator and that the 
BPI Modeler can access BPI using the configured virtual network name.

Licenses for BPI in a Cluster Environment

You need to obtain and install a separate BPI licence on every node of the 
cluster where BPI is installed.

In the Active/Passive mode of cluster configuration, BPI is operational on one 
node only at any one time; the active node. You therefore need purchase only 
one set of the required Business Process licenses for this Active/Passive 
cluster configuration. However, as BPI license keys are linked to a specific 
Node Name, and you need install BPI license keys on each cluster node where 
BPI in installed. You therefore need to obtain additional licenses for failover 
(passive) nodes in the cluster. 

For this purpose, a set of additional complimentary license products has been 
created for BPI, and you can order and use these licenses for the failover 
nodes in the cluster (for each of the passive nodes you want to configure). You 
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need to order these additional licenses using the product numbers that 
correspond to the licensed product, or products, that you have already 
purchased.

To obtain these complimentary licenses, you need to contact the HP Password 
Delivery Service. You do this after you order and receive your initial BPI 
licenses. Your request for additional licenses needs to include the original 
order number.

The following URL takes you to the HP Password Delivery Service Web page:

http://www.webware.hp.com

In the left-hand menu is a link for contacting the Password Delivery Center, 
where you can find contact details for your region.

Full details of the complimentary product numbers can be found in the BPI 
product Data Sheet. The Data Sheet is available from the BPI product page of 
the Management Software Web site:

http://www.hp.com/managementsoftware

Section Cluster License Example on page 387 provides an example of an BPI 
cluster configuration.
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Cluster License Example

BPI is to be installed on two nodes in your cluster. The virtual server name for 
this BPI resource BPI_apple. The node names of the physical nodes in the BPI 
cluster are BPI_one and BPI_two; see Figure 48.

Figure 48 Cluster Licensing

You purchase one BPI LTU for Enterprise Foundation on node BPI_one. The 
following are examples based on the BPI version 2.10 product numbers:

BB185AA         HP BPI Enterprise Foundation LTU

You also need to request one complimentary license for BPI_two as follows:

BB185AA-COMP    HP BPI Enterprise Foundation LTU

When referencing these nodes from within the cluster set up, you use the 
actual server names (BPI_one and BPI_two).

Use the Cluster Administrator to configure the BPI Resource Group on each 
node in turn. When the Resource Group is online, you can request and install 
the appropriate BPI license using the Administration Console on that node.
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Reinstalling BPI In a Cluster

You can reinstall BPI in the cluster using the instructions in Deploying 
Business Process Insight. You need only install BPI on one node in the cluster 
to reinstall, as this process updates the files and directories on the shared 
disk. 

The only time you need to install BPI on all the nodes in the cluster is if there 
is a change to the local information, for example, BPI service definitions or 
shortcuts.

Removing BPI From the Cluster

Use the instructions in Deploying Business Process Insight to remove the BPI 
files from the shared disk.

Note that you can use the uninstall procedure only for the first node in the 
cluster where you want to remove BPI. This is because the all the files and 
directories on the shared disk have already been removed.

The following are still present on each of the other nodes in the cluster where 
BPI is installed:

• BPI component shortcuts

• BPI services

• personal configuration files for the BPI Modeler and the BPI 
Administration Console

These need to be removed as required; see the Business Process Insight 
Problem Solving Guide for information about removing BPI Services.

Other Considerations

The following are other points that you need to be aware of when configuring 
BPI to operate within a cluster environment:

• When you shut down the BPI components using the BPI Administration 
Console, the cluster server attempts to automatically restart them. You 
can modify this behavior from the Cluster Administrator tool; there is a 
property that specifies that specific resources are not restarted if they are 
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shut down. However, if you use the Cluster Administrator and not the BPI 
Administration Console to start and stop the BPI components, you do not 
have this problem.

• If you have created a customized adaptor, using openadaptor, and the 
adaptor is running on a machine outside the cluster environment, there is 
additional information that you need to be aware of. This information is 
appropriate only for adaptors running outside the cluster and sending 
business events to the Business Event Handler installed within the 
cluster; the information covers configuring the adaptor to retry in order to 
re-establish a connection with the BPI cluster when there is a cluster 
failover. The information that you need is covered in the Business Process 
Insight Integration Training Guide - Business Events in the section 
describing Service Wrappers.
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17 Backup and Recovery
This chapter describes the backup and recovery procedures for the BPI Server 
in cases where you are not using the Business Availability Center 
high-availability solution (see the Business Availability Center Deployment 
Guide for more details of the high-availability solution).

It is important to back up your BPI Server system to ensure that the BPI files 
and data can be recovered in the event of a media corruption. It is also 
important to back up your system to ensure that any processes being 
processed and their associated data and events can be recovered to a known 
state.

There are general high reliability configurations, which are recommended for 
all systems, for example, using mirror or Redundant Array of Inexpensive 
Disk (RAID) storage. Restoring or recovering from a backup should be a last 
resort. Your goal should be to make sure that the backups are never required.

This section does not cover how to set up your system for high availability. The 
section focuses on the recommended procedures for backing up and recovering 
BPI instance data.

The section also describes the behavior of the BPI system when specific 
components are shutdown, and provides recommendations for minimizing the 
effect of the shutdown.

If you have a system shutdown or failure, you want to keep your BPI system 
as synchronized as possible during the shutdown period. This section 
describes techniques for design that can help achieve this.

The Process Repository data is part of the BAC backup and recovery process 
and is not covered in this chapter.
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The following list describes some key considerations that you need to be aware 
of when designing your BPI system for effective backup and subsequent 
recovery:

• For planned component shutdowns:

— Shut your BPI system down during quiet periods where possible.

— Use high reliability tools where appropriate.

• Design adapters to minimize the number of events lost during a system 
failure.

For most adapters, it is possible to design them such that they process 
events from the last time the adapter was executed. The Business Process 
Insight Integration Training Guide - Business Adapters describes how you 
do this.

• Minimize the number of Check Sequence arcs that you use in your 
processes.

When the BPI system is recovered following a shutdown, it is likely to 
receive a burst of out-of-sequence events. You are recommended to use 
Check Sequence arcs only where essential. Overuse can cause the BPI 
system to generate an excess of violations when it restarts. The Business 
Process Insight Online Help for the Modeler describes Check Sequence 
arcs in more detail.
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Files and Directories to Backup

The following list describes the BPI data that is persisted within your BPI 
Server system and that therefore needs to be part of your backup policy:

• All BPI schema objects for the BPI Instance database schema.

You specified the database details when you installed BPI, you need these 
details in order to complete your backup.

The database for BPI should be backed up using the utilities and 
procedures provided as part of your database management system.

• Event definitions

BPI stores details about Event definitions that have been deployed to the 
Business Impact Engine in a series of files; these files are located as 
follows:

bpi-install-dir\data\repository\events

• Configuration information

BPI includes configuration information, which controls how BPI is setup 
and is relatively static. This configuration information is located in the 
following directory:

bpi-install-dir\data\conf\bia

• Template configuration files

The following directory contains the template definitions for most of the 
configuration files for the BPI Server and presented (managed) within the 
Administration Console. When you configure a component using the 
Administration Console, all the configuration files in data\conf\bia are 
regenerated, based on the content of the template files located at:

bpi-install-dir\newconfig

• Log files

These do not need to be backed up to restore a consistent system; however, 
you are advised to back up the log files, which are located at:

bpi-install-dir\data\log
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• Data files

These are the files (Class files, Java files and so on) that contain the 
details of the deployment status of your definitions. BPI includes 
configuration information relating to the processes and data that are 
deployed within the database. This information changes whenever the 
components of a process are deployed to the Business Impact Engine. This 
information might be static in a production system, but variable in a 
development system where Business Processes are being designed, 
developed and tested and are therefore in a state of change.

These data files are located at:

bpi-install-dir\data\datafiles

• Business Event Handler

Events received by the Business Impact Engine from the Business Event 
Handler are not acknowledged by the Engine until they have been 
successfully received. Out-of-sequence events and events that contain 
errors (for example, missing data) are stored in the Business Event 
Handler hospital.

The Business Event Handler includes database tables for the hospital and 
event store. By default these tables are created in the same database as 
the rest of the BPI data, and are therefore backed up with the BPI data.

• Application adapter files and data

Application adapters are those developed using the Business Event 
Handler component to access business data from applications within your 
organization. The Business Process Insight Integration Training Guide - 
Business Events describes how to build application adapters. 

It is usual for application adapters to be located close to (or co-located 
with) their data source, which means that they are likely to be running on 
a different system to the system where BPI is installed.

Any data used by that application adapter that needs to be synchronized 
with the application data (for example buffer tables populated using 
database triggers or adapter history files), should be backed up as part of 
the backup procedures for the application. Where possible the buffer table 
should exist within the same database as the application data that is 
being monitored. This makes it easier to backup the data together and 
keep it synchronized.

• TransactionVision
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You need to back up the TransactionVision event data related to the BPI 
Server as described in the TransactionVision Help.

With the exception of the application adapter files and data, you must back up 
all of the data described above at the same time in order to maintain its 
consistency.

How often you back up the BPI data depends on how frequently the data is 
changing. The data can be backed up while the BPI system is operational; 
however, you need to ensure that you do not deploy or undeploy and 
definitions during the backup as the backup includes directories.

As the BPI instance database cannot be synchronized with the Event 
definition files and data files, it is not possible to recover the BPI system to 
the point of failure from a backup. You must use the appropriate database 
management system tools to restore your system to the most recent backup 
and not to the point of failure.

As you cannot recover to the point of failure, if you have installed a database 
solely for BPI, you can consider not backing up all the transaction log files. 
This will reduce the amount of disk space required by the database for 
recovery purposes. In the case of Microsoft SQL Server, you could use the 
Simple Recovery model, rather than the Full Recovery model. The Simple 
Recovery model enables you to recover to the most recent backup. The Full 
Recovery model enables you to recover the database to the point of failure.

In the case of Oracle, you need to use ARCHIVELOG to enable online 
backups. If you do not want to use ARCHIVELOG, you can stop BPI and 
complete an offline backup.
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How the BPI System Behaves When Components are 
Shutdown

This section describes the behavior of the BPI components when they are 
shutdown. It provides additional information that helps you understand the 
behavior of the system for backup and recovery purposes.

Engine Shutdown

If the Business Impact Engine component is shutdown, it is no longer able to 
receive and process events.

As a result of the Engine shut down, the Business Event Handler component 
stops accepting business events until the Business Impact Engine is 
restarted. When the Engine is restarted, any business events waiting to be 
processed are automatically submitted to the Business Impact Engine.

Database Shutdown

If the database is shut down for any reason, the Business Impact Engine can 
no longer communicate with it and also shuts down, as described in section 
Engine Shutdown on page 396. In addition, all other BPI components that use 
the database are shut down.

Notification Server Shutdown

When the BPI system determines that a notification is required, the Business 
Impact Engine passes a notification to the Notification Server. All 
notifications are held by the Business Impact Engine, in the database, until 
the Notification Server has confirmed that it has accepted responsibility for 
them.

If the Business Impact Engine shuts down before the notification is sent to the 
Notification Server, the notification is retried when the Business Impact 
Engine restarts. Note that the service status shown is the latest status. No 
notifications are generated for any interim changes that occur when the 
Business Impact Engine is shut down. For example, if the Engine shuts down 
when a service is in the state Critical, and the service subsequently changed 
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from Critical to Normal and then back to Critical, when the Engine 
restarts, the service status is shown as Critical. In this case, the 
information about the state change to Normal and then back to Critical is 
not recorded.

Email Server Shutdown

If the Notification Server cannot make a connection to the email server to 
send the notification to the designated user, the Notification Server stores the 
notification in the database and resends it at a later time when a connection is 
established. The Notification Server continues the attempt to resend the 
notification until is reaches the value for the Maximum retries to SMTP 
server parameter. When this maximum is reached, the Notification Server 
stops retrying and logs an error in its log file.

Business Event Handler - BPI Adapter Shutdown

If the Business Event Handler shuts down for any reason, the effect of the 
shutdown depends on the design of the individual adapters that are connected 
to it.

For database adapters, where you are using buffer tables, make sure that the 
buffer tables are backed up and synchronized with the application data that is 
being tracked.

For file adapters, make sure that the current position in the file is backed up 
with the source application data.

This means that when the Business Event Handler BPI adapter is restarted, 
the application adapters can be also restarted and any events marked as 
DISCHARGE_WAIT can then be sent back into the BPI system.

Servlet Engine Shut Down

If the Servlet Engine is shut down for any reason, all the currently open BPI 
clients using Browser Windows also stop. You might need to restart the Web 
Browser Windows and the BPI clients when the Servlet Engine is restarted.
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Completing an Online Backup for BPI

Before starting an online backup, you need to ensure that your database is 
configured such that it is capable of completing a backup online. For example, 
in the case of an Oracle Server, you need to make sure that the Oracle 
instance you have specified for BPI is running in ARCHIVELOG mode. If it is 
not, you cannot complete an online backup.

You should also align the BPI backup process with that of the overall BAC 
system backup processes in order to make sure that the data is as consistent 
as possible across your deployment after you have recovered the data.

The following steps describe the process for completing an online backup:

1. Ensure no one is using the BPI Modeler.

2. Close the BPI Modeler.

3. Use the BPI Administration Console to shut down the Process Repository 
component. This prevents changes being added to the repository whilst 
the backup is taking place.

Do not make any further administration changes using the 
Administration Console until after the online backup is complete.

4. Backup the following BPI directories and their subdirectories on the 
system where the BPI Server is installed:

bpi-install-dir\data\repository
bpi-install-dir\data\conf\bia
bpi-install-dir\data\datafiles
bpi-install-dir\data\log
bpi-install-dir\newconfig

If you prefer, you can backup the entire bpi-install-dir\data 
directory. 

Any log files currently locked by BPI processes cannot be backed up, so 
there are some error messages in the backup process referring to these 
files. Older log files are successfully backed up.
398 Chapter 17



5. Back up the BPI data in the database using the database management 
system backup utilities.

6. Use the BPI Administration Console to restart the Process Repository 
component on the system where the BPI Server is installed.

7. Restart the BPI Modeler.

Your backup is now complete.

It is possible that the Engine Model Cleaner process is running at the same 
time as the online backup is completed. This is not a problem, but can result 
in inconsistencies between the data stored in the Engine’s database and its 
configuration files. If you see warnings in the Business Impact Engine log file 
indicating that the Engine cannot find a definition in the database, it is as a 
result of this scenario.
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Restoring your BPI Data from a Backup

This section describes how to restore your BPI system following:

• a complete system failure

• a BPI file system failure

• a database failure

In all cases, you are restoring both the database and the file system for the 
BPI components. 

The following are points to note when restoring the database and the file 
system:

• Process instances created after the last database backup are lost.
• Process instances completed after the last database backup remain active 

and are unlikely to complete.
• Process, Data or Event definitions created since the last database backup 

need to be redeployed.

The Modeler detects that the current process is not the latest one and the 
Process is set to a deployment state of:

Not deployed, but can be deployed; an earlier revision is 
deployed

You can select to deploy the process and the later version that has been 
detected in the Process Repository is deployed.

• Modifications to Process, Data or Event definitions since the last database 
backup need to be redeployed.

The Modeler detects that the current process is not the latest one and the 
Process is set to a deployment state of:

Not deployed, but can be deployed; an earlier revision is 
deployed

You can select to deploy the process and the later version that has been 
detected in the Process Repository is deployed.

• Process, Data or Event definitions deployed since the last database backup 
need to be redeployed.

• Monitor definitions that are new or have been modified since the last 
database backup need to be redeployed.
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• Email users and subscriptions configured through the Notification Server 
Administration Console after the last backup are lost and need to be 
re-added.

• Scripts and files created since the last backup need to be recreated; for 
example, any Velocity templates or Notification Server scripts that you 
have recently created might need to be redone.

• Email users and subscriptions deleted since the last database backup 
reappear and will need to be deleted again.

• Process, Data, Service and Event definitions that have been undeployed 
reappear and need to be undeployed again.

• Recent configuration changes made using the Administration Console need 
to be redone.

Where appropriate, you are advised to restore the database files, BPI Event 
definition files and BPI configuration files to maintain consistency. If you do 
this, you also need to re-enter any Event definitions created since the backup 
was completed. 

Steps to Restore your BPI System

This section describes the steps for restoring your BPI system.

If you have had a severe system failure, you are recommended to reinstall BPI 
including all its dependencies, for example, the database management system 
(Microsoft SQL Server or Oracle Server) and the J2SE, before restoring any 
files.

To restore the BPI data, complete the following steps:

1. Ensure no one is using the BPI Modeler.

2. Close the BPI Modeler to prevent new and modified definitions being 
created.

3. Use the BPI Administration Console to shut down all the BPI 
components. 

Do not make any further administration changes using the 
Administration Console until after the recovery is complete.

4. Restore the files that you previously backed up under:

bpi-install-dir\data
bpi-install-dir\newconfig
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If your BPI system has been running since the last backup you are likely 
to receive warnings for log files that already exist; this is expected. 
However, other error and warning messages should be fully investigated 
before continuing.

If you are using an Oracle database continue at step 6. If you are using a 
Microsoft SQL Server database, continue at step 5.

5. Use the Microsoft SQL Server database utilities to restore the BPI 
database to the last backup. Be aware that when restoring files following 
the reinstallation of the database, the system identifiers for the database 
users are not the same. As a result, the newly created BPI user is not able 
to access the data in the restored database. 

For Microsoft SQL Server you use the Management Studio to execute an 
SQL command similar to the following (if you are not using the default 
schema name or database user defined within BPI, substitute the correct 
schema name or user for your database):

use hpbpiSchema;
exec sp_change_users_login 'Update_One','hpbpiuser', 
'hpbpiuser';

You also need to ensure that the default database for your database user 
is set correctly; for example: hpbpiSchema.

Continue at step 7.

6. Use the Oracle Server database tools to restore the BPI database to the 
last backup.

7. Restart the Business Impact Engine, Monitor Engine and Process 
Repository from the BPI Administration Console.

As the BPI database cannot be synchronized with the BPI file data 
relating to Event definitions and configuration information, it is not 
possible to recover to the point of failure from a backup. You must use a 
database management system command to restore your system to the 
most recent backup and not to the point of failure.

As the BPI database cannot be synchronized with the BPI file data 
relating to Event definitions and configuration information, it is not 
possible to recover to the point of failure from a backup. You must use a 
database management system command to restore your system to the 
most recent backup and not to the point of failure.
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8. Restart the BPI Modeler.

9. Open a Monitor Definer Window.

10. Re-apply any Business Process data that has been entered through the 
BPI Modeler, since the last backup.

11. Re-apply any monitor definition data that has been entered using the 
Monitor Definer, since the last backup.

You have now restored your BPI data. 

12. Undeploy any Process, Data, Service or Event definitions that are 
deployed and that were undeployed before you restored your BPI system.

13. Use the BPI Administration Console to restart the remaining BPI 
components.

14. Delete any email users and subscriptions that have reappeared since you 
restored your BPI system.

15. Use the Process Intervention tool to re-synchronize with the UCMDB.

Now go to section Completing the BPI Recovery Procedure on page 404 to 
complete the recovery procedure.
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Completing the BPI Recovery Procedure

This section describes points to note after you have completed an BPI recovery 
from backup.

After you have completed the steps described in section Restoring your BPI 
Data from a Backup on page 400, you have recovered to the latest backup. You 
have therefore potentially missed events that are relevant to your Business 
Processes. This means that BPI can raise erroneous events, particularly in 
cases where you have Check Sequence arcs defined.

You do also have the option to take a differential backup, which is faster. 
However, you are advised to adopt the backup and recover policies adopted for 
other applications within your organization, using the information provided 
in this section, which is specific to BPI.
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